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Important Notice

The Sapphire Infusion Pump User Manual is delivered subject to the conditions and
restrictions listed in this section. Clinicians, qualified hospital staff, and home users
should read the entire User Manual prior to operating the Sapphire pump in order to
fully understand the functionality and operating procedures of the pump and its
accessories.

®  Healthcare professionals should not disclose to the patient the pump's security
codes, Lock levels, or any other information that may allow the patient access to
all programming and operating functions.

®  Improper programming may cause injury to the patient.

®  Home users of the Sapphire pump should be instructed by a certified home
healthcare provider or clinician on the proper use of this pump.

Prescription Notice

Federal United States law restricts this device for sale by or on the order of a physician
only {21 CFR 801.109(b) (1)}.

The Sapphire pump is for use at the direction of, or under the supervision of, licensed
physicians and/or licensed healthcare professionals who are trained in the use of the
pump and in the administration of blood, medication and parenteral nutrition. The
instructions for use presented in this manual should in no way supersede established
medical protocol concerning patient care.

Copyright, Trademark and Patent
Information

© 2016, Q Core Medical Ltd. All right reserved.

Sapphire and Q Core (with or without logos) are trademarks of Q Core Medical Ltd.
The design, pumping mechanism and other features of the Sapphire pump are
protected under one or more US and Foreign Patents.
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Disclaimer

The information in this manual has been carefully examined and is believed to be
reliable. No responsibility is assumed for any inadvertent inaccuracies. Q Core Medical
Ltd. reserves the right to make changes to any of its products in order to improve
reliability, design and performance. The instructions presented in this manual should in
no way supersede established medical protocol concerning patient care. The text and
drawings herein are for the purposes of illustration and reference only; the
specifications on which they are based are subject to change without notice.

Warning

Use only Q Core Medical Ltd. supplied administration sets and accessories with the
Sapphire pump. Use of administration sets other than Q Core Medical Ltd. supplied
sets may impair the operation of the pump and the accuracy and flow rate of the
infusion, and may generate hazardous fluid pressures which may activate occlusion
alarms at unpredictable pressures.

Q Core Medical Ltd. warranty on this device will be null and void and Q Core Medical
Ltd. will assume no responsibility for incidents which may occur if the product is not
used in accordance with product labeling. Refer to Warnings and Safety Precautions on
page 24 for a complete list of warnings and cautions.

Technical Assistance

For technical questions, troubleshooting assistance and reporting of unexpected
events, please contact your local agent/distributor, and refer to page 221. You may
also contact Q Core Medical Ltd. support via email to the following address:

support@Qcore.com


mailto:support@Qcore.com
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Chapter 1: Introduction

The following sections describe the functions and features of the Sapphire pump, and
provide a summary of safety and regulatory information:
Product Overview and INdiCatioNns .......c...eiiiiiiieiiiiie et 10
Terms and ADDIeVIatioNS .......civveiiiiieiieee e e e e e e e e e e e re e e e eaes
Document Conventions ....
Safety and Compliance INformation ..........ccoeiiiiiiiiiiiiiie e 16
Warnings and Safety Precautions ........c.oouuieiiiiiiei i e e 24

Product Overview and Indications

The Q Core Sapphire infusion pump is intended for controlled delivery through
intravascular, subcutaneous, intra-arterial and epidural routes. The pump is designed to
deliver saline, Total Parenteral Nutrition (TPN), lipids, IV medication, epidural
medication, blood and blood products.

The Sapphire pump includes the following infusion modes for all intended uses:
Continuous, Intermittent, TPN, PCA, Multi-step, and Epidural.

The pump is intended to be used by both licensed health care professionals in a clinical
environment, and home users in an ambulatory environment and in pre-hospital
medical ground transportation.

The dedicated Q Core administration sets for the Sapphire pump are intended for
single-patient use and single-use only.

This user manual supports the use of Sapphire software version r14. Verify that the
software version that appears on the Sapphire turn-on screen is r14. The version
number can be viewed from View system as well (for more information, refer to View
Menu on page 138).

0 This software version is intended for use only in the US.
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Dedicated Delivery Mode Configurations

To promote safety and convenience of use in different environments, the Sapphire
pump can be preconfigured to support only certain delivery modes. The different types
of configurations available on various pump types, are described in the following table.

Pump Type Delivery Modes Supported

PCA ® PCA

® Continuous

Epidural ® PCEA

® Intermittent Epidural
TPN ® TPN

® Continuous
Multi-therapy 1 or more of the following:

® Continuous

® Intermittent

® TPN

® PCA

® Multi-step

® Epidural
SapphirePlus ® Continuous

® Multi-step
SapphireH100 1 or more of the following:

® Continuous

® Intermittent

® TPN

® Multi-step

Each delivery mode is assigned a unique color that appears on the Indicators Bar,
helping users to easily differentiate between the different modes (Figure 3.1 on
page 56).
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Features

The features of the SapphirePlus pump are designed to simplify treatment and ensure
patient safety.

Treatment-Related Features

Introduction

Single platform device: The delivery mode of the pump can be changed,
according to the required type of infusion.

Priming alternatives: Both manual priming (by gravity) and automatic priming
(using the pump) are available.

Quick infusion titration (in most delivery modes): Modification options allow
updating of infusion parameters without stopping the infusion.

Incomplete action notification: The pump — which has been left untouched for a
defined time — notifies the user if an action was initiated but not confirmed.

Resume Infusion After Pump Shut Down: Allows resuming an infusion after the
pump has been shut down from a running or paused infusion.

PreSet Programs: Allows saving the infusion parameters of commonly used
protocols, and allows a quick-start infusion using these parameters.

Piggyback (Continuous delivery mode only): Provides the ability to add a
Secondary line to a running continuous infusion, without re-entering infusion
parameters for the Primary line.

Flexible programming features:

® Infusions can be programmed in a variety of dose rate units, including the
following, per different time units: mL, mg, mcg, units, mUnits, Million Units,
gram, nanogram, mmol, mEg.

® Infusion rate can be programmed as a weight based infusion (patient weight
can range from 0.1- 500 Kg).

Wireless Networked Communication: Enables communication between the
pump and the facility network, using the facility Wi-Fi.



Safety-Related Features

Lock Screen: Avoids inadvertently activating screen functions by locking the
screen when the infusion is running.

Patient Lockout: Prevents unauthorized tampering with the pump by locking
pump functions. Password entry is required to reactivate the screen. This option
can be configured to automatically activate once an infusion begins.

Authorization lock level: Allows access to only those pump functions for which
the user has authorization. Authorization levels (Low, Medium, High, Technician)
are password-controlled.

Range parameter safety check: Prevents entering infusion parameters that are
outside of a precalculated safety range. The permitted ranges vary according to
the parameters already entered by the user, or by the limits defined in the Drug
Library, if one is installed on the pump.

Easy alarm troubleshooting: Alarm screens display specific instructions about
how to manage the alarm or resolve the problem.

Drug Library: Enables safer practice according to clinical care area. Programming
is done with drug specific name, profile, hard limits and recommended (soft)
limits.
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Terms and Abbreviations

The following table defines common terms and abbreviations used in this manual.

Term/Abbreviation

AFFV
AC/DC
Accum.
CCA
DFU
ECG
EMC
EMI
FCC

h

HIS

Kg
KVO
LE-LAN
MAC
mcg
mEq
min

mg

mL
mmol
Mounting System
MRI

Introduction

Meaning

Anti-Free-Flow-Valve

Alternating Current / Direct Current
Accumulated

Clinical Care Area

Directions for Use
Electrocardiogram

Electromagnetic compatibility
Electromagnetic interference
Federal Communications Commission
Hour

Hospital Information System
Kilograms

Keep Vein Open

License-Exempt Local Area Network
Media Access Control

Micrograms

Milliequivalents

Minutes

Milligrams

Milliliters

Millimoles

Sapphire Multi-Pump Mounting System

Magnetic Resonance Imaging



Term/Abbreviation Meaning

mUnits Milliunits

M Units Million Units

nanog Nanograms

Occ. Occlusion

PAV Pressure Activated Valve

PCA Patient Controlled Analgesia

PCEA Patient Controlled Epidural Analgesia
PDA Personal Digital Assistant

PHY Physical Layer

Prim. Primary

RF Radio Frequency

Sec. Secondary

TPN Total Parenteral Nutrition

VI Volume Infused

VTBI Volume To Be Infused

Q Core Q Core Medical Ltd.

Sapphire pump Q Core Sapphire infusion pump family
SapphirePlus pump Q Core SapphirePlus infusion pump
SapphireH100 pump Q Core SapphireH100 infusion pump
WLAN Wireless Local Area Network
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Document Conventions

The following messages in this manual prompt readers to pay special attention to
specific points:

g Warnings indicate precautions and instructions which, if not
followed, may result in personal injury.

Cautions indicate instructions which, if not followed, may result in

£ damage to the equipment or to the quality of treatment.
o Notes provide additional information to help obtain optimal
equipment performance.

The parameters ranges described in this manual reflect their factory default settings.
These ranges may be configured by an authorized technician.

Safety and Compliance Information

The following section presents important labeling, safety and compliance information:

Symbols and Labeling on page 17
Compliance and Classification on page 21
Biocompatibility on page 23

Sterilization on page 23

Degree of Protection Against Ingress of Water and Dust on page 23
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S

ymbols and Labeling

The following table describes the labels and symbols that appear on the Sapphire

P

umps and their components, and identifies their locations on the equipment.
Symbol Description Location
Back of the pump casing and
S N Serial number. on the back of the mini
cradle.

Back of the pump casing, on
the back of the mini cradle,

REF Catalog Number. EBP", PCA Lockboxes 1007,

250" and 500mL", and
Mounting System.

Batch code. Inside casing of the mini
LOT cradle, EBP, PCA Lockboxes

100", 250" and 500mL", and
Mounting System.

Caution: Consult accompanying Back of the pump casing

documents for safety instructions (service EBp" he back of
to be performed by qualified technician; csver,. ) Idoln t ed acko
consult Service Manual before removing the mini cradle, an

cover). Mounting System.

Storage temperature range. Shipping package.

@ Storage humidity range. Shipping package.
s
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Symbol Description

-@- Storage atmospheric pressure range.
The C and US indicators adjacent to the
<s B: CSA mark signify that the product has
®
C US United States.

Consult instructions for use.

Follow instructions for use.

been evaluated to the applicable CSA and
UL standards, for use in Canada and the

Date of manufacture (year).

I Name of manufacturer.

R -

Identify defibrillation proof and degree of
protection against electric shock.
Equipment Type BF Applied Part.

Introduction

Location

Shipping package.

EBP, on the back of the mini
cradle, and PCA Lockbox

500mL".

Back of the pump casing,

PCA Lockbox 250mL", and
Mounting System.

Back of the pump casing and
Mounting System.

Back of the pump casing.

Back of the pump casing, on
the back of the mini cradle,

EBP”, PCA Lockboxes 100",
250" and 500mL", and
Mounting System.

Back of the pump casing.



Symbol Description

Input: 100-240 V; 50-60 Hz; Max. 120 VA
B Output: 10V DC; Max. 4.7 A.

P24 Dust and splash proof.
IPX1 Waterproof rating.
IPX2 Waterproof rating.
Rx Only US federal law restricts this device to

prescription only.

Waste Electrical and Electronic Equipment
(WEEE) Disposal.

This symbol indicates that used batteries
and electronic equipment must not be
disposed of as unsorted municipal waste,
and must be collected separately. Contact
an authorized representative for
information concerning the
decommissioning of your equipment.

ALARM Alarm — LED, when lit, indicates an alarm
situation in the operation of the pump.
Refer to Hardware and Software
Components on page 35.

CHARGE Charge — LED, when lit, indicates that the
battery is charging. Refer to Hardware and
Software Components on page 35.

RUN Run — LED, when lit, indicates that the
pump is infusing. Refer to Hardware and
Software Components on page 35.

STOP Stop — Allows you to temporarily stop the
infusion.

Location

Mounting System.

Back of the pump casing.
Mounting System.

EBP".

Back of the pump casing, on
the back of the mini cradle,
PCA Lockboxes 100", 250",
and 500mL*.

Back of the pump casing
cover, EBP, and on the back of
the mini cradle.

Front casing of the pump,
below the red LED.

Front casing of the pump,
below the yellow LED.

Front casing of the pump,
below the green LED.

Front casing of the pump,
below the touch screen.
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Symbol Description Location

On/Off On/Off — Turns pump On and Off. Front casing of the pump,
below the touch screen.
I ( : Complies with limits for Class B digital .
C device established by FCC Rules, Part 15. Back of the pump casing.
Wi-Fi enabled.
® .
(((‘))> Complies with IEEE 802.11 a/b/g/n. Back of the pump casing.

* PCA Lockboxes 100, 250 and 500mL, and External battery pack are available for use with
Sapphire Multi-Therapy, PCA and Epidural pumps.
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Compliance and Classification

This manual has been written in conjunction with the requirements in the International
Standard, IEC 60601-2-24 for Medical Electrical Equipment - Part 2-24: Particular
Requirements for Safety of Infusion Pumps and Controllers. Data presented in the
Technical Specification section reflect specific test conditions defined in this standard.
Other external factors, such as varying back pressure, temperature, head height, set
usage, fluid restrictions, solution viscosity, or combinations of these factors may result
in deviations from the performance data presented.

21

IEC 60601-1, UL 60601-1 and CAN/CSA C22.2 601.1-M90 medical electrical
equipment, which classifies the SapphirePlus pump as:

® (Classll

® Type BF

® Continuous operation

® |P24 dust and splash proof
[ ]

Not suitable for use in the presence of flammable anesthetic mixture with air or
with oxygen or nitrous oxide

IEC 60601-1-2: Electromagnetic compatibility.

IEC 60601-2-24: Infusion pumps and controllers, which classifies the SapphirePlus
pump as a Type 4 pump (continuous infusion flow, combined with bolus delivery).

IEC 60601-1-11: Requirements for medical electrical equipment and medical
electrical systems used in the home healthcare environment.

IEC 60601-1-8: Requirements for alarm systems in medical electrical equipment
and medical electrical systems.

Defibrillator compliance statement: Equipment Type BF Applied Part.

IEEE 802.11 a/b/g/n: Requirements for wireless local area network (WLAN)
computer communication — synonymous with Wi-Fi.

FCC: The Federal Communications Commission (FCC) regulates interstate and
international communications by radio, television, wire, satellite and cable. The
SapphirePlus pump complies with Part 15B, 15C, 15E of the FCC Rules.
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Wireless Communication

The SapphirePlus wireless device contains a Connectivity Module that allows for
implementing Wireless Local Area Network (WLAN) networking capabilities. This allows
the application software to download drug libraries and software updates to the
infusion pump over a wireless connection.

The pump Wi-Fi abilities have been tested and approved according to United States
rules and regulations. Using the pump Wi-Fi abilities outside of the United States where
allocations and technical parameters may be different, may result in the violation of
government regulations and possibly affect the functionality of the Wi-Fi module.

FCC Information

US FCC (FEDERAL COMMUNICATIONS COMMISSION) STATEMENT Rc
The Federal Communications Commission (FCC) regulates interstate and
international communications by radio, television, wire, satellite and cable.

The SapphirePlus wireless device complies with Part 15B, 15C, 15E of the FCC Rules.
Operation is subject to the following two conditions:

®  This device may not cause interference.

®  Pump operation must not be affected by any transmitted interference from other
devices.

FCC INTERFERENCE STATEMENT

This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to Part 15B, 15C, 15E of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses, and can radiate radio frequency energy. If
not installed and used in accordance with the instructions, it may cause harmful
interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the
equipment Off and On, the user is encouraged to try and correct the interference by
one or more of the following measures:

®  Reorient or relocate the receiving antenna.

® Increase the distance between the equipment and the receiver.
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®  Connect the equipment to an outlet on a circuit other than the one to which the
receiver is connected.

®  Consult the dealer or an experienced radio/TV technician for help.

RADIO FREQUENCY EXPOSURE STATEMENT

®  The Wireless LAN radio device in the connectivity module peripheral board of this
infusion device has been evaluated and found compliant to the requirements of
the following Radio Frequency exposure standards:
® Federal Communications Commission, OET Bulletin 65 (Edition 97-01),
Supplement C (Edition 01-01), Evaluating Compliance with FCC Guidelines for
Human Exposure to Radio frequency Electromagnetic Fields, July 2001.
® EN 50360 and EN62311

®  The radiated output power of this wireless device is far below the FCC radio
frequency exposure limits. The SapphirePlus wireless device has been evaluated
at 0.2 inches away from a human body, and found to be compliant with FCC RF
exposure limits.

Biocompatibility

All materials in components of the administration sets that are in the fluid pathway have
been tested for biocompatibility, and are in compliance with applicable international
standards I1SO 10993-1 for biocompatibility.

Sterilization

Administration sets that are manufactured by Q Core for the SapphirePlus pump, are
sterilized with ethylene oxide (EO), according to the sterilization requirements of
ISO 11135-1.

Degree of Protection Against Ingress of Water and Dust

The SapphirePlus pump meets the IP24 splash/dust standard according to IEC
60601-1-11. Protects from water which is sprayed at 10 L/min at a pressure of
80-100 kN/m2 for 5 minutes at all angles, and protects from touch by objects greater
than 12 millimeters such as fingers.
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Warnings and Safety Precautions

The following sections contain important safety information.
All warnings and safety precautions should be read carefully before operating the
SapphirePlus pump:

® General Warnings and Precautions on page 24

® Proper Use of the Pump on page 29
Safety information specific to particular pump functions appears in the relevant
sections of this manual.

General Warnings and Precautions

To ensure safety and proper operation, read the User Manual and any instructions
accompanying disposables or accessories before operating this device. In addition,
adhere to the following safety guidelines:

Avoid placing the administration set or power cord on the floor, or
A any other location where it can accidentally be damaged or provide
a risk of strangulation, particularly due to excessive length.

®  To avoid damage to the pump and its accessories, keep the equipment away from
unattended children and pets.

® Do not clean, disinfect or sterilize any part of the pump by autoclaving, or with
ethylene oxide gas. Doing so may damage the pump and void the warranty. Only
external parts of the pump should be disinfected.

If the pump is dropped or appears to be damaged, it should be
A taken out of service and inspected by Q Core Medical Ltd. trained,
qualified personnel only.

®  All service procedures, including certification, calibration, part replacement and
modification of equipment, should be carried out only by a qualified service
technician. Detailed instructions are available in the service manual.

® Do not operate the pump with the safety door open.
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Waste Disposal

Take care to dispose of the packaging, the administration sets, the battery, and any
other electronic components in accordance with applicable environmental laws (such as
the WEEE Directive for Waste Electrical and Electronic Equipment). Contact your local
authority to determine the proper method of disposal.

A Waste Disposal Safety Precautions

®  Keep used plastic infusion containers, packaging and tubing out of the reach of
children.

®  Administration sets should be disposed of in a proper manner, considering the
nature of residual fluid that may be contained within, in accordance with hospital
disposal practices.

® Do not dispose of the battery in or near fire.

Explosion Hazard

The equipment is not suitable for use in the presence of flammable anesthetic mixture
with air or with oxygen or nitrous oxide.

Electric Shock Hazards

To promote safety, always adhere to the warnings listed below.

A Electrical Safety Precautions

®  Access to any internal part of the SapphirePlus pump and the performance of any
service procedures should be carried out only by a qualified service technician,
fully trained in the operation of the infusion pump.

®  Disconnect the power supply before servicing.

® Disconnect the battery prior to opening the pump casing. Voltage present on
internal components may cause severe shock or death on contact.

®  Connect AC power to the pump only via a Q Core supplied power adapter.
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® Do not touch the pump to cradle (P2C) connection in the back on the pump.

Electromagnetic Compatibility

The SapphirePlus pump is designed to conform with electromagnetic compatibility
(EMC) standard IEC 60601-1-2 and to operate accurately in conjunction with other
medical equipment which also meets the requirements of this standard. To avoid
electromagnetic interference that may affect the operation of the pump, do not use the
pump near sources of strong electric and magnetic interference (EMI), such as large
electric motors.

®  Manage the electromagnetic environment to permit the device to perform as
intended without disturbing other equipment.

®  Separate the device from all other electronic equipment. If the device must be
used near other electrical equipment, monitor the equipment to ensure there is no
electromagnetic interference.

®  Devices should not be used adjacent to or stacked with other equipment. If the
device must be used adjacent to or stacked with other equipment, monitor the
device to verify normal operation.

®  If you suspect external RF sources or other equipment are influencing device
operation, contact the biomedical engineering department for additional
guidelines concerning electromagnetic immunity.

® Contact the biomedical engineering department for additional information in the
service manual concerning operating devices near RF sources.
The EMC limits for the Medical Device Directive 93/42/EEC (EN301489-1/-17 IEC/EN
60601-1-2:2007) are designed to provide reasonable protection against harmful
interference in a typical medical installation. The equipment generates uses and can
radiate radio frequency energy, and if not installed and used in accordance with the
instructions, may cause harmful interference to other devices in the vicinity. However,
there is no guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference with other devices, which can be
determined by turning the equipment Off and On, the user is encouraged to try to
correct the interference by one or more of the following measures:

®  Reorient or relocate the receiving device

Introduction 26



® Increase the distance separating between the equipment parts

®  Connect the equipment to an outlet on a circuit different from that to which the
other device(s) is connected

®  Consult the manufacturer or field service technician for help

Portable and mobile RF communications equipment, such as cellular telephones, 2-way
radios, Bluetooth™ devices, microwave ovens in close proximity to this device may
affect wireless communications with the Infusion pump and/or the operation of the
Infusion pump. Special precautions need to be exercised regarding EMC. These
include:

®  Maintaining a minimum separation distance of 2 ¥z ft (% m) between the Infusion
pump system and portable/mobile RF communications equipment

Electromagnetic Safety Precautions

® Do not expose the pump to therapeutic levels of ionizing radiation, as permanent

damage to the pump electronic circuitry may occur. It is preferable to remove the
pump from the patient during therapeutic radiation sessions.

® Do not use the pump in the vicinity of magnetic resonance imaging (MRI)
equipment, as magnetic fields may adversely affect the operation of the pump.
Remove the pump from the patient during MRI procedures, and keep it at a safe
distance from magnetic energy.

Wireless Compatibility

To promote safety, always adhere to the precautions listed below.

Wireless Device Precautions

®  The wireless 802.11 a/b/g/n device usage in the 5150-5250 MHz band is limited
to indoor use in order to reduce potential for harmful interference with co-channel
mobile satellite systems.
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® Inthe 5250-5350 MHz and 5650-5850 MHz frequency bands, high power radars
are allocated as primary users and these radars could cause interference and/or
damage to LE-LAN devices.

®  Operation is subject to the following two conditions: (1) the wireless device will
not cause interference, and (2) Pump operation must not be affected by any
transmitted interference from other devices.

Data Transfer and Integrity

The SapphirePlus wireless device is capable of operating at a full bandwidth of
802.11 a/b/g/n.

For network planning purposes, each pump transfers no more than 10 KB/min
(kilobytes per minute).

Data integrity is achieved in two levels:

® By Wi-Fi TCP/IP protocol
® By the software of the pump

Wireless Quality of Service

Quality of Service is primarily the responsibility of the network and the networking
equipment. It may be achieved by improving several network aspects:

®  Use networking devices that support QoS infrastructure

®  Use a dual-band access point so that if one of the bands is too crowded, the
second band can be used. This is supported by the SapphirePlus wireless module.

®  Use roaming to ensure that the wireless device will be assigned to the access
point where the radio signal received from the pump is the strongest one.

The level of cyber security is the responsibility of the network and
e based on the network configuration.
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Proper Use of the Pump

Although the SapphirePlus pump has been designed and manufactured to exacting
specifications, it is not intended to replace trained personnel in the monitoring of
infusions.

Home users must be trained by their medical provider before using
A the SapphirePlus pump.

Clinicians are advised to verify the proper route of delivery, and the
A patency of the infusion site.

When using the pump, periodic patient monitoring must be performed to ensure that
the infusion is proceeding as expected. The pump is capable of developing positive
fluid pressures to overcome widely varying resistances to flow, such as resistance
imposed by small-gauge catheters, ports, filters, or intra-arterial infusions. Although the
pump is designed to stop fluid flow when an alarm occurs, it is neither designed nor
intended to detect infiltrations or extravasations, and such conditions will not trigger an
alarm.

When using the pump, use only Q Core approved accessory
A equipment.
If auditory and/or visual signals do not perform according to
A settings, or if the hard keys do not perform as expected, do not use

the pump, and contact an authorized technician.

Environmental Safety Precautions

®  The pump has not been evaluated for use within magnetic resonance imaging
(MRI) environments, or with other medical equipment that emits radiation for
diagnostic or therapeutic purposes.

®  The SapphirePlus pump has not been evaluated for compatibility with
Extracorporeal Membrane Oxygenation (ECMO) systems.
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®  Use only Q Core supplied accessories and cables. The use of accessories and
cables other than those specified in this manual, with the exception of cables sold
by Q Core Medical Ltd. as replacement parts for internal components, may result
in increased emissions or decreased immunity of the pump.

Administration Sets

Before using administration sets, always read and follow the instructions in the User
Manual, and the instructions accompanying the administration set and source
container. Carefully follow any label copy instructions for loading, removing, and
reloading the set, as well as the recommended set change interval.

Use only valid Q Core approved administration sets with the

A SapphirePlus pump. Severe injury or death may result from using
sets other than those indicated in Q Core's approved list of
products. For more information refer to Administration Sets on
page 47.

For infection control purposes, consider the set change interval recommended by the
local Centers for Disease Control and Prevention (CDC), your facility guidelines, and
the instructions provided with the administration set.

A Administration Sets: Safety Precautions

® Do not use a damaged administration set or damaged set components or
packaging. Always refer to the instructions for use that are included.

®  Q Core administration sets are for single patient use only, and should not be
sterilized or cleaned for re-use.

® Do not connect the administration set to the patient while priming.
® Do not use force when connecting the administration set to the patient.

®  Always use the clamps on the administration set to occlude the administration set
prior to removing the Q Core administration cassette from the pump.
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® Do not apply pressure or pressurized air to any outlet or tubing connected to the
pump. Pressure may destroy sensitive elements.

® Do not pull or stretch the tubing in any section of the administration set when the
pump is in use, nor apply pressure to the infusion container.

The minimum pull force applied on the administration set which is
0 capable of disengaging the administration set from the pump is
2.855 Kg.

®  The administration set and container should be replaced as needed to avoid fluid
contamination problems.

®  The administration set must be replaced according to the hospital policy of
infection control and treatment protocol. Q Core sets allow accurate delivery up to
96 hours. If you program rate, dose or bolus combinations which exceed a
96-hour schedule, make sure that you replace the administration set on time.

Basic Infusion Safety Information

To obtain maximum accuracy of the pump when used in a hospital or clinical
environment, verify that the infusion container is positioned at a height of 50 cm above
the pump. There is no restriction on the location of the infusion container in relation to
the patient’s heart.

When clamping the administration set, ensure that the clamp is at least 20 cm (8 in)
away from the pump, when possible.

Note that if the dose rate is beyond the pump resolution of 0.1mL/h increments, the
pump will increase or decrease the rate by up to 0.05mL/h. This flow rate (mL/h) is
presented on the running screen during infusion.

For example, if the dose rate entered is 20 mg/h, which is equivalent to 3.64ml/h, the
pump will decrease the rate to 3.6 ml/h and display it on the running screen.

Alarm conditions automatically stop the infusion and require immediate attention
before the infusion can be restarted.
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A Administering Infusions: General Safety Precautions
®  Occlusion Pressure Alarm Settings:

® High pressure settings may affect the time for occlusion detection. Make sure
that the occlusion pressure is set according to the clinical use case.

® When using sets with a Pressure Activated Valve (PAV), detection may be offset
by 0.3 BAR (4.35 PSI or 225 mmHag). (This offset is called PAV cracking
pressure.)

®  Volume To Be Infused:

® Do not enter a volume to be infused greater than the amount of fluid available
in the container.

®  When post infusion is not 0 mL/h, note that the pump continues to infuse until
stopped by the user, or until the container is empty. To avoid over-delivery, use
containers that match the volume to be infused.

®  Secondary Infusions: When using the Piggyback infusion feature, verify that:
® The medication/solution in the Secondary infusion container is compatible
with the medication/solution in the Primary infusion container.
® The Secondary administration set is connected to the appropriate injection site
on the primary administration set (above the administration cassette).
® Interruption of the Primary infusion is clinically appropriate for the duration of
the Piggyback infusion.
® The Secondary source container is positioned at least 8 inches (20 cm) higher
than the Primary source fluid level.
® The drip chamber on the set should be used to verify that the correct line is
delivering and the other line is idle.
® The clamp of the Secondary set is closed when Piggyback infusions are not
running.
®  Air Detection: The Air in Line detector working range when delivering fatty acids
is 2%-20% lipids. Delivering fatty acids with different lipids concentrations may
trigger the Air in Line alarm.
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Chapter 2: Components, Accessories,

and Administration Sets

The following sections present a high level overview of the SapphirePlus pump
components and accessories:

UNPacking the PUMP .eoueeiieiiie e e et e e et e e e e rt e e e e et e e eeaaes 34
Hardware and Software COMPONENTS ......eiiiiiieiiiiiie e e e e e e e e e eaae 35
USING PUMP ACCESSOTIES etnirniiiieieinteueteeieetreieetetneeraetnsenaetnsanerensanesenseneenasensanesenns 38

Unpacking the Pump

When unpacking the Sapphire pump, inspect each item to ensure that it is undamaged.
The following items should be included:

®  SapphirePlus pump (with Li-lon Battery enclosed)

® AC/DC power adaptor for pump

®  User Manual

®  Mini cradle, with key (to lock) and pin (to allow open/close without the key)

®  Other optional items:
Demand bolus handle”
Splitter for mini cradle
Communication cable
PCA Lockbox 100mL"
PCA Lockbox 250mL"
PCA Lockbox 500mL"
Infusion Pouch 500 mL
Home Large Backpack (5 liter)
Travel Case

External Battery Pack”
Mounting System

* Available for use with Sapphire Multi-Therapy, PCA and Epidural pumps.
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Hardware and Software Components

The pump includes both hardware (control unit) and software (touch screen)
components. Hardware components are shown in the figure below. The parts of the
control unit are listed and described in the table following the figure.

Figure 2.1. Hardware Components
1

Number Component Description/Notes

1 Safety door Covers and protects the administration set and pumping
mechanism.

2 Speaker Delivers auditory alarm sounds.

3 Status LEDs Colored indicators providing a summary of the pump

current status:
® Red: An alarm is occurring.
® Yellow (blinking): The battery is charging.
® Yellow (steady on): The pump is connected to main
power, and the battery is fully charged.
® Green: The pump is running.
4 On/Off button Enables the user to turn the pump On and Off.

Stop button Enables the user to temporarily stop an infusion.
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Number Component Description/Notes

6 Power socket Enables you to charge the battery using the power
adaptor, connect a communication cable or a bolus
handle.

N/A Battery Houses the battery. (Located on the back of the pump.)

compartment

Touch Screen

The touch screen is used to configure and operate the pump. The main areas of the
screen are listed and described in the table following the figure.

Figure 2.2. Touch Screen Areas
SapphirePlus without Drug Library SapphirePlus with Drug Library
1 |: Running 1 E)r::”\::llme Pl Continuous iiiii)
|| 0165 » 165

% Rate > 2 '% Rate »

97 Vel > 97 Vel >

@ %:‘90 VI £ Total @ 3'-{"1‘5)0 Vi £ Total

w 80:35:17 Time left > w 00:35:18  Time left >

iewiEdt | Lock
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Number Component Description/Notes

1 Indicators Bar Displays the following essential status information:

CCA name (appears above Screen title, across all
screens when Drug Library is loaded).

ICU Medical MedNet™ Connectivity icon (appears
next to the Wi-Fi icon across all screens on Sapphire-
Plus pumps. Displayed in blue when connected; dis-
played in gray when not connected).

Wi-Fi icon (appears next to the ICU Medical Med-
Net™ Connectivity icon across all screens on Sap-
phirePlus. Displayed in blue when connected;
displayed in gray when not connected).

Soft Limit icon (appears above Battery status icon,
when Drug Library is loaded and current infusion
exceeds soft limit range).

Screen title (Start Up, Running, Paused, drug name,
etc.).

Drug concentration (appears when applicable, under
screen title).

Running icon (appears while an infusion is running).

® Delivery mode (Continuous, Multi-step).

Battery status icon.

2 Main Display Displays infusion parameters and other pump settings,
and serves as a work area in which most programming
and configuration takes place.

3 Toolbar Contains function keys that enable you to perform
common operations, such as confirming settings,
pausing infusions, locking the screen, etc.
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Using Pump Accessories

This section explains how to set up the following pump accessories:
MiNi Cradle .....ooooiiiiiiiiiii s 38
(VY=Y G o] ] P UUPUPU PP 40

Administration Sets ..

Mini Cradle

The small, easy to use bedside mini cradle offers flexible positioning of the pump at
any angle or height. Components of the mini cradle are listed and described in the
table following the figure.

Figure 2.3. Mini cradle
1

«— 3

Number Component Name Description/Notes

1 Pump hook Located on the pump holder. Press the hook to
release the pump from the mini cradle.

2 Mini cradle knob Located on the base of the mini cradle. Twist the
knob to connect or release the mini cradle from an
IV pole. To unlock the knob, use the supplied key

or pin.
3 Connection splitter Located on the base of the mini cradle. Used for
(optional) the RS-232 communication cable (optional) and

power-supply connections.
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To operate the pump from an IV pole set, attach the pump to the mini cradle. This
enables easy access to the screen without the risk of changing the settings through
accidental contact. In the mini cradle, you can also charge the pump.

Make sure the cradle is securely attached to the IV pole before
& attaching the pump.

The following steps explain the workflow of attaching the mini cradle to the IV pole,
attaching and releasing the pump, and releasing the mini cradle from the pole:

1. Attach the mini cradle to the IV pole by tightening the mini cradle knob on the
right side (Figure 2.3, #2).
To unlock the knob, make sure that the supplied key or pin is placed inside it.

To attach several pumps to the IV pole, rotate the mini cradle to a
0 horizontal position:
Pull the pump holder and the base of the mini cradle away from
each other, and rotate to the desired position.

2. To attach the pump to the mini cradle, insert the pump onto the bottom hooks of
the mini cradle (Figure 2.4, #1), and then click it into the top hook (Figure 2.4, #2).
Ensure that the pump is seated on both hooks.

3. Torelease the pump, press the pump hook located on the top of the pump holder
(Figure 2.4, #2).

4. To open and release the mini cradle, rotate the knob.
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Figure 2.4. Mini cradle Hooks

Power Supply

The pump power supply is used to charge the battery. Specifications of the power
supply include:

® Input voltage: 100-240 VAC
®  Output voltage: 10 VDC

A To prevent entanglement, always secure the cable cord properly.

> To charge the battery:
1. Plug the Q Core supplied power supply cord into the main power supply source.

2. With the white arrows facing up, plug the power cord into the SapphirePlus pump
power socket or into the splitter connector.

3. On the front of the pump, verify that the Charge LED status indicator is On
(blinking yellow light).

For more information regarding charging the battery, refer to Charging the Battery on
page 190.
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> To disconnect the power supply from the pump:
Gently press on both sides of the power supply connector, and pull it out of the
SapphirePlus pump power socket.
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Multi-Pump Mounting System

The Mounting System is designed to facilitate the use of multiple pumps while saving
valuable bed-side space and providing power consolidation. The Mounting System is
designed to accommodate three mini cradles, and charge three pumps via a single
power outlet, all attached to an IV pole via a single clamp. The Mounting System can
also accommodate the use of a single PCA Lockbox 250mL when mounted on the
right-hand mini cradle among the three.

0 It is recommended to use mini cradles with a splitter in order to
facilitate attachment and detachment of pumps.

A ® Verify that the mini cradles are securely attached to the Mounting
System, and that the Mounting System is securely attached to the
IV pole before attaching the pumps.
® Do not transport the Mounting System while mounted on an IV
pole. Detach and carry using the handle.
® Verify that the IV pole is not moving, tilting or wavering when
mounted with a Mounting System.
® Before using the Mounting System, make sure that the Mounting
System power supply and all cords are completely dry.
® To avoid risk of electric shock the mounting system power supply
must be connected to a power outlet with protective earth.
® Always connect the AC input cord to the Mounting System power
supply, before connecting it to a power outlet.
® Make sure that the AC input cord is fully inserted into the Mount-
ing System power supply socket and into the power outlet.
® Always disconnect the AC input cord from the power outlet
before disconnecting it from the Mounting System power supply.
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y ® Use only Q Core approved AC input cord and power supply with

e the Mounting System.

® To avoid entanglement of lines and cords, do not mount more
than 4 Mounting Systems on a single IV pole.

It is recommended to use additional IV container hooks (not
o supplied by Q Core) when mounting more than two Mounting
System on a single IV pole.

Setup Instructions

o It is recommended to first attach the Mounting System to the IV
pole before attaching the mini cradles to the Mounting System

> To attach the Mounting System to an IV Pole:
1. Loosen the clamp knob by rotating it counter-clockwise.

2. Firmly hold the Mounting System and place the clamp on an IV pole with the carry
handle facing upwards.

3. Tighten the clamp knob by rotating it clockwise (Figure 2.5).

Figure 2.5. Mounting System on IV Pole
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To prevent detaching from the IV pole, the Mounting System can be
o locked to the pole by removing the knob cap or knob key from the
clamp knob.

> To attach a mini cradle to the Mounting System:

1. Rotate the mini cradle to a vertical position with the mini cradle knob pointing
downward and the top hook pointing upward.

Figure 2.6. Attaching Mini Cradle to Mounting System

)

o Place the mini cradles according to the markings on the Mounting
System, between the designated lines (Figure 2.8).

2.  Loosen the mini cradle knob to maximum extent by rotating it.

3. Tilt the mini cradle and place the open vice on the top of the Mounting System
(Figure 2.7 Item A). Align the cradle and tighten the knob by rotating it (Figure 2.7
[tem B).
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Figure 2.7. Placing Mini Cradle on Mounting System

() l

~

4. Plug a DC output connector to the mini cradle splitter.

5. Fasten the DC output cables to the clips located on the bottom of the Mounting
System.

6. Plug the AC input cord to the power outlet. Verify that the Mounting System
power supply LED is ON.

Figure 2.8. Fully Assembled Mounting System
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> To transport the Mounting System, detach it from the IV pole:

1.
2.

Unplug the AC input cord from the power outlet.

Firmly hold the Mounting System and rotate the clamp knob counter-clockwise,
until the Mounting System is loose.

To carry the Mounting System always use the dedicated carry handle.

Always contact a certified technician in cases of Mounting System
A electrical and mechanical malfunctions.
When removing the Mounting System from the IV pole, avoid
applying pressure on the power cable, connectors or cradles.
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Administration Sets

The SapphirePlus pump should be used with a Q Core approved administration set,
which includes the Q Core administration cassette. This cassette includes a normally
closed valve (three-state Anti-Free-Flow Valve) that provides automatic anti-free-flow
protection. Opening the valve allows manual priming as well as transition of infusion to
gravity induced.

Figure 2.9. Sapphire Administration Cassette and AFFV

o Only administration sets that include a roller clamp and do not
include pressure activated valves (PAV) can be used by gravity. For
more information, refer to the Directions for Use of each set.

For more information about priming the administration set and inserting it into the

pump, refer to Priming Manually on page 73 and Inserting the Administration Cassette on
page 68.

47 SapphirePlus Infusion Pump User Manual



Q Core Approved Administration Sets

This section provides a list of administration sets approved by Q Core Medical Ltd. to
be used with the SapphirePlus pump.

Use only administration sets listed here or in Q Core's approved list
A of products:
http://www.qcore.com/
Using anything other than Q Core approved administration sets with
the pump may result in operation that is not within the constraints
and parameters of the device.

Name of Set Part Number

AP231-01 Infusion set with vented/non-vented drip chamber, ~ 12003-000-0027
back check valve, needleless y-site, 0.2y filter and needleless
y-site

AP232-01 Microbore with vented/non-vented drip chamber, 12003-000-0028
back check valve, needleless y-site, 0.2y filter and needleless

y-site

AP233-01 Infusion set with vented/non-vented drip chamber, ~ 12000-000-0026

1.2p filter and needleless y-site

AP431-01 Infusion set with vented/non-vented drip chamber, ~ 12000-000-0027
back check valve and 2 needleless y-sites

AP432-01 Infusion set with vented/non-vented drip chamber, ~ 12000-000-0028
back check valve and 3 needleless y-sites

AP433-01 Infusion set with vented/non-vented drip chamber 12000-000-0029
and needleless y-site

AP434-01 Infusion set with vented/non-vented drip chamber 12000-000-0030

SH348 Non PVC UV Resistant Infusion Set With Vented/ 12007-000-0014
Non-Vented Spike, Drip Chamber Floating Ball With 4
Needleless Y-Site, 15um Filter And Needleless Y-Site

Other products available from Q Core Medlical Ltd. are listed in Q Core Official Product
List, at http://www.qgcore.com/
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Chapter 3: Fundamental Concepts and

Operations

The following sections explain the structure and function of the Main Display and the
toolbar, provide an overview of the delivery modes, and describe special features that
can be enabled and disabled, according to user requirements:

Working with the Main Display ..........eeiiiiiiiiiiii et 50
Selecting DeliVEry IMOTE .....ccuueiiieeeiee et et e et e et e e e et e e e 56
Enabling Special FEAtUIES .....civuniiiiiiiiee e et e e e et e et e et e e saa e aen 58

Working with the Main Display

The Main Display is a touch screen that serves as a work area for programming infusion
parameters, and choosing from lists of possible selections. While an infusion is running,
selected infusion parameters and other relevant information (such as time left until
completion of the infusion) appear on the Main Display.

The following sections describe how to use the keypads, and provide an overview of
the main function keys and icons that appear on the Main Display.

Using the Keypad

Numeric keypad

The keypad is used for entering digits, to specify parameters for volumes, rates and
times, and typing drugs names when searching the Drug Library. As you press the
relevant digits, they are displayed in the frame at the top of the Main Display, replacing
the name of the parameter. Pressing Clr, at the lower left corner of the keypad, clears
all entered digits and lets you re-enter the value.
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The acceptable range of a given parameter is displayed in the upper right corner of the
Main Display. When you enter a value that is outside of a permitted range, the range
values stay red, and the OK function key is disabled. The values of a range are
dynamic, and change according to other parameters that have already been
programmed.

When entering time, the pump allows you to enter minutes up to the value of 59.
Infusion time of over 59 minutes must be expressed in hours and minutes. For example,
90 minutes must be entered as 1:30 (h:min).

Alphanumeric keypad

In some instances, for example, defining a new PreSet program, or entering a drug
name, the keypad displays letters and symbols in addition to numbers.

The Alphanumeric keypad displays uppercase letters with numbers, and lowercase
letters with symbols. Uppercase letters and numbers are the default state. Switch the
default keypad from uppercase and numbers to lowercase and symbols by pressing the
'abc sym' key on the toolbar and back to default by pressing 'ABC 123" key.
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Overview of Toolbar Function Keys

The function keys are located in the toolbar, and enable user actions. The function keys
that appear vary according to the screen or program that is currently selected.
Function keys enabling basic actions are described in the following table.

Name of Key Action Notes
oK Confirms a selection or an If the selection involves parameters
entered parameter that are out of the permitted range,
the OK key is disabled.
Prime Initiates priming Appears in the Attention screen, after
the Prime function has been selected.
Mute/Unmute Silences/unsilences the Appears when any alarm is triggered.
speaker The speaker unmutes automatically
after 2 minutes.
Back Displays the previous screen
Exit Returns to either the Start Up  In situations when the Back key and
screen, or to the screen the Exit key will take users to the
displaying current infusion same screen, only the Exit key is
parameters displayed.

The following function keys are available from the Running screen:

Name of Key Action Notes

Lock Locks the screen or the For more information, refer to Locking
pump the Screen on page 122 and Activating

Patient Lockout on page 122.

Press to Unlock Unlocks the screen

screen

Press to Unlock Unlocks the pump Unlocking the screen requires a

Patient password.
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Name of Key Action Notes

Request Pause/ Pauses an infusion or a bolus  For more information, refer to Pausing
Pause Bolus Infusions on page 118.

Request Continue/ Resumes a paused infusion

Continue Bolus or a bolus

View/Edit Displays a list of infusion For more information, refer to Infusion

parameters to be viewed or  Standby on page 119.
edited. Provides access for

putting the infusion on

Standby, when applicable.

Bolus Delivers a bolus during
continuous mode

Overview of lcons

Icons that frequently appear on the Indicators Bar and the Main Display are described
in the following table. In addition, some alarms appear with their own icons.

Icon Meaning Notes

> Indicates that the parameter To initiate the update, touch the
immediately adjacent to the icon canbe  box in which the icon appears.
viewed and updated directly from the
Main Display.

a Rate of the infusion.

Volume to be infused.
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Icon Meaning

‘ Indicates that the current infusion is
above the upper soft limit range in at
. least one parameter.

Time remaining until the end of the
infusion.

Indicates that an infusion is currently
running.

Indicates status of battery charge.

. Indicates that the current infusion is

' below the lower soft limit range in at

least one parameter.

Indicates that the current infusion is
exceeding both upper and lower soft
limit ranges.

Fundamental Concepts and Operations

Notes

For more information, refer to
Battery Care Information on
page 187.

For more information, refer to Soft
Limit on page 166.

For more information, refer to Soft
Limit on page 166.

When more than one parameter is
limited by the Drug Library — one of
the parameters is programmed
above the upper soft limit, and
another parameter is programmed
below the lower soft limit.

For more information, refer to Soft
Limit on page 166.

54



Icon Meaning

Indicates that the pump is connected to

((J)) the hospital network by Wi-Fi.

Indicates that the pump is connected to

(C367)  1cU Medical MedNet™ by Wi-Fi.

Updating data.

Software updates available.

Notes

The icon is displayed on the
Indicator bar only when the Wi-Fi
option is enabled.

Displayed in blue when the device
is receiving a wireless signal,
displayed in gray when the device
is not receiving a wireless signal.
For more information, refer to
page 37.

The icon is displayed on the
Indicator bar only when the Wi-Fi
option is enabled.

Displayed in blue when the device
is connected to ICU Medical
MedNet™, displayed in gray when
device is not connected to ICU
Medical MedNet™. For more
information, refer to page 37.

May appear when transitioning
between lines.

Drug library or pump software
updates are available for
installation.

Note: The option to install these
updates is available when turning
off an idle pump (not during a
paused or running infusion).
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Selecting Delivery Mode

The SapphirePlus pump is a multi-platform device that has the ability to operate in
several different delivery modes.

o The delivery modes availability can be set by a technician

Possible delivery modes include:

Mode Description/Notes

Continuous Delivers an infusion at a constant, programmed rate. This
mode includes the option to add a Secondary (Piggyback)
line.

Multi-step Delivers the infusion in a set of 1 and up to 25 steps.

Each delivery mode features its own unique options. The current mode is displayed at
the right side of the Indicators Bar on some of the screens. On screens that are not
mode related, such as Delivery mode selections screen below, the name "Sapphire" is
displayed instead.

Figure 3.1. Indicators Bar: Delivery Mode
[ Savitre Juis]
Continuous Multi-step
L ]
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Changing the delivery mode is done using the Options menu. An authorization code of
High is required to modify the delivery mode. For more information about how to
change the delivery mode, refer to Setting Delivery Mode on page 127.
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Enabling Special Features

Depending on the needs of a specific clinical care area or institution, the SapphirePlus
pump can be enabled to perform special functions. An authorization code is required
to enable/disable these functions.

After Drug Library is loaded, local changes to configurations

o controlled by the Drug Library will remain valid until the user selects
a CCA or turns the pump Off.
Local changes made to configurations not controlled by the Drug
Library will remain valid until reconfigured or pump is set to factory
defaults.
When Resuming an infusion after pump shutdown, local
configurations will remain until the end of the current infusion.
For more information about configuration settings, refer to Appendix
A: SapphirePlus Configuration Settings on page 214.
When no Drug Library is loaded, all local changes made to any
configuration will remain valid until reconfigured or until the pump is
set to factory defaults.

The following features can be enabled/disabled by users who have an authorization
code of High:

Delivery

Feature Mode(s) Description/Notes

Set delay All Enables users to start or continue an infusion at a later
time. The user may either define a specific delay period
or set the pump to Standby.

For more information, refer to Using the Set Delay
Feature on page 151.

Post Infusion All Sets the rate that is applied at the end of infusion to
Rate KVO or to continue at the current infusion rate. For
more information refer to Ending an Infusion on
page 123.
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Feature

Delivery

Mode(s)

Description/Notes

PreProgram

Prime Reminder

Advanced Bolus

Auto P. Lockout

Screen Saver

59

All

All

Continuous

All

All

Allows users to start an infusion using predefined
infusion parameters. When this option is enabled, the
PreSet Programs button appears on the pump Start Up
screen.

For more information, refer to Creating and Editing PreSet
Programs on page 148.

Enables a reminder for the user to prime the
administration set before starting an infusion.

For more information, refer to Automatic Priming Using
the Pump on page 71

Allows users to program a bolus by entering rate,
amount and time.

For more information, refer to Administering a Bolus on
page 92.

A safety feature that enables automatic locking of the
screen. A password is required to unlock the screen in
order to make changes to the infusion parameters or to
start a new infusion. Activated first during a running
infusion.

For more information about enabling the feature, refer
to Configuring General Settings on page 132.

For more information about using the feature, refer to
Activating Patient Lockout on page 122.

Provides a distant view of the main parameters during a
running infusion. Activated 30 seconds after the
infusion starts.
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A Technician authorization code is required to enable/disable the following additional

features:

Feature

Delivery

Mode(s)

Description/Notes

Delivery modes

New Patient

Set Secondary
(Piggyback)

Allow Bolus

Bolus Rate
Sec. Bolus Rate

Occ.
Auto-restart

Calculate
Concentration

All

All

Continuous

Continuous

Continuous

Continuous

All

All

Determines the available delivery modes. Each mode
can be turned Off separately.

Allows users to associate an infusion with a patient,
and reset the Accumulated VI (accumulated volume
infused).

Allows users to program a Secondary infusion.
For more information about programming a Secondary
infusion, refer to Adding a Secondary Line on page 97.

Allows users to program a bolus during a Continuous
infusion. When this feature is enabled, the Bolus
button appears in the toolbar during the running
infusion. For more information about administering a
bolus, refer to Administering a Bolus on page 92.

Specifies the rate of delivery of a fast dose, for rapid
volume infusion.

Specifies the rate of delivery of a fast dose for a
Secondary (Piggyback) infusion.

Enables the pump to automatically restart an infusion,
up to 5 times an hour, if a downstream occlusion was
detected and cleared within 40 seconds.

Determines if the user enters final concentration or
Drug Amount and Diluent Volume.
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Delivery
Feature Mode(s) Description/Notes

mL/h Only All Allows users to use units other than mL/h. If this option
is enabled, programming will automatically default to
mL/h. This feature is available in the absence of a Drug
Library on the pump.

Wi-Fi All Allows users to connect to the hospital network via
wireless communication.
This option is available after the Wi-Fi module has
been installed and configured.

Setting KVO rate

Sets the default rate applied when the Post Infusion Rate is set to KVO. The permitted
range for the KVO rate parameter is 0-20 mL/h (for all delivery modes).
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Chapter 4: Getting Started

The following sections explain the sequence of actions necessary to prepare the pump
and the administration set for an infusion:

TYPICAl WOTKFIOW oveeiiiiie et e e e e e e e et eeeaaas 62

Connecting the Infusion Container to the Administration Set .........c.ccooeeeiiiiiiieeeiinnnn.. 65

OpeNning the Safety DOOT .......iiiiiie e e e e e e e et eeeaaanaas 66

Inserting the Administration CasSEtLe ............ueeiiiiiiiieiiiiiie e e e e e e e eaan 68

Automatic Priming Using the PUMP .....oiiiiiii e 71
Typical Workflow

The recommended workflow for preparing the pump and administration set for an
infusion comprises the following steps:

1. Turn the pump On.
Connect the infusion container to the administration set.
Open the safety door.

Insert the cassette.

Prime the administration set using the pump.*

ok w

Connect the administration set to the patient. When using an administration set
with a filter, place the filter under the patient’s IV infusion site.

* |t is recommended to prime the administration set using the pump. It is possible to

prime the administration set manually. For more information, refer to Priming
Manually on page 73.
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The workflow sequence is illustrated in the following figure:

Figure 4.1. Recommended Workflow
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Turning the Pump On
The pump is turned On by pressing the On/Off hard key, at the lower right corner of
the pump.

When a Drug Library is loaded, a message is displayed asking to accept or change the
current CCA. For more information about CCA, refer to Clinical Care Area (CCA) on
page 161.

While the pump turns On, a system check is performed. If you do
£ not hear a sound from the speaker, or if items on the screen do not
display properly, do not use the pump.

o If a message regarding resuming previous infusion appears upon
turning the pump On, refer to Resuming Infusions After Pump
Shutdown on page 117.
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Turning the Pump Off

Pressing the On/Off hard key for 5 consecutive seconds turns the pump Off.
Alternatively, press the On/Off hard key, and then, from the Attention screen, press
Off. If a drug library update, or software update is available for installation, the user is
prompted with the option to install when turning off the pump. Note that installing a
new pump software removes the Drug Library if it has become incompatible.

After operating the pump with <1 mL/h flow rate, you will be
0 prompted to remove the administration cassette before turning Off
the pump.

For more information about turning the pump Off during an infusion, refer to Aborting
Infusions on page 120.

The pump enables resuming an infusion after pump shut down. For more information,
refer to Resuming Infusions After Pump Shutdown on page 117.

Connecting the Infusion Container to the
Administration Set

This section explains how to connect the infusion container to the administration set.

Before setting up the infusion, verify that the container,
A administration set and administration set package are undamaged.

> To connect the container to the administration set:
1. Open the sterilized administration set package.

2. Close the clamps and the AFFV to block the administration set. Make sure that the
clamp is located at least 20 cm (8 in) from the pump, when possible.

3. Spike the administration set into the container.

Verify that the arrow on the administration cassette is pointing
0 toward the same direction of the fluid flow (down).
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A Connecting the Infusion Container: Safety Precautions
®  Make sure there is no leakage from the container, and that the spike is firmly
attached to the container.

®  Verify that the set components are positioned correctly. The arrows on the
administration cassette and the filter must point toward the direction of the flow
(from the container to the patient).

®  When using a filter, maintain the filter level below the vascular access site.

Opening the Safety Door

Opening the safety door involves pressing it down while simultaneously pulling the
safety door open.

> To open the safety door:

1. Using your thumb, press the door outwards.
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2. While maintaining pressure, swing the safety door outwards.
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Inserting the Administration Cassette

Inserting the administration cassette into the pump involves positioning the cassette in
the proper direction, and ensuring that all portions of the cassette including the flange,
are secured inside the administration cassette’s housing. In Figure 4.2, the flange is
represented by #2, and the saddle is represented by #1.

Figure 4.2. Administration Cassette

y It is recommended to make sure that the pump is turned On, and to
L verify that all clamps on the administration set are closed before
inserting the administration cassette.

> To insert the Q Core administration cassette:

1. Open the safety door (Opening the Safety Door on page 66). Then, insert the
administration cassette at an angle, by placing the saddle (Figure 4.3, #1) on the
round metal anchor (#2) in the cassette's housing. Make sure that the arrow on the
cassette (#3) is pointing toward the bottom of the pump, and the bottom flange is
inside the cassette housing.
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Figure 4.3. Insertion of Cassette

2. Clip the upper end of the administration cassette into the metal lock (Figure 4.3,
#4).

3. Close the safety door over the administration cassette. Ensure that the safety door
clicks upon closure.
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Removing the Administration Cassette

When the infusion is complete, close the clamps, disconnect the administration set
from the patient, and disconnect the administration cassette.

In case of emergency, you can stop pump operation by opening the safety door,
closing the clamps, removing the administration cassette from the pump and
disconnecting the administration set from the patient.

The following procedure describes how to remove the cassette from the pump.

Although the AFFV offers automatic free flow protection, a small

A amount of fluid (up to 0.09 mL) may be expelled when the
administration cassette is detached. In order to ensure full
protection, disconnect the patient from the administration set
before detaching the cassette from the pump.

> To remove the Q Core administration cassette:

1. Close all clamps on the administration set.

2. Disconnect the patient from the administration set.

3. Open the safety door (Opening the Safety Door on page 66).
4

Loosen the cassette by raising the metal lock that secures it to the pump (#4 in
Figure 4.3).

5. Pull out the cassette, and close the safety door.

Getting Started

70



Automatic Priming Using the Pump

Before commencing infusion setup, the administration set needs to be primed. Priming
expels all the air from the administration set, and fills it with the infusion liquid. A fully
primed administration set is a set filled with infusion liquid (from which all the air was
removed).

0 It is recommended to prime the administration set using the pump.

Priming with the pump can be initiated from the following screens:
®  Start Up

¢ Start

®  Paused (infusion or bolus)

®  Airin Line Alarm

Before using the pump for priming, ensure that:
®  The administration set clamp is open.

®  The safety door is closed.
The Q Core administration cassette is properly connected to the pump.

Before priming, verify that the administration set is disconnected
A from the patient.

When the Prime Reminder is enabled and the set has not yet been

0 primed using the pump, a Prime Reminder will be displayed,
enabling the user to press Prime in order to start priming or to
press Start in order to proceed with the infusion (refer to Configuring
General Settings, page 133).

®  To prime the administration using the pump

71 SapphirePlus Infusion Pump User Manual



1. Position the pump in an upright position using one of the following methods:
® Attach the pump to the cradle base.
® Attach the pump to an IV pole using the mini cradle.

2. From the toolbar of the Start Up, Start, Air in Line Alarm, or Paused screen, press
Prime.

3. Verify that the administration set is disconnected from the patient. Then, from
the Attention screen, press Prime. Priming begins.
While the pump is priming, a progress circle appears on the screen, with a time
countdown displayed. The default priming time is 2 minutes.
When using administration sets that contain less than 20 mL, shorter priming times
can be set. For more information, refer to Set prime volume on page 132.

During priming with the pump, the Air in line alarm is disabled.

A When priming, check that all clamps are opened and that there is no
occlusion. Ensure that liquid, not air, enters the administration set
during priming.

The pump automatically indicates when priming is finished.
If priming is completed before the default priming time has elapsed, automatic
priming can be discontinued.

> To discontinue priming:

1. From the toolbar, press Finish Prime. Alternatively, at the bottom of the pump,
press the Stop hard key.

2. From the toolbar, press OK
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Priming Manually
The Q Core administration set can also be used as a gravity set, and the Anti-Free-Flow
Valve (AFFV) can be used manually.

Before commencing infusion setup, the administration set needs to be primed. Priming
expels all the air from the administration set, and fills it with the infusion liquid. A fully

primed set is a set filled with infusion liquid (from which all the air was removed).

The following procedure explains how to prime the administration

0 set manually, using gravity. However, it is recommended to prime
the administration set using the pump. For more information, refer
to Automatic Priming Using the Pump on page 71.

A set with a Pressure Activated Valve (PAV) can not be primed
0 manually.
For more information, refer to the Direction for Use for each set.

> To prime the administration set manually:
1. Open all the clamps on the administration set.

2. To allow free flow, open the AFFV by pushing it in and down, towards the center
of the Q Core administration cassette (#1 in Figure 4.4).

3. Fill the entire administration set with fluid, so that the fluid displaces all air in the
administration set.

0 When priming a set with a filter; the filter must remain lower than
the patient line.

4. To block free flow, close the AFFV by pushing it up and away from the center of
the cassette (#2 in Figure 4.4).
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Figure 4.4.

Opening and Closing the AFFV

Closed AFFV Opened AFFV Closed AFFV

Although the AFFV offers automatic free flow protection, a small
amount of fluid (up to 0.12 mL) may be expelled when the
administration cassette is attached. In order to ensure full
protection, insert the administration cassette to the pump housing
before connecting the set to the patient.

To use as a gravity set, fix the AFFV in an open position as described
in step 2 in To prime the administration set manually on page 73.

Only administration sets that include a roller clamp and do not
include pressure activated valves (PAV) can be used by gravity. For
more information, refer to the Administration set’s DFU.
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Chapter 5: Using the Delivery Modes

The following sections explain how to operate the pump in the different delivery
modes. After setting up the pump and the infusion, always check the battery status to
ensure it is sufficient for the desired infusion program.
ContiNUOUS IMOTE ....coiiviiiiiiiiiiiii et 76
MUIEI-STEP IMIOTE oounniiiiie ettt e et e e et e e et e e e et e e e eaa e e e easenaeesaaenaaeees 105

Continuous Mode
The following sections will be reviewed:

Infusion Parameters: ContinUOUS MOTE ......c.ueiiuniiiiiiiiieiiiie e e e 79
Starting @ ContinUOUS INFUSION ....iiiiiiiiiiiii et eeae e 79
Continuous Mode: Mid-infusion ACtIONS ......ccouiiiiiiiiiiiii e eaans 91

In this mode, the pump infuses fluid at a constant, programmed rate.

Figure 5.1. Continuous Flow Profile
Rate
(mL/h)
o
VTBI (mL)

Time 7
83/
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The SapphirePlus pump can also be configured to support Secondary (Piggyback)
infusions. The Secondary option is used when two medications are administered from

two different containers; The user may either alternate between the containers or
administer them sequentially.

To use the Secondary option, the option must be enabled (requires
0 Technician authorization code).

Figure 5.2. Secondary Infusion Setup
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When the Secondary option is enabled, you can set Secondary infusion parameters:

A

Immediately after programming the Primary infusion (Starting a Continuous Infusion
Using the Secondary Function on page 85).
OR

While a Primary infusion is already running (Adding a Secondary Line on page 97).

Piggyback Option: Safety Precautions

When working with Secondary infusions, adhere to the following instructions and
guidelines:

Use only Q Core administration sets designed for Piggyback infusions. (For more
information, refer to Q Core Approved Administration Sets on page 48.)

Hang the Secondary solution container at least 8 inches above the Primary
solution fluid level.

Use the drip chamber on the set to verify that the correct line is delivering and the
other line is idle.

After the Secondary infusion is complete, clamp the Secondary administration set.
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Infusion Parameters: Continuous Mode

The following infusion parameters are relevant for a Continuous infusion. When
programming the infusion, it is necessary to specify two of the parameters. The third
parameter is then automatically calculated by the pump.

Parameter Description/Notes

Rate The speed at which the fluid is infused. Rate values can
range from 0.1 to 999 mL/h.
Note: When selecting units that are not from the mL/h
family, the word Rate is replaced with Dose Rate.

VTBI The total amount of fluid to be infused. VTBI values can
range from 0.1 to 9999 mL.
The remaining VTBI is displayed on the screen as the
infusion progresses.

Time The period of time over which the fluid is infused. The range
for the Time value varies according to the VTBI and Rate.
The upper limit of the Time value is 99 hours and 59
minutes.

Starting a Continuous Infusion

The following procedure explains how to program the pump to start a new Continuous
infusion.

If relevant, you may skip programming by using the Repeat Last
o Infusion or PreSet programs procedures to begin the infusion. For

more information, refer to Starting New Infusions: Shortcuts on

page 114. To restart the infusion by adding VTBI during Post

Infusion state, refer to Restarting the Infusion during the Post Infusion

State on page 124.
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> To begin a new Continuous infusion without Drug Library:

1.

From the Indicators Bar, verify that the pump is in Continuous mode.

0 For more information about changing delivery modes, refer to
Selecting Delivery Mode on page 56.

From the Start Up screen, select New Infusion.
If the Dosing method screen appears, select the appropriate option:

® mL: Continue to Step 7.
® Dose calculation: Continue to Step 4.
Weight based units are available for both Dosing methods

Otherwise, continue to Step 10.

From the Concentration units screen, select the appropriate drug units.

0 To display additional concentration units press Next.

According to the pump configuration one of the following screens will appear:

® Concentration: From the Concentration screen, using the keypad, enter the
Concentration = OK; then, continue to Step 7.

® Drug amount: Using the keypad, enter the Drug Amount = OK. Then, using
the keypad, enter the Diluent Volume = OK; then, continue to Step 6.

From the Attention screen, confirm the concentration and press OK.
If the selected drug unit is Million Units, continue to Step 9.
If the Patient Weight screen appears, specify whether the infusion is weight based:

® Yes: Continue to Step 8.
® No: Continue to Step 9.

From the Patient Weight screen, using the keypad, enter the Patient Weight =
OK.

From the Dose Rate units screen, select the appropriate dose rate units.
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10.

1.

12.

From the Edit screen, program 2 of the following 3 parameters, by selecting the
relevant rows:

® Rate: Using the keypad, enter the value = OK.

® VTBI: Using the keypad, enter the value = OK.

® Time: Using the keypad, enter the value = OK.

The third (unprogrammed) parameter is then automatically calculated by the
pump and displayed in the relevant box.

If the calculated rate is beyond the pump resolution (0.1 mL/h

0 increments), the pump decreases the rate by 0.1 mL/h during the
infusion to achieve accurate delivery of the volume in the specified
time. The rate reduction is always 0.1 mL/h, and is presented on the
Running screen (when selecting dose calculation, the equivalent
change to 0.1 mL/h applies).

Review the parameters displayed on the Confirm screen.

Verify that the parameters reflect the correct treatment according to
& the prescription.

Then, press OK.

If the pump is configured to support Secondary infusions,

0 Secondary infusion parameters can be programmed at this point.
For detailed instructions, go to Step 3 on page 85 (To begin a new
Continuous infusion using the Secondary option without Drug Library).

Make sure that the clamps on the administration set are open; then, press Start.

The Running screen is displayed, and the infusion begins.

Throughout the infusion, the following information is displayed on the screen:

81

Drug Name: The name of the selected drug. Displayed on the indicators bar,
when working with a Drug Library.
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®  Drug Concentration: Drug concentration as entered by the user (Final
concentration or Drug Amount / Diluent Volume). Displayed when applicable.

®  Rate: Current infusion rate. For all dose units other than mL/h, the calculated rate
will be displayed in mL/h, both in the View system menu and in the Running
screen.

®  VTBI: Total volume left to be infused during the current infusion. As the infusion
progresses, this value decreases.

® VI/ Total: Total volume (including KVO if applied during a delayed start period) /
the VTBI value programmed. As the infusion progresses, the VI increases, and the
Total remains constant.

®  Time left: Time remaining until the end of the current infusion.

When the remaining VTBlis 0.1mL or less, the time left displayed on
0 the screen may deviate up to a few minutes from the actual time
remaining.
If the calculated rate is beyond the pump resolution (0.1 mL/h
increments), the pump decreases the rate by 0.1mL/h during the
infusion, in order to achieve accurate delivery of the volume in the
specified time. The rate reduction is always of 0.1mL/h and is
presented on the running screen (when selecting dose calculation,
the equivalent change to 0.1mL/h applies).

0 To view all programmed parameters of the current infusion,
including the rate in mL/h, from the Running screen, press View/
Edit - View system — Infusion values.
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> To begin a new Continuous infusion with a Drug Library:

1.

2.
3.

4.

83

From the Indicators Bar, verify that the pump is in Continuous mode.

0 For more information about changing delivery modes, refer to
Selecting Delivery Mode on page 56

From the Start Up screen, select New Infusion.
From the Drug Name screen:

® Using the keypad, enter the drug name; then, press Find and proceed to
Step 4.

0 The Find key can be used to display all available drugs without
entering any characters (letters, numbers or symbols), or filter drug
names according to the characters entered.

®  When the required drug is not found in the Drug Library, press Choose
General key on the toolbar:

'Choose General' will bypass specific drug limits, and the infusion
A will be programmed without Drug Library limits.

From the Attention screen, confirm choosing General, and press OK.
Proceed to Step 3 on page 80 (To begin a new Continuous infusion without Drug
Library) and continue programming from there.

From the Drug List screen, select the row of the relevant drug.

0 To display additional drugs press Next.
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5. Ifalist of available drug profiles appears, select the appropriate drug profile and
proceed according to the step directed to:
® No concentration: proceed to Step 7 on page 80 (To begin a new Continuous
infusion without Drug Library), and continue programming from there.
® Diluent only (e.g., 10 mL): proceed to Step 7 on page 80 (To begin a new
Continuous infusion without Drug Library), and continue programming from there.
® Partial concentration: the Drug Amount and/or Diluent Volume are/is missing.
The screen/s of the missing value/s will appear:
® From the Drug Amount screen, using the keypad, enter the Drug Amount
- OK.
® From the Diluent Volume screen, using the keypad, enter the Diluent
Volume = OK.
From the Attention screen, confirm the concentration and press OK.
Proceed to Step 7 on page 80 (To begin a new Continuous infusion without Drug
Library), and continue programming from there.
® Full concentration:
Proceed to Step 7 on page 80 (To begin a new Continuous infusion without Drug
Library), and continue programming from there.
If a list of available drug profiles does not appear, continue to Step 10 on page 81 (To
begin a new Continuous infusion without Drug Library), and continue programming from
there.
For more information about the Drug Library, refer to Chapter 9: Drug Library on
page 160.
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Starting a Continuous Infusion Using the Secondary Function

The following procedure explains how to program a Continuous infusion using both
Primary and Secondary lines.

> To begin a new Continuous infusion using the Secondary option without
Drug Library:

1.

85

Verify that the pump is in Continuous mode, and then enter parameters for the
Primary infusion (Step 2 on page 80 through Step 10 on page 81 in To begin a new
Continuous infusion without Drug Library).

Review the parameters displayed on the Confirm screen.

Verify that the parameters reflect the correct treatment according to
& the prescription.

Then, press OK.
From the Start screen, select Set Secondary.
If the Dosing method screen appears, select the appropriate option:

® mL: Continue to Step 8.
® Dose calculation: Continue to Step 5.
Weight based units are available for both Dosing methods.

Otherwise, continue to Step 11.

From the Concentration units screen, select the appropriate drug units.

0 To display additional concentration units press Next.

According to pump configuration one of the following screens will appear:
® Concentration: From the Concentration screen, using the keypad, enter the
Concentration = OK. Then, continue to Step 8.

® Drug amount: Using the keypad, enter the Drug Amount = OK. Then, using
the keypad, enter the Diluent Volume - OK. Then, continue to Step 7.
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10.
11.

12.

From the Attention screen, confirm the Concentration and press OK.
If the selected drug unit is Million Units, continue to Step 10.
If the Patient Weight screen appears, specify whether the infusion is weight based:

® Yes: Continue to Step 9.

® No: Continue to Step 10.

From the Patient Weight screen:

If the patient weight was entered during the primary line programming, continue
to Step 10.

If the patient weight was not entered during the primary line programming, using
the keypad, enter the Patient Weight - OK.

From the Dose Rate units screen, select the appropriate dose rate units.
Program 2 of the following 3 parameters, by selecting the relevant boxes:

® Rate (Secondary): Using the keypad, enter the value > OK.

® VTBI (Secondary): Using the keypad, enter the value - OK.

® Time (Secondary): Using the keypad, enter the value - OK.

The third (unprogrammed) parameter is then automatically calculated by the
pump and displayed in the relevant box.

If the dose rate is beyond the pump resolution of 0.1 mL/h

0 increments, the pump will increase or decrease the rate by up to
0.05 mL/h. This flow rate (mL/h) is presented on the running screen
during infusion. For example, if the dose rate entered is 20 mg/h,
which is equivalent to 3.64 ml/h, the pump will decrease the rate to
3.6 ml/h and display it on the running screen.

Review the parameters displayed on the Confirm screen.

Verify that the parameters reflect the correct treatment according to
the prescription.
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Then, press OK.

13. From the Start screen, select one of the following:

® Start secondary: The Attention screen appears. After verifying that the clamps
on the Secondary administration set are open, press OK. The Secondary
screen appears, and the Secondary infusion begins. When the Secondary
infusion is complete, the pump automatically continues with the Primary
infusion.

® Start primary: The Attention screen appears. After closing the clamp on the
Secondary administration set, make sure that the clamps on the primary
administration set are open; then, press OK. The Primary screen appears, and
the Primary infusion begins.

Throughout the infusion, the Indicators Bar displays information regarding the current
infusion (Primary, Secondary or the name of the drug infused). After the secondary
infusion is completed, the pump automatically switches to the primary line, and beeps
to notify the user. The following information is displayed on the Primary/Secondary
screen:

87

Drug Name: The name of the selected drug. Displayed on the indicators bar,
when working with a Drug Library.

Drug Concentration: Drug concentration as entered by the user (Final
concentration or Drug Amount / Diluent Volume). Displayed when applicable.

Rate: Current infusion rate. For all dose units other than mL/h, the calculated rate
will be displayed in mL/h, both in the View system menu and in the Running
screen.

VTBI: Total volume left (in the current infusion) to be infused. As the infusion
progresses, this value decreases.

VI / Total: Total volume (including KVO if applied during a delayed start period) /
the VTBI value programmed. As the infusion progresses, the VI increases, and the
Total remains constant.
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®  Time left: Time remaining until the end of the current infusion.

When the remaining VTBlis 0.1mL or less, the time left displayed on
0 the screen may deviate up to a few minutes from the actual time
remaining.
o You can switch between the two infusions at any time. For more
information, refer to Switching between Primary and Secondary

Infusions on page 101.

To view all programmed parameters of the current infusion,

0 including the rate in mL/h, from the Running screen, press View/
Edit > View system — Infusion values.
For all dose units other than mL/h, the calculated rate will be
displayed in mL/h, both in the View system menu and in the
Running screen.

> To begin a new Continuous infusion using the Secondary option with a
Drug Library:

1. Verify that the pump is in Continuous mode, and then enter parameters for the
Primary infusion (To begin a new Continuous infusion with a Drug Library Step 2 on
page 83 to Step 5 on page 84).

2. Review the parameters displayed on the Confirm screen.

Verify that the parameters reflect the correct treatment according to
& the prescription.

Then, press OK.
3. From the Start screen, select Set Secondary.

4. From the Drug Name screen:
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® Using the keypad, enter the drug name, then press Find and proceed to
Step 5.

0 The Find key can be used to display all available drugs without
entering any characters (letters, numbers or symbols), or filter drug
names according to the characters entered.

®  When the required drug is not found in the Drug Library, press Choose
General key on the toolbar:

'Choose General' will bypass specific drug limits, and the infusion
A will be programmed without Drug Library limits.

From the Attention screen, confirm choosing General and press OK.
Proceed to Step 4 on page 85 (To begin a new Continuous infusion using the Secondary
option without Drug Library) and continue programming from there.

From the Drug List screen, select the row of the relevant drug.

0 To display additional drugs press Next.

If a list of available drug profiles appears, select the appropriate drug profile and
proceed according to the step directed to:
® No concentration: proceed to Step 8 on page 86 (To begin a new Continuous
infusion using the Secondary option without Drug Library), and continue
programming from there.
® Diluent only (e.g., 10 mL): proceed to Step 8 on page 86 (To begin a new
Continuous infusion using the Secondary option without Drug Library), and continue
programming from there.
® Partial concentration: the Drug Amount and/or Diluent Volume are/is missing.
The screen/s of the missing value/s will appear:
® From the Drug Amount screen, using the keypad, enter the Drug Amount
- OK.
® From the Diluent Volume screen, using the keypad, enter the Diluent
Volume = OK.
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From the Attention screen, confirm the concentration and press OK.

Proceed to Step 8 on page 86 (To begin a new Continuous infusion using the
Secondary option without Drug Library), and continue programming from there.

® Full concentration:

Proceed to Step 8 on page 86 (To begin a new Continuous infusion using the
Secondary option without Drug Library), and continue programming from there.

If a list of available drug profiles does not appear, continue to Step 11 on page 86
(To begin a new Continuous infusion using the Secondary option without Drug Library),
and continue programming from there.

For more information about the Drug Library, refer to Chapter 9: Drug Library on
page 160.
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Continuous Mode: Mid-infusion Actions

The following actions can be performed during Continuous infusions:

Updating Infusion Parameters
AdMINISEENING @ BOIUS ..oiviieeiiiiie e e e eeea e e e e a e e e eaaaeeees

FiYo Lo [ oY= BNY=Yolo o Lo =T VAN T o 1PN
Switching between Primary and Secondary Infusions .

Replacing the Current Secondary LINE ......cciivvieriiiiiine e e e e
Pausing Infusions
Infusion Standby .......
Aborting Infusions
LOCKING ThE SCrEEN ....iiiiiiee et e et e e e et e e e e aa e e e e st e eaaaeneeaees

Activating Patient LOCKOUL .....cuuueiiiiiiieeiiiiie et e e et e e eea e e e eran s

Updating Infusion Parameters

Infusion parameters can be modified by using the View/Edit function key. In addition,
you can modify the rate, VTBI, and time left directly from the Running, Primary or
Secondary screen.

> To update current parameters directly from the screen:

1.
2.
3.

On the Main Display, select the relevant parameter (Rate, VTBI or Time left).
Using the keypad, enter the new value of the parameter - OK.

To confirm and save changes, press OK.
To return to the original infusion screen without saving changes, press Back.

> To update parameters using the View/Edit function key:

Hownn -

21

From the toolbar, press View/Edit.
Select the box of the parameter to be updated.
Using the keypad, enter the new value of the parameter - OK.

To update other parameters, repeat Steps 2-3.

In addition to parameter changes, the following actions are also available:
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® Clear Accum. VI: Resets the total volume infused via all infusions associated
with the current patient to O mL. For more information, refer to Clearing
Accumulated VI on page 157.

® View system: Displays various system and pump parameters. (Refer to View
Menu on page 138.)

® Edit Primary/Secondary Line: Allows you to update infusion parameters of
the infusion that is not currently running. The pump will prompt you to pause
the infusion while updating these parameters.

5. To confirm and save changes, press OK.

To return to the original infusion screen without saving changes, press Back. Then,
from the Attention screen, press OK.

If the dose rate is beyond the pump resolution of 0.1mL/h

0 increments, the pump will increase or decrease the rate by up to
0.05mL/h. This flow rate (mL/h) is presented on the running screen
during infusion.

Administering a Bolus

The Bolus feature enables administration of a fast dose, when rapid volume infusion in
the Continuous mode is necessary.

Bolus delivery allows infusion at high rates. Only certified medical
A personnel should use this feature.
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> To deliver a bolus:

1.

93

From the toolbar of the Running, Primary or Secondary screen, press Bolus.

0 For the Bolus button to appear on a Continuous running infusion,
the pump needs to be configured to the Allow Bolus setting. The
Allow Bolus setting can be modified by Technicians only. For more
information, refer to the Service Manual. If a Drug Library is installed
on the pump, the Bolus button will appear only if the option was
enabled for a specific drug, or an entire CCA.

If the Patient Weight screen appears, using the keypad, enter the Patient Weight
- OK.

According to configuration, one of the following screens will appear:

0 When using the ICU Medical MedNet™ Drug Library, bolus
programming is only done via the Edit option.

°* Edit:
® Amnt (Bolus): Using the keypad, enter the Bolus Amount = OK (the
acceptable range varies, according to the current VTBI).

0 Trying to enter one of the unavailable (grayed out) boxes, triggers a
message requesting to enter the Bolus amount first.

Enter one of the following parameters, by selecting the relevant box:
® Rate (Bolus): Using the keypad, enter the Bolus Rate - OK.
® Time (Bolus): Using the keypad, enter the Bolus Time - OK.

The third (unprogrammed) parameter is then automatically calculated by the
pump and displayed in the relevant box.

Continue to Step 4.
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® Bolus Amount: Using the keypad, enter the Bolus Amount = OK (the
acceptable range varies according to the current VTBI). Then, continue to

Step 5.
When trying to exit programming before its completion, a message
0 is displayed stating that the data entered has not been saved.
Bolus units used may differ from the units used by the infusion, due
0 to their pre-configuration in the Drug Library.
When the bolus is programmed by amount only, the default bolus
0 rate is 125 mL/h. This default can be modified using a Technician

authorization code.

When the infusion rate is higher than 125 mL/h, the bolus rate will
be 1 mL/h faster than the infusion rate.

During a bolus, some of the parameters can be updated from the

Bolus delivery screen. For more information, refer to Updating Bolus
Infusion Parameters on page 95.

4. Review the parameters displayed on the Confirm screen.

Verify that the parameters reflect the correct treatment according to
& the prescription.

Then, press OK.
5. To start the bolus, from the Attention screen, press OK.

The Bolus delivery screen is displayed, and the bolus begins.
Throughout the bolus, the following information is displayed on the screen:

®  Drug Name: The name of the selected drug. Displayed on the indicators bar,
when working with a Drug Library.

Using the Delivery Modes



®  Drug Concentration: Drug concentration as entered by the user (Final
concentration or Drug Amount / Diluent Volume). Displayed when applicable.

®  Bolus Rate: Current infusion rate.

®  Bolus VTBI: Total bolus amount left to be infused. As the bolus progresses, this
value decreases.

®  Bolus VI / Total: Total bolus amount that has been infused during the current
infusion / the total bolus amount programmed. As the infusion progresses, the
Bolus VI increases, and the Total remains constant.

®  Time left: Time remaining until the end of the bolus.

When the bolus is complete, a message appears on the Main Display.

Mid-bolus Actions

The following actions can be performed during bolus delivery:

Updating Bolus INfusion Parameters ............ouuoeeiiiiiiieiiiiiie e 95
U =4 T 2T [ TN 96
ADOITING @ BOIUS «.eiiiiiieiie e e e et e e e et e e s et e e e et e e e et aaees 96

Updating Bolus Infusion Parameters
Bolus infusion parameters are updated directly from the Bolus delivery screen.
> To update parameters from the Bolus delivery screen:

1. On the Main Display, select the relevant frame (Bolus Rate, Bolus VTBI or Time
Left).

The Time Left parameter is not configurable, when the bolus was
0 programmed by amount only.

2. Using the keypad, enter the new Rate, VTBI or Time left > OK.
3. From the Attention screen, press OK.
Updated parameters are displayed.

95 SapphirePlus Infusion Pump User Manual



Pausing a Bolus
When necessary, you can temporarily stop the bolus.
> To pause a bolus:

®  From the toolbar of the bolus delivery screen, press Pause Bolus. Then, from the
Attention screen, press OK.
Alternatively, press the Stop hard key.
All volume delivery stops.

> To resume a paused bolus:
1. From the toolbar of the bolus delivery screen, press Continue Bolus.

2. From the Attention screen, press OK.

Aborting a Bolus

The following procedures involve pausing and then permanently quitting the bolus,
with the option to quit the entire infusion.

> To abort a bolus and quit all infusions:

1. Press the Stop hard key. Alternatively, press the Pause Bolus, then press OK.
The bolus is paused.

2. From the toolbar, press Quit Bolus.

w

From the toolbar of the Paused screen, press Quit.

4. From the Attention screen, press Quit infusion.

0 Resuming infusion after quitting will not be possible.

> To abort a bolus and continue the infusion (Secondary option not in use):

1. Press the Stop hard key. Alternatively, press the Pause Bolus, then press OK.
The bolus is paused.

2. From the toolbar, press Quit Bolus.
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3. From the toolbar of the Paused screen, press Request Continue.
4. From the Attention screen, press OK.
> To abort a bolus and continue the infusion (Secondary option in use):

1. Press the Stop hard key. Alternatively, press the Pause Bolus, then press OK. The
bolus is paused.

From the toolbar, press Quit Bolus.
From the toolbar of the Paused screen, press Switch or Continue.

From the Start screen, press Primary or Secondary.

ok~ wN

From the Attention screen, press OK.

Adding a Secondary Line

The following procedure explains how to add a Secondary line while a Primary infusion
is already running.

o If you have already programmed the Secondary infusion, and want
to start it, refer to Switching between Primary and Secondary
Infusions on page 101.

Before programming a Secondary infusion, verify that the

A administration set you are using is appropriate for Secondary
(Piggyback) infusions. For more information, refer to Q Core Approved
Administration Sets on page 48.

> To add a Secondary line while a Primary line is running, without Drug
Library:

1. From the toolbar, press View/Edit.
2. Select Add Sec. Line.
3. If the Dosing method screen appears, select the appropriate option:

® mL: Continue to Step 7.
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9.

® Dose calculation: Continue to Step 4.
Weight based units are available for both Dosing methods.

Otherwise, continue to Step 10.

From the Concentration units screen, select the appropriate drug units.

6 To display additional concentration units press Next.

According to pump configuration one of the following screens will appear:

® Concentration: From the Concentration screen, using the keypad, enter the
Concentration = OK. Then, continue to Step 7.

® Drug amount: Using the keypad, enter the Drug Amount = OK. Then, using
the keypad, enter the Diluent Volume = OK. Then, continue to Step 6.

From the Attention screen, confirm the concentration and press OK.
If the selected drug unit is Million Units, continue to Step 9.

If the Patient Weight screen appears, specify whether the infusion is weight based:
® Yes: Continue to Step 8.

® No: Continue to Step 9.

From the Patient Weight screen:

If the patient weight was entered during the primary line programming, continue
to Step 9.

If the patient weight was not entered during the primary line programming, using
the keypad, enter the Patient Weight = OK.

From the Dose Rate units screen, select the appropriate dose rate units.

10. Program 2 of the following 3 parameters, by selecting the relevant boxes:

® Rate (Secondary): Using the keypad, enter the value - OK.
® VTBI (Secondary): Using the keypad, enter the value - OK.
® Time (Secondary): Using the keypad, enter the value - OK.
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1.

The third (unprogrammed) parameter is then automatically calculated by the
pump and displayed in the relevant box.

0 If the dose rate is beyond the pump resolution of 0.1 mL/h

increments, the pump will increase or decrease the rate by up to
0.05 mL/h. This flow rate (mL/h) is presented on the running screen
during infusion.

Review the parameters displayed on the Confirm screen.

Verify that the parameters reflect the correct treatment according to

&R the prescription.

Then, press OK.

12. From the Start screen, select one of the following:

Start secondary: The Attention screen appears. After verifying that the clamps
on the Secondary administration set are open, press OK. The Secondary
screen appears, and the Secondary infusion begins. When the Secondary
infusion is complete, the pump automatically continues with the Primary
infusion.

Continue primary: The Primary screen appears, and the Primary infusion
begins.

For more information about switching from one infusion to the other, refer to
Switching between Primary and Secondary Infusions on page 101.

> To add a Secondary line while a Primary line is running, with a Drug

Library:
1.
2.
3.
°
99

From the toolbar, press View/Edit.

Select Add Sec. Line.

From the Drug Name screen:

Using the keypad, enter the drug name, then press Find and proceed to
Step 4.

0 The Find key can be used to display all available drugs when not

entering any characters (letters, numbers or symbols), or filter drug
names according to the characters entered.
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®  When the required drug is not found in the Drug Library, press the Choose
General key on the toolbar:

'Choose General' will bypass specific drug limits, and the infusion
A will be programmed without Drug Library limits.

From the Attention screen, confirm choosing General and press OK.
Proceed to Step 3 on page 97 (To add a Secondary line while a Primary line is running,
without Drug Library), and continue programming from there.

4. From the Drug List screen, select the row of the relevant drug.

0 To display additional drugs press Next.

5. Ifalist of available drug profiles appears, select the appropriate drug profile and
proceed according to the step directed to:
® No concentration: proceed to Step 7 on page 98 (To add a Secondary line while
a Primary line is running, without Drug Library), and continue programming from
there.
® Diluent only (e.g., 10 mL): proceed to Step 7 on page 98 (To add a Secondary
line while a Primary line is running, without Drug Library), and continue
programming from there.
® Partial concentration: the Drug Amount and/or Diluent Volume are/is missing.
The screen/s of the missing value/s will appear:
® From the Drug Amount screen, using the keypad, enter the Drug Amount
- OK.
® From the Diluent Volume screen, using the keypad, enter the Diluent
Volume = OK.
From the Attention screen, confirm the concentration and press OK.

Proceed to Step 7 on page 98 (To add a Secondary line while a Primary line is
running, without Drug Library), and continue programming from there.

® Full concentration:

Proceed to Step 7 on page 98 (To add a Secondary line while a Primary line is
running, without Drug Library), and continue programming from there.
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If a list of available drug profiles does not appear, continue to Step 7 on page 98
(To add a Secondary line while a Primary line is running, without Drug Library), and
continue programming from there.

For more information about the Drug Library, refer to Chapter 9: Drug Library on
page 160.

Switching between Primary and Secondary Infusions

Switching between infusions involves pausing the infusion that is currently running, and
then starting or continuing the other infusion.

> To switch from the Primary to the Secondary infusion:

1. Pause the Primary infusion:

From the toolbar of the Primary screen, press Request Pause. Then, from the
Attention screen, press OK.
Alternatively, press the Stop hard key.

2. From the toolbar of the Primary screen, select Switch or Continue.

3. From the Start screen, select Start secondary.

The Attention screen appears. After verifying that the clamps on the Secondary
administration set are open, press OK. The Secondary screen appears, and the
Secondary infusion begins.

> To switch from the Secondary to the Primary infusion:

1. Pause the Secondary infusion:
From the toolbar of the Secondary screen, press Request Pause. Then, from the
Attention screen, press OK.
Alternatively, press the Stop hard key.

2. From the toolbar of the Secondary screen, select Switch or Continue.
3. From the Start screen, select Continue primary (or Start primary).

The Attention screen appears. After verifying that the clamps on the Secondary
administration set are closed, and that the clamps on the primary set are open,
press OK. The Primary screen appears, and the Primary infusion begins.
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Replacing the Current Secondary Line

During a running secondary infusion, the secondary line can be replaced by using one
of the following methods:

Deleting the Current Secondary Line and Moving to the Primary Infusion ................ 102
Replacing the Current Secondary Line with a New Secondary Line ........c.ceuvuvieeeeneens 103

Deleting the Current Secondary Line and Moving to the Primary Infusion

The following procedure explains how to delete the running secondary line and move
to the primary infusion.

> To delete the secondary line and move to the primary infusion:

1.

ok wN

Pause the Secondary infusion:

From the toolbar of the Secondary screen, press Request Pause. Then, from the
Attention screen, press OK.

Alternatively, press the Stop hard key.

From the toolbar of the paused screen, press View/Edit.
On the View/Edit screen, select Delete/Replace Sec. Line.
On the Delete/Replace screen, select Delete and move to primary.

The Attention screen appears. After verifying that the clamps on the Secondary
administration set are closed, and that the clamps on the primary set are open,
press OK. This will delete the current programmed secondary line.

The paused Primary screen appears.
From the toolbar of the paused Primary screen, select Request Continue.

Then, from the Attention screen, press OK.

If you want to program a new Secondary line, refer to Adding a
0 Secondary Line on page 97.
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Replacing the Current Secondary Line with a New Secondary Line

The following procedure explains how to replace the current secondary line with a
different secondary infusion.

Before programming a Secondary infusion, verify that the

A administration set you are using is appropriate for Secondary
(Piggyback) infusions. For more information, refer to Q Core Approved
Administration Sets on page 48.

> To replace the running secondary line with a different secondary line
without Drug Library:

1.

gos W N
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Pause the Secondary infusion:

From the toolbar of the Secondary screen, press Request Pause. Then, from the
Attention screen, press OK.

Alternatively, press the Stop hard key.

From the toolbar of the paused screen, press View/Edit.
On the View/Edit screen, select Delete/Replace Sec. Line.
On the Delete/Replace screen, select Replace secondary.

From the Attention screen press OK to delete the current secondary line and to
program a different secondary infusion.

Proceed to Step 3 on page 97 (To add a Secondary line while a Primary line is running,
without Drug Library).
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> To replace the running secondary line with a different secondary line with
Drug Library:

1. Pause the Secondary infusion:

From the toolbar of the Secondary screen, press Request Pause. Then, from the
Attention screen, press OK.
Alternatively, press the Stop hard key.

From the toolbar of the paused screen, press View/Edit.
On the View/Edit screen, select Delete/Replace Sec. Line.

On the Delete/Replace screen, select Replace secondary.

ok wnN

From the Attention screen press OK to delete the current secondary line and to
program a different secondary infusion.

6. Proceed to Step 3 on page 99 (To add a Secondary line while a Primary line is running,
with a Drug Library).
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Multi-step Mode

The following sections will be reviewed:

Infusion Parameters: Multi-step MOE .......ccovveiiiiiiiiiiiiiiiee e e e e e 106
Starting @ Multi-step INFUSION ....eiiiiiiieiiie e e et eeeaa s 106
Multi-step Mode: Mid-infusion ACLIONS .....ccevueieiiiiiieeeiiiie e e eera e e 112

This mode allows the pump to deliver a series of up to 25 consecutive infusion Steps
from the same infusion container. Each Step is delivered as a Continuous infusion, at its
own pre-programmed parameters. Although the infusion rates of each Step can differ,
the rate within a single Step does not vary (constant, continuous infusion).

Figure 5.3. Multi-step Flow Profile
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Infusion Parameters: Multi-step Mode

When programming a Multi-step infusion, the number of Steps must be specified.
Infusion parameters relevant to each Step are listed in the following table. During
programming, it is necessary to specify two of the three parameters. The remaining
parameter is then automatically calculated by the pump.

Parameter Description/Notes

Rate The speed at which the fluid is infused. Rate values can range from
0.1 to 999 mL/h.
Note: When selecting units that are not from the mL/h family, the
word Rate is replaced with Dose Rate.

VTBI The total amount of fluid to be infused. The remaining VTBI is
displayed on the screen as the infusion progresses. VTBI values can
range from 0.1 to 9999 mL.

Time The period of time over which the fluid is infused. The acceptable
range for time values vary according to the VTBI. The maximum
Step time is 24 hours.

Starting a Multi-step Infusion

The following procedure explains how to program the pump to start a new Multi-step
infusion.

If relevant, you may skip programming by using the Repeat Last
o Infusion or PreSet programs procedures to begin the infusion. For

more information, refer to Starting New Infusions: Shortcuts on

page 114. To restart infusion by adding VTBI during post infusion,

refer to Restarting the Infusion during the Post Infusion State on

page 124.

> To begin a new Multi-step infusion without Drug Library:

1. From the Indicators Bar, verify that the pump is in Multi-step mode.

o For more information about changing delivery modes, refer to
Selecting Delivery Mode on page 56.
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11.

107

From the Start Up screen, select New Infusion.

If the Dosing method screen appears, select the appropriate option:

® mL: Continue to Step 7.
® Dose calculation: Continue to Step 4.
Weight based units are available for both Dosing methods.

Otherwise, continue to Step 10.

From the Concentration units screen, select the appropriate drug units.

0 To display additional concentration units press Next.

According to pump configuration one of the following screens will appear:

® Concentration: From the Concentration screen, using the keypad, enter the
Concentration = OK. Then, continue to Step 7.

® Drug amount: Using the keypad, enter the Drug Amount = OK. Then, using
the keypad, enter the Diluent Volume = OK. Then, continue to Step 6.

From the Attention screen, confirm the concentration and press OK.
If the selected drug unit is Million Units, continue to Step 9.
If the Patient Weight screen appears, specify whether the infusion is weight based:

® Yes: Continue to Step 8.
® No: Continue to Step 9.

From the Patient Weight screen, using the keypad, enter the Patient Weight -
OK.

From the Dose Rate units screen, select the appropriate dose rate units.

. Using the keypad, enter the number of Steps required for the infusion, and then

press OK.

For the first Step, program 2 of the following 3 parameters, by selecting the
relevant boxes (the digit refers to the number of the Step):

® Rate 1: Using the keypad, enter the value » OK.
® VTBI 1: Using the keypad, enter the value > OK.
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® Time 1: Using the keypad, enter the value - OK.
The unprogrammed parameter is then automatically calculated by the pump, and
displayed in the relevant box.

If the dose rate is beyond the pump resolution of 0.1 mL/h

0 increments, the pump will increase or decrease the rate by up to
0.05 mL/h. This flow rate (mL/h) is presented on the running screen
during infusion.

12. After reviewing the infusion parameters for the current Step (as displayed on the
Indicators Bar), press OK to proceed and program the next Step.

13. To program parameters for the remaining Steps of the infusion, repeat Step 11

through Step 12 of this procedure.

After the final Step is programmed, the Confirm screen appears, displaying the

following parameters:

® Total VTBI: Amount of fluid to be delivered during the entire infusion.

® Total time: Time period of the entire infusion.

® Number of steps: Number of Steps making up the total infusion.

® Review Steps details: Selecting this option displays the parameters of all
programmed Steps, screen by screen (with each step displayed in its own
screen).

14. Review the parameters displayed on the Confirm screen.

Verify that the parameters reflect the correct treatment according to
y o the prescription.

Then, press OK.
15. Make sure that the clamps on the administration set are open; then, press Start.

The Running screen is displayed, and the infusion begins.
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Throughout the infusion, the current Step number is displayed on the Indicators Bar
(e.g., Running 1/6) and next to parameter on main display (Rate 1,VTBI 1 and Time 1).
The transition between steps is accompanied by a beep. In addition, the following
information appears on the screen:

®  Drug Name: The name of the selected drug. Displayed on the indicators bar,
instead of the step number, when working with a Drug Library.

®  Drug Concentration: Drug concentration as entered by the user (Final
concentration or Drug Amount / Diluent Volume). Displayed when applicable.

®  Rate: Current infusion rate. For all dose units other than mL/h, the calculated rate
will be displayed in mL/h, both in the View System menu and in the Running
screen.

®  VTBI: Total volume left to be infused during the current Step.

®  VI/ Total: Total volume (including KVO if applied during a delayed start period) /
the total VTBI (for the entire infusion). As the infusion progresses, the VI increases,
and the Total remains constant.

®  Time left: Time remaining until the end of the entire infusion.

®  Step Time: Time remaining until the end of the current Step.

0 When the remaining VTBI is 0.1TmL or less, the time left displayed on
the screen may deviate up to a few minutes from the actual time
remaining.
0 To view all programmed parameters of the current infusion,
including the rate in mL/h, from the Running screen, press View/

Edit - View system — Infusion values.
For more information, refer to Viewing System Parameters on
page 139.

109 SapphirePlus Infusion Pump User Manual



> To begin a new Multi-step infusion with a Drug Library:

1. From the Indicators Bar, verify that the pump is in Multi-step delivery mode.

0 For more information about changing delivery modes, refer to
Selecting Delivery Mode on page 56.

2. From the Start Up screen, select New Infusion.
3. From the Drug Name screen:

® Using the keypad, enter the drug name, then press Find and proceed to
Step 4.

0 The Find key can be used to display all available drugs when not
entering any characters (letters, numbers or symbols), or filter drug
names according to the characters entered.

®  When the required drug is not found in the Drug Library, press Choose
General key on the toolbar:

'Choose General' will bypass specific drug limits, and the infusion
A will be programmed without Drug Library limits.

From the Attention screen, confirm Choosing General, and press OK.
Proceed to Step 3 on page 107 (To begin a new Multi-step infusion without Drug
Library), and continue programming from there.

4. From the Drug List screen, select the row of the relevant drug.

0 To display additional drugs press Next.
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5. Ifalist of available drug profiles appears, select the appropriate drug profile and
proceed according to the step directed to:
® No concentration: proceed to Step 7 on page 107 (To begin a new Multi-step
infusion without Drug Library), and continue programming from there.
® Diluent only (e.g., 10 mL): proceed to Step 7 on page 107 (To begin a new
Multi-step infusion without Drug Library), and continue programming from there.
® Partial concentration: the Drug Amount and/or Diluent Volume are/is missing.
The screen for the missing value will appear:
® From the Drug Amount screen, using the keypad, enter the Drug Amount
- OK.
® From the Diluent Volume screen, using the keypad, enter the Diluent
Volume = OK.

From the Attention screen, confirm the concentration and press OK.

Proceed to Step 7 on page 107 (To begin a new Multi-step infusion without Drug
Library), and continue programming from there.

® Full concentration:

Proceed to Step 7 on page 107 (To begin a new Multi-step infusion without Drug
Library), and continue programming from there.

If a list of available drug profiles does not appear, continue to Step 7 on page 107
(To begin a new Multi-step infusion without Drug Library), and continue programming
from there.

For more information about the Drug Library, refer to Chapter 9: Drug Library on

page 160.
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Multi-step Mode: Mid-infusion Actions

The following actions can be performed during Multi-step infusions:

Updating Step Parameters
PaUSING INTUSIONS Luuueiiiiiiie e et e et e et e e e et e e e eaa e e e eateaeeaaaenaaanes
Aborting Infusions
Locking the Screen
Activating Patient Lockout

Updating Step Parameters

Infusion parameters for the current Step can be modified directly from the Running
screen. In addition, infusion parameters for the current Step and the following Step can

be updated by using the View/Edit function key.

Parameters for only the current Step and the Step immediately
0 following it can be modified.

If the step being updated ends before the change is made or
0 confirmed, the change will not be made and an Attention screen
will appear.

> To update current Step parameters from the Running screen:

1.

2.

Select the frame of the parameter that you want to update (Rate, VTBI or Step
Time).

Using the keypad, enter the new rate, VTBI (during the Step), or time remaining
until the end of the Step - OK.

To confirm and save changes, press OK.
To return to the original infusion screen without saving changes, press Back.
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> To update parameters of the current or next Step using the View/Edit
function key:

1. From the toolbar, press View/Edit.

2. Select the box of the relevant parameter.

3. Using the keypad, enter the new value of the parameter = OK.
4. To update other parameters, repeat Steps 2-3.

In addition to parameter changes, the following actions are also available:

® Clear Accum. VI: Resets the total volume infused via all infusions associated
with the current patient to O mL. For more information, refer to Clearing
Accumulated VI on page 157.

® Next step: Allows you to update infusion parameters of the Step following the
current Step. (This box appears only if there is a Step following the current
Step.)

® View system: Displays various system and pump parameters.
5. To confirm and save changes, press OK.

To return to the Running screen without saving changes, press Back.
Then, from the Attention screen, press OK.

If the dose rate is beyond the pump resolution of 0.1mL/h

0 increments, the pump will increase or decrease the rate by up to
0.05mL/h. This flow rate (mL/h) is presented on the running screen
during infusion.
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Chapter 6: Basic Infusion Operations

The following sections explain procedures and actions that are commonly performed in
all delivery modes to start and manage infusions:

Starting New INfusions: SNOMTCULS ........eiiiiiieiiiiee e 114
Resuming Infusions After Pump Shutdown ...........coueeiiiiiiiiiiiiie e, 117
Mid- and Post INfUSION ACHIONS .euvueeiiieei i e e e e e e e e e 118

Starting New Infusions: Shortcuts

The following shortcut operations allow you to begin an infusion without the need to
enter required parameters:
Repeating Last INFUSION .....oovuuiiiiiiii e e e e 114
USING @ PreSet PrOZram ...ou.ii ittt et e e e e et e ae e e e e eae e e eanaees 115

Repeating Last Infusion

Repeat Last Infusion is a quick method to continue the infusion with a new IV bag, after
the first one has been emptied or discontinued (the same infusion parameters used for
the same patient). The pump automatically saves all the parameters programmed,
excluding secondary line, for the last infusion performed in that delivery mode. If a
parameter is updated while an infusion is running, the updated parameter is saved. The
Last Infusion settings are saved even if the last infusion was not completed or the pump
has been turned Off. The Repeat Last Infusion option may be available only if it is

enabled on the pump.

0 When using the Repeat Last Infusion option, the Accumulated VI
parameter and the remaining Lockout Time are not cleared;
instead they continue counting from the previous infusion. For more
information about Accumulated VI, refer to Using the New Patient
Feature on page 155.
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Information about Secondary (Piggyback) infusions is not saved.
This option is not relevant to Secondary infusions.

Repeat Last Infusion is not available (grayed out) when the pump
settings differ from those used for the previous infusion. These
include: CCA, regional settings, and the flow rate of the previous
infusion exceeding the current hard limit. Additionally, it is not
available for an infusion in which Add VTBI was used.

> To repeat the last infusion:

1. From the Start Up screen, select Repeat Last Infusion.

2. Review the parameters displayed on the Confirm screen.

Verify that the parameters reflect the correct treatment according to
the prescription.

Then, press OK.

3. To begin the infusion, make sure that the clamps on the administration set are
open, and press Start.

The Running screen appears, and the infusion begins.

Using a PreSet Program

The PreSet Programs function allows you to select an infusion with predefined
parameters. Each delivery mode can support up to 10 PreSet programs. PreSet
programs are available only in the delivery mode in which they were saved.

This feature is available when the ICU Medical MedNet™ Drug
Library is not used.

When not under the ICU Medical MedNet™ Drug Library, in order
for the PreSet Programs function to appear in the Start Up screen,
the pump needs to be configured to the Allow PreProgram setting.
For more information, refer to Configuring General Settings on

page 132.
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> To start an infusion using the PreSet Programs function:

1.

From the Start Up screen, select PreSet Programs.

If no PreSet program was saved in the current delivery mode, a
0 blank screen appears.
For more information about adding or modifying a program, refer
to Creating and Editing PreSet Programs on page 148.

Select the row of the desired program.

0 To display additional programs, press Next.

Review the parameters that are displayed.

Verify that the parameters reflect the correct treatment according to
/ the prescription.

Then, press OK.

To begin the infusion, make sure that the clamps on the administration set are
open, and press Start.

The Running screen appears, and the infusion begins.
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Resuming Infusions After Pump Shutdown

When the pump is turned Off during an active infusion (running or paused), the option
to resume the previous infusion will be displayed after the pump is turned On:

®  To resume the infusion: on the Attention screen, press OK. The running screen
appears.

0 The option to resume will not be available if the pump was shut
down due to a critical alarm, or if the infusion was quit.

® To abort the previous infusion: on the Attention screen, press Exit. The Start Up
screen appears.

When a Drug Library is loaded on the pump, the Clinical Care Area
0 screen appears. The user can either accept or change the current

CCA. For more information, refer to Clinical Care Area (CCA) on

page 161.
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Mid- and Post Infusion Actions

The following sections describe procedures that are commonly performed during an

infusion:
Pausing Infusions
Infusion Standby .......
Aborting Infusions

LOCKING ThE SCrEEN ...ttt e e e et e e e et e e e aaaaeeeees

Activating Patient Lockout

ENding an INFUSION ...iiiiiiiie ettt et e e et e e eaaa e e e
Restarting the Infusion during the Post Infusion State ..........cccevviiiiiiiiiiiiiiniiiiiene,

Pausing Infusions

The Pause function allows you to temporarily stop an infusion. Infusions can be paused
using either the Request Pause function key, or, in an emergency, the Stop hard key.
A message stating that the infusion has been paused appears 30 seconds after pausing

the infusion (audible and visual).

0 Pressing the Stop hard key stops the infusion immediately,
bypassing the need for confirmation of the Pause action. In an
emergency, it is recommended to pause the infusion using the
Stop hard key. In routine situations, using the Request Pause
function key is recommended.

o Turning the pump Off after pausing the infusion allows the user to
resume this infusion after turning the pump back on.

> To pause an infusion using the Stop hard key:

®  Atthe bottom of the pump, press Stop. The infusion is paused.

0 When the Patient Lockout or Lock Screen features are activated, it is
necessary to confirm pausing from the Attention screen, by pressing

OK.

Basic Infusion Operations

118



> To pause an infusion using the Request Pause function key:
1. From the toolbar, press Request Pause.
2. From the toolbar of the Attention screen, press OK.

3. The infusion is paused.

0 If you do not press OK within 30 seconds, the infusion is not
paused, and the Running screen reappears.

> To resume a paused infusion:
1. From the toolbar, press Request Continue.

2. From the toolbar of the Attention screen, press OK.

Infusion Standby

The Standby function allows you to temporarily stop the current infusion without being
alerted for pump inactivity (up to 72 hours). The Standby option is available from the
View/Edit menu during an active (running or paused) infusion.

Infusion parameters may be edited during Standby.

> To enter the Standby mode during an infusion:
1. From the toolbar of the infusion screen, press View/Edit.
2. From the toolbar of the View/Edit screen, press Standby.

3. From the toolbar of the Attention screen, press OK.
The infusion is paused, until it is resumed manually (see To resume a paused infusion
above).

If the pump is turned Off during Standby for less than 72 hours,

0 when it is turned On again, the option to resume the infusion will be
available. For more information, refer to Resuming Infusions After
Pump Shutdown on page 117.
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> To continue infusion from standby mode:

1. From the toolbar press End Standby.
The Pause screen appears.

2. To continue infusion, press Request continue.
3. From the Attention screen, press OK.
> To abort infusion from the Standby mode:

1. From the toolbar, press End Standby.
The Pause screen appears.

2. From the toolbar, press Quit.

3. In the Attention screen, press Quit Infusion.

Aborting Infusions
Aborting an infusion is performed using one of the following methods:

®  Pausing and then quitting the infusion: Returns the pump to the Start Up screen.
Resuming the infusion after quitting is impossible.

®  Turning off the pump: Turns the pump Off mid-infusion, using the On/Off hard
key.

When the pump is turned Off mid-infusion, the infusion parameters are saved. When
the pump is turned back On, the user is prompted to indicate whether or not to
continue the stopped infusion.

0 In an emergency situation, it is recommended to press and hold the
ON/OFF hard key for 5 consecutive seconds. This turns the pump
Off, bypassing the need to confirm the action.

> To pause and then quit an infusion:
1. At the bottom of the pump, press the Stop hard key.
2. From the toolbar, press Quit.
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From the toolbar of the Attention screen, press Quit Infusion.

0 Resuming infusion after quitting will not be possible.
When a Drug Library is loaded on the pump, the Clinical Care Area
0 screen appears. The user can either accept or change the current

CCA. For more information, refer to Clinical Care Area (CCA) on
page 161.

> To turn Off the pump:

1.

2.

121

At the bottom of the pump, press the ON/OFF hard key.

If a rate of <1 mL/h was used, the pump will prompt the user to take
0 the administration cassette out of the pump before turning the
pump Off.

From the toolbar, press Off.

Pressing and holding the ON/OFF hard key for 5 consecutive seconds turns the
pump Off (bypassing the need for confirmation).

0 If a Drug Library update or a Software update is available for
installation, the user is prompted to update or turn Off the
pump without updating.

In case of emergency, when Patient Lockout or Lock Screen is

0 activated (Activating Patient Lockout on page 122), the user must
press and hold ON/OFF for 5 seconds to turn the pump Off, or
unlock the pump before turning it Off.
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Locking the Screen

Locking the display screen prevents inadvertent and unintentional changes to settings,
by disabling the functionality of the touch screen. For safety, it is recommended to lock
the screen while an infusion is running.

> To lock the screen:
1. From the toolbar of the Running screen, press Lock.

2. On the Lock options screen, select Lock Screen.

The > icons on the Main Display and the toolbar function keys disappear. Only the
Press to Unlock Screen function key appears on the toolbar.

> To unlock the screen:
1. From the toolbar, press Press to Unlock Screen.

2. From the toolbar of the Attention screen, press OK.

Activating Patient Lockout

The Patient Lockout feature prevents unauthorized personnel from modifying pump
and infusion settings. In this state, only limited features are available. A password is

required to unlock the pump.

0 During Patient Lockout or screen lock, the Request Pause
function key is not available. Pause the infusion by pressing the
Stop hard key. (Refer to To pause an infusion using the Stop hard
key on page 118.)
To turn the pump Off, press and hold the ON/OFF hard key for 5
consecutive seconds.

> To activate Patient Lockout:
1. From the toolbar of the Running screen, press Lock.

7. On the Lock options screen, select Patient lockout.

Basic Infusion Operations 122



> To release Patient Lockout:
1. From the toolbar, press Press to Unlock Patient.

2. Using the keypad, enter the relevant password and press OK.

Ending an Infusion

When the infusion is complete (entire programmed VTBI delivered), the pump
automatically applies the post infusion rate — KVO or Rate — and displays the infusion
summary:

®  VI-Volume Infused for the currently completed infusion. If the Accumulated VI
has been cleared during this infusion, VI presents the volume infused from that
time on.

®  Rate - the rate at which the infusion was delivered.

® Total time — the total time of the infusion.

The Post Infusion Rate is either KVO or Rate, according to the pump setting. The
default KVO is set by an Authorized technician. When KVO is applied, the pump
delivers at the KVO default rate, or the current infusion rate, the lower of the two.

If Post Infusion Rate is not 0 mL/h. the Post Infusion screen will be displayed once the
message is dismissed.

> To view the Post Infusion screen:
1. From the toolbar of the Message screen, press Mute = OK.

> To discontinue the Post Infusion and the infusion:

1. From the toolbar of the Message screen, press Mute - OK.

2. From the toolbar of the Post Infusion screen, press Quit.

When a Drug Library is loaded and CCA was changed during the

0 previous running infusion, an Attention screen appears, asking to
confirm the new CCA. For more information, refer to Clinical Care
Area (CCA) on page 161.
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Restarting the Infusion during the Post Infusion State

During Post Infusion, it is possible to restart the same infusion by adding VTBI, or by
quitting and selecting Repeat Last Infusion. Note that using the Add VTBI option
during a Post Infusion will disable the Repeat Last Infusion option.

> To add VTBI directly from the Post Infusion screen:
1. On the Main Display, select VTBI.
2. Using the keypad, enter the new VTBI - OK.

0 The infusion rate is automatically retained from the current
infusion.

3. To update another parameter, select it from the View/edit and update its value
using the keypad.

4. Review all infusion parameters and press OK to confirm the infusion program.
The Running screen appears.

> To add VTBI using the View/Edit function key:

1. From the toolbar, press View/Edit.

2. Select Add VTBI.

3. Using the keypad, enter the new value of the VTBI - OK.

0 The infusion rate is automatically retained from the current
infusion.

4. To update another parameter, select it from the View/edit and update its value
using the keypad.

5. Review all infusion parameters and press OK to confirm the infusion program.

The Running screen appears.
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> To restart the infusion from the Start Up screen:
1. From the Start Up screen, select Repeat Last Infusion.

2. Review the parameters displayed on the confirmation screen.

Verify that the parameters reflect the correct treatment
AL according to the prescription.

Then, press OK.

3. To begin infusion, make sure the clamps on the administration set are open, and
press Start.
The running screen appears, and the infusion begins.
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Chapter 7: Options Menu: Configuring,

Viewing and Testing

The following sections describe configuring settings, testing elements, and viewing
system data using the Options menu:

Main OPLtiIONS: OVEIVIEW ...evuniiiiiiiiieiie ettt ettt et et e et e et e eaeeabeeeaeeaanaenanas 126
Setting DElIVErY IMOTE ...oovueiiiiiiee et e et e ettt e e e eaa e e e eateeaanaannas 127
Managing Configuration SEtHINGS ......covvviieiiiiiiiiiiiiie e 128

Main Options: Overview

The Options screen provides access to configurable pump settings, testing modes, and
system data. The screen is displayed by pressing the Options function key, on the
toolbar of the Start Up screen.

The Options screen allows access to all configurations and settings of the SapphirePlus
pump (as opposed to settings relevant to a specific infusion). The screen also provides
access to testing components and viewing pump (as opposed to infusion) parameters

(e.g., System parameters Event logs).

0 The Options function key is not available during an infusion. Some
of the configuration and information accessed from the Options
menu is also accessible during infusion via the ViewSystem menu.
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Setting Delivery Mode

The SapphirePlus pump is a multi-platform device that has the ability to operate in
several different modes. Each delivery mode features its own unique options. The
current mode is displayed at the right side of the Indicators Bar.

Setting the delivery mode is done using the Options menu. An authorization code of
High or Technician is required to modify the delivery mode.

When you change the delivery mode, the pump reverts to the
0 default values for the newly selected mode.

> To change the delivery mode:

1 From the toolbar, press Options.

2. From the Options screen, select Delivery mode.

3. Using the keypad, enter the required password, and then press OK.
4

Select the relevant delivery mode.

The Start Up screen of the selected mode appears.
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Managing Configuration Settings

The following sections describe how to view and update pump configuration settings:

Managing Alarm SETEINGS ...ccvvueiiiiiiii et e et e et e e e ereeeeetb e e e eereaeeaaaenaaaees 128
Configuring AUIO SETEINGS ..uuiiiiiiiiiiiiiiee e e et e e et e e e ea e e eereeeeeeaens 131
Configuring General SETLINGS ...civvuiiiiiiiie e e e e e e e e eaae e e eeaees 132
Defining Regional Parameters .........cviiiiieieiriiiieeiiiiieeeeeiieeeeerieeeeviieeeeereeeearanneeaens 135
Testing SyStem FUNCLION ...oiuniiiiiiii ittt e e e e e e e e e e ana e 137
VIBW IMIBNU ittt ettt e ettt s e e rebi e e e eean e e enananees 138
When a drug library is loaded to the pump, local configurations
o made on the pump remain valid until the user selects a CCA or turns

the pump Off. For more information refer to Chapter 9: Drug
Library on page 160.

Managing Alarm Settings

The Alarms menu allows you to view and modify alarm-related options. Only users with
authorization levels of High or Technician have access to this menu.

> To access the Alarms menu:

®  From the toolbar of the Start Up screen, select Options. Then, select Pump
configuration - Alarms.

To Modify Parameter

(from the Alarms

Descriptions/Notes screen)
Occlusion units The format of occlusion units (BAR, PSl or  Select Occlusion units.
mmHg). Then, select BAR, PSI or

mmHg.
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Descriptions/Notes

To Modify Parameter

(from the Alarms
screen)

Occlusion
pressure

Pump unattended

Infusion near end

129

The minimum downstream pressure that
triggers an Occlusion alarm. Acceptable
ranges are 5.8 to 17.4 PSI, 0.4 to 1.2 BAR
or 300 to 900 mmHg. An alarm sounds
when the downstream pressure reaches
the set value * the sensor sensitivity level.

The number of consecutive minutes of no
interaction with the pump after which a
Pump Unattended alarm is triggered.
Options are 2, 5 or 10 minutes.

Note: A Pump Unattended alarm is not
triggered when the pump is in Delayed
start or Standby.

The number of minutes before completion
of an infusion at which an Infusion Near
End alarm is generated.

Select Occlusion
pressure. Then, using the
keypad, enter the desired
value = OK.

Select Pump
unattended. Then,
select 2 min, 5 min or
10 min.

Select Infusion near
end. Then, select 1 min,
3 min, 5 min, 10 min or
Off.
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To Modify Parameter

(from the Alarms

Descriptions/Notes screen)

Alarm volume Sets the speaker volume for the auditory Select Alarm volume.
alarm signal. Options are Maximum or Then, select Maximum or
Minimum. Minimum.

When the option is set to Minimum,
messages are provided with a visual signal
only. Alarm levels 1, 2 and 3, and the
'Infusion Complete' message are provided
with a visual signal and the lowest auditory
signal permitted, according to

IEC 60601-1-8.

Maximum alarm volume is 65 dB.
Minimum alarm volume is 45 dB.

Note: Auditory alarm signal sound levels,
which are less than ambient levels, can
impede operator recognition of alarm
conditions.

For more information about messages and
alarms, refer to Chapter 10: Alarms and
Troubleshooting on page 170.

An Occlusion Auto-restart option exists and is available for

o configuration by authorized technicians only. This option allows the
pump to restart the infusion automatically provided the occlusion
was cleared.
If the occlusion is not cleared within 40 seconds, or the user chooses
to exit the process, or the user chose to exit the process, the
downstream occlusion alarm is activated (appears within a few
seconds). (appears within a few seconds) An Occlusion Auto-restart
can occur up to 5 times in one hour.
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Configuring Audio Settings

The Audio settings menu allows you to view and modify audio-related pump settings.
Only users with authorization levels of High or Technician have access to this menu.

> To access the Audio settings menu:

®  From the toolbar of the Start Up screen, select Options. Then, select Pump
configuration - Audio settings.

To Modify Parameter

(from the General

Descriptions/Notes settings screen)

Keys volume Sets the speaker volume for the auditory  Select Keys volume.
signal generated when users select Then, select Low, High or
functions and press keys on the pump. Off.

Alarm volume Sets the speaker volume for the auditory  Select Alarm volume.
alarm signal. Options are Maximum or Then, select Maximum or
Minimum. Minimum.

When the option is set to Minimum,
messages are provided with a visual
signal only. Alarm levels 1, 2 and 3, and
the 'Infusion Complete' message are
provided with a visual signal and the
lowest auditory signal permitted,
according to IEC 60601-1-8.

Maximum alarm volume is 65 dB.
Minimum alarm volume is 45 dB.

Note: Auditory alarm signal sound
levels, which are less than ambient levels,
can impede operator recognition of
alarm conditions.

For more information about messages
and alarms, refer to Chapter 10: Alarms and
Troubleshooting on page 170.
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Configuring General Settings

The General settings menu allows you to view basic pump settings, and modify them
according to clinical requirements. Only users with authorization levels of High or
Technician have access to this menu.

> To access the General settings menu:

®  From the toolbar of the Start Up screen, select Options. Then, select Pump
configuration - General settings.

To Modify Parameter

(from the General

Descriptions/Notes settings screen)
Current CCA Used to select the CCA to which the pump  Select Current CCA.
should be set. Appears only when Drug Choose the appropriate
Library is loaded. CCA,; then, from the
For more information, refer to Clinical Care Attention screen press
Area (CCA) on page 161. OK.
Start Up config. Sets the configuration of the Start Up Refer to Start Up
screen. For more information, refer to Start Configuration Menu on
Up Configuration Menu on page 135. page 135.
Authorization Sets the authorization lock level of the Select Authorization
level pump. For more information, refer to level. Then, enter a
Managing Authorization Levels on page 144. password and select Low
Medium, High or Tech.
Set Delay Enables users to start or continue an Select the Set Delay row,
infusion at a later time. The user may either  to toggle the option
define a specific delay period, or set the between On and Off.
pump to Standby.

For more information, refer to Using the Set
Delay Feature on page 151.

Set prime volume  The amount of fluid used to prime the Select Set prime
administration set when automatic priming  volume. Then, using the
is performed. The acceptable range is 2 to keypad, enter the desired

25 mL. value = OK.
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To Modify Parameter

(from the General

Backlight

Post Infusion
Rate

Prime Reminder

Advanced Bolus

133

Descriptions/Notes

Allows the user to set the degree of screen
brightness for a running infusion. Backlight
can also be modified during a running
infusion. The Off and Partial options of this
feature save power and promote longer
battery life.

Sets the rate that is applied at the end of
infusion to KVO, or to continue at the
current infusion rate.

When KVO is selected, the rate applied is
the default KVO rate set by an Authorized
technician.

Enables a reminder for the user to prime
the administration set before starting an
infusion.

For more information, refer to Automatic
Priming Using the Pump on page 71.

Allows users to program a bolus by
entering rate, amount and time. When this
option is disabled, the bolus is
programmed by amount only, and the rate
is the default bolus rate. The option is
available only when Allow Bolus is enabled
(by a Technician authorization code).
Applicable only for the Continuous
delivery mode.

For more information, refer to
Administering a Bolus on page 92.

settings screen)

Select Backlight. Then,
select On, Off or Partial.

Select the Post Infusion
Rate row. Then, select
KVO or Rate.

Select the Prime
Reminder row, to toggle

the option between On
and Off.

Select the Advanced
Bolus row, to toggle the
option between On and

Off.
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To Modify Parameter

(from the General

Descriptions/Notes settings screen)

Auto P. lockout Enables/disables Patient Lockout, a safety  Select the Auto P.
feature that requires password entry to Lockout row, to toggle
make any parameter changes. the option between On

When the opt'lon is enabled, 'Patlent and Off.
Lockout is activated automatically as the

infusion begins (Activating Patient

Lockout on page 122).

Screen Saver Enables/disables a far-view display of the Select the Screen Saver
main infusion parameters during Standby row, to toggle the option
or a running infusion. These include drug between On and Off.

information, delivery mode (color
indication), infusion rate, and the phase
(dose, continuous rate etc.). The screen
saver appears 30 seconds after the infusion
program has started, and the pump has
not been touched.

The screen saver will not appear in the
following cases: Delayed start, Post
Infusion, or during a Bolus delivery.

The screen saver will disappear in the
following cases:

® Alarm — screen will revert to the alarm
screen

® Touching the screen — screen will revert
to the Running screen

® Infusion is paused — screen will revert to
the Paused screen.
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Start Up Configuration Menu
> To access the Start Up Configuration menu:

1. From the toolbar of the Start Up screen, select Options. Then, select Pump
configuration - General settings = Start Up Config

To Modify Parameter

(from the StartUp

Descriptions/Notes Config. screen)
Repeat last Allows the user to start infusions, using the  Select the Repeat Last
infusion same infusion parameters for the same Infusion row, to toggle

patient. When the option is enabled, the the option between On
Repeat Last Infusion button appearsonthe 1 Off.

pump Start screen.

For more information, refer to Repeating

Last Infusion on page 114.

PreProgram Allows the user to start an infusion using Select the PreProgram
predefined infusion parameters. When the  row, to toggle the option
option is enabled, the PreSet Programs between On and Off.
button appears on the pump Start Up
screen.

For more information, refer to Creating and
Editing PreSet Programs on page 148.

Defining Regional Parameters

The Regional menu controls date, time, language and US format settings. Only users
with authorization levels of High or Technician have access to this menu. When
SapphirePlus is connected to ICU Medical MedNet™, the date and time are set by the
ICU Medical MedNet™ server and can't be changed manually on the pump.

> To access the Regional menu:

®  From the toolbar of the Start Up screen, select Options. Then, select Pump
configuration - Regional.
The following procedures explain how to configure settings from the Regional menu.
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> To set the date:

1.
2.

3.

Select the Date frame.

Using the keyboard, enter values (2 digits each) for the day, month, and year.
(When US format is set, the order is month, day, and year.)

To confirm the new settings, press OK.

> To set the time:

1.
2.
3.

4.

Select the Time frame.
Using the keyboard, enter values (2 digits each) for the hour and the minute.

If necessary, switch the time units from AM to PM or vice versa, by pressing the
AM/PM function key. (This step is relevant only when U.S. format is set.)

To confirm the new settings, press OK.

> To set the language:

1.
2.

3.

Select the Language frame.

Select the desired language.

0 In some pumps, only the default language is listed.

To confirm the new settings, press OK.

> To set the US format:

1.
2.
3.

Select the US format frame.
Toggle the settings between On and Off

To confirm the new settings, press OK.

The date will appear in month/day/year format and time will appear
0 12 hour format (am/pm) when this setting is toggled On.
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Testing System Function

The Test system menu allows you to test basic system functionalities. Only users with
authorization levels of High or Technician have access to this menu.

> To access the Test system menu:

®  From the toolbar of the Start Up screen, select Options. Then, select Pump
configuration - Test system.

Option Descriptions/Notes

Speaker high ® On: High volume auditory signal sounds.
® Off: No auditory signal.

Speaker low ® On: Low volume auditory signal sounds.
® Off: No auditory signal.

Alarm LED ® On: The red (Alarm) LED is lit.
® Off: The red (Alarm) LED is not lit.

Charge LED ® On: The yellow (Charge) LED is lit.
® Off: The yellow (Charge) LED is not lit.

Running LED ® On: The green (Run) LED is lit.
® Off: The green (Run) LED is not lit.

Door sensor ® Closed: The safety door is closed.

® Opened: The safety door is open.
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View Menu

The View menu provides access to current pump settings and lists of events that are
audited by the system. The main categories are:

Category Description/Notes

View system Provides a view of the current system settings, and allows updating
selected settings. For more information, refer to Viewing System
Parameters on page 139.

Event log Provides a view of the events recorded by the system; such as
authorization level change, programming infusion parameters,
activated alarms etc. For more information, refer to Viewing the Event
Log on page 142.

> To access the View menu from the Start Up screen:

1. From the toolbar of the Start Up screen, select Options.

2. On the Options screen, select View.

> To access the View system screen from the Running screen:
1. From the toolbar of the Running screen, select View/Edit.

2. From the toolbar of the View/Edit screen, select View system.
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Viewing System Parameters

The View system screen allows you to view current system settings and infusion
parameters, and update selected settings. You can navigate through the pages of
settings, by pressing the Next and the Back function keys.

The following settings appear in all delivery modes:

Setting Description/Notes

Infusion Values Displays all the programmed parameters of the current infusion,
including rate in mL/h. Applicable only on an active infusion, or
during Standby.

Pressing > displays the parameters.

Post Infusion The rate applied when the infusion ends; KVO or Rate. The
setting can be modified before infusion ends, when no drug
library is used or no drug has been selected, by pressing >, and
then selecting KVO or Rate. Within a drug library each drug is set
with a specific post infusion option, which can only be viewed
during a running infusion.

Alarm volume The volume of the auditory alarm signal (Maximum or
Minimum). The setting can be modified by pressing >, and then
selecting a setting.

Occlusion The level of downstream pressure that triggers an occlusion
alarm. For more information, refer to Managing Alarm Settings on
page 128.
The setting can be modified by pressing >, entering a value using
the keypad, and then pressing OK.

Authorization Current authorization lock level. For more information, refer to
Managing Authorization Levels on page 144.
The setting can be modified by pressing >, selecting a setting,
and then pressing OK. Password entry is required to change the
authorization.

Current CCA The current CCA, as pre-selected by the user, and used for the
current infusion. Appears only when Drug Library is loaded.
For more information, refer to Clinical Care Area (CCA) on page 161.
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Setting Description/Notes

Next CCA The next CCA appears only when the Drug Library is loaded, and
the user changed the CCA during an infusion.
Note: The next CCA will apply only after the infusion has ended.
Applicable only during an active infusion, or during Standby.
For more information refer to Clinical Care Area (CCA) on page 161.

Backlight Current backlight settings. For more information refer to
Configuring General Settings on page 132.
The setting can be modified by pressing >; then selecting On,
Partial or Off.

Accumulated VI The cumulative volume infused (mL). The Accumulated VI can be
cleared by pressing >. For more information, refer to Monitoring
the Accumulated Volume Infused (Shift's Total) on page 156.

Accum. Prim. VI The cumulative volume infused (mL) via the primary infusions.
Appears in the View System menu only in the Continuous
Delivery mode. For more information, refer to Monitoring the
Accumulated Volume Infused (Shift's Total) on page 156.

Accum. Sec. VI The cumulative volume infused (mL) via the secondary infusions.
Appears in the View System menu only in the Continuous
Delivery mode. For more information, refer to Monitoring the
Accumulated Volume Infused (Shift's Total) on page 156.

VI cleared date The date and time in which the Accumulated VI was last cleared.
For more information, refer to Monitoring the Accumulated Volume
Infused (Shift's Total) on page 156.

VI cleared time

Delivery mode Current delivery mode.

Single Air detector These settings are associated with the amount of air that triggers
an Air in Line alarm. These settings can be modified by
Technicians only. For more information, refer to the Service
Manual.

Note: While a non-epidural infusion is running at a rate of 4 mL/h
or lower, the Single air detector switches automatically On.

Accumulated Air
detector

Accumulated Threshold

Date Current date and time. For more information, refer to Defining
Time Regional Parameters on page 135.
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Setting Description/Notes

Software version The software version loaded on the pump.

Drug Library name The Drug Library name appears only if the pump is loaded with a
Drug Library. For more information about the Drug Library, refer
to Chapter 9: Drug Library on page 160.

Drug Library published The Drug Library published date appears only if the pump is
date loaded with a Drug Library. For more information about the Drug
Library, refer to Chapter 9: Drug Library on page 160.

Serial number Serial number of the pump.

Next Certification Date that the pump is due for the next Certification. For more
information refer to the Service Manual.

Set Prime Volume The amount of fluid used to prime the administration set, when
automatic priming is performed. The acceptable range is 2 to
25 mL.

Battery status The approximate percentage of current battery charge. Possible
values are 100%, 75%, 50%, 25%, and Low Batt.

KvVO The default KVO rate set for the current delivery mode. The

parameter is not relevant to Intermittent or Epidural Intermittent
mode (in which the KVO is equal to the KVO/continuous rate
programmed for the infusion).

Bolus rate The default bolus rate set for the current delivery mode. The
parameter is not relevant to the Multi-step modes. In continuous
mode, when the Advanced Bolus option is set to On, the bolus
Amount, Rate and Time can be programmed by the user, and the
bolus rate will not be displayed on the View System menu.
Default bolus rate can be modified by Technicians only. For more
information, refer to the Service Manual.

Secondary bolus rate The default secondary bolus rate. This parameter is relevant only
for the Continuous Delivery mode. When the Advanced Bolus
option is set to On, the bolus Amount, Rate and Time can be
programmed by the user, and the secondary bolus rate will not be
displayed on the View System menu.

Default bolus rate can be modified by Technicians only. For more
information, refer to the Service Manual.
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Viewing the Event Log

The Event log screen allows you to view a record of all events audited by the system.
You can view a list of all events or only the events that occurred on a specific day.

> To view events that occurred on a specific day:
From the Options menu, select View.
On the View screen, select Event log.

On the Event log screen, select By date.

Hown =

Using the keypad, enter values for the day (2 digits), the month (2 digits), and the
year (2 digits). (When U.S. format is set, the order is month, day, and year.)

To navigate directly to a component of the date (e.g., day), press
0 the component.

5. On the toolbar, press OK.

A list of events is displayed.

0 If no events occurred on the selected day, a blank screen is
displayed.

> To view all events:

1. From the Options menu, select View.

2. Onthe View screen, select Event log.

3. On the Event log screen, select All events.
A list of events is displayed.

The Event log is sorted according to time, with the most recent event listed first. Each
event is assigned a specific code. (For example, the code for the Pump Unattended
alarm is 18.) The code appears in the Event log next to the time of the event.
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When the row of an event is selected, the Event details frame displays the complete
timestamp of the event (date and exact time), and a brief description of the event.
When the pump is turned Off, or a power failure occurs, the pump shut-down is
registered as an event (with a time stamp), and the event log is saved.

When the number of events in the Event Log exceeds the maximum capacity, the
earlier half of the event log will be cleared, in order to allow logging of new events.
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Chapter 8: Using Advanced Features

This chapter explains how to work with less frequently used pump features. The
following options are generally reserved for more advanced pump users:

Managing Authorization LEVEIS .........coouuuiiiiiiiiie e e 144
PaSSWOIA RE-ENTIY ...ciiiiiiieeeiiiie et e e e e e et e e et e e e et e e e s et e e e sataeeesaaanaaeens 147
Creating and Editing PreSet Programs ..........cceeiiiiiieiiiiiiie e e e e 148
Using the Set Delay FEAtUIE .....cciviuiiiiiiiiee et e e e e e e e e et eens 151
Using the New Patient FEATUIE ........cceiiiiiiieiiiiee e e e 155
Updating to a New Pump Software VErsion ...........cceeeeiiiiiiiiiiiiie e 158

Managing Authorization Levels

To help ensure patient safety, the SapphirePlus pump can be set to one of four
authorization levels. Authorization levels control access to the programming options
available in the pump. Each level allows users to access a different set of pump actions
and programming options.

Authorization levels are modular. Therefore, users with a given authorization level can
access actions available to their level, plus all actions available to users with lower
authorization levels. The levels are:

®  Low: All programming options are disabled, and no settings can be changed.

®  Medium: Basic programming options, such as using shortcuts to start infusions,
are enabled.

®  High: All tasks and configuration settings are enabled, except for options limited
to technician use.

®  Technician: All settings are enabled. This level is restricted to technicians and
developers only.

Passwords are defined by technician or loaded with the Drug
0 Library.
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Specific actions allowed in each of the authorization levels are listed in the following
table.

Authorization Level Allowed Actions

Low Stop the pump, and then continue the infusion
Power the pump On and Off
Use the View menu

Medium Stop the pump, and then continue the infusion
Start infusions using the PreSet Programs feature
Start infusions using the Repeat Last Infusion feature
Priming with the pump

High Start infusions using the New Infusion feature
View/Edit parameters
Use the Pump Configuration menu
Create/Edit PreSet programs (requires a unique password)
Changing delivery mode (requires password re-entry)
Clinician bolus

Technician All

When the pump is turned Off, the authorization lock level setting is saved. Therefore,
the lock level set most recently is maintained when the pump is turned back On.

If the pump is turned Off in Technician mode, the pump turns back
o On in a High authorization level.
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The current authorization lock level can be viewed via the Options menu. When an
infusion is running, the lock level can be accessed via the Running screen.

> To view the current authorization lock level from the Options menu:

®  From the Options menu, select View - View system.
The Authorization parameter is displayed.

> To view the current authorization lock level via the Running screen:
1. From the toolbar of the Running screen, press View/Edit.
2.  From the View/Edit screen, select View system.

The Authorization parameter is displayed.

Setting Authorization Lock Levels

Users with an authorization level of High can reset the authorization lock level of the
pump.

> To change authorization level from a lock level of High:

1. From the Options menu, select Pump configuration - General settings.

2. Select Authorization level. Then, using the keypad, enter the High level password
- OK.

Because only High and Tech authorization levels can change the

0 authorization level on the pump, a high or technician password is
required to access this setting. Entering a Medium or Low level
password generates an error message.

The authorization level matching the entered password, as well as all levels below
it, are listed on the Main Display.

3. Select the authorization level at which you want to lock the pump. Then, from the
Attention screen, press OK.

4. To exit the Options menu, press OK.
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> To change authorization level from a lock level of Medium or Low:
1. From the Options menu, select Pump configuration.

2. On the Password screen, using the keypad, enter the High level authorization
password. Then, from the toolbar, press OK.

3. From the toolbar of the Attention screen, press OK.

4. To exit the Options menu, press Exit.

Do not disclose the passwords of authorization levels Medium, High
A or Technician to patients, home users or any other unauthorized
user.

Password Re-entry

The SapphirePlus pump is designed to prevent inadvertent parameter changes, or
actions other than those permitted by the currently set authorization level. As a safety
measure, the pump will prompt the user to re-enter the High level password before
performing the following actions:

®  Changing delivery modes

®  Changing authorization levels

0 Entering a High level authorization password allows access to these
actions, even if the pump is set at a Medium or Low authorization
lockout level.

A password entry is also required to unlock the screen when the Auto Patient Lockout
feature is enabled. The authorization level of the password entered sets the
authorization lockout level of the pump.
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Creating and Editing PreSet Programs

The PreSet Programs feature allows users to start infusions using predefined infusion
parameters, thus eliminating the need for programming. Each delivery mode can
support its own set (of up to 10) predefined infusion programs. Only the infusion
programs set for the currently selected delivery mode are displayed (a preset program
is available for use and edit only when the pump is set to the delivery mode in which
the program was saved) .

This feature is available when the ICU Medical MedNet™ Drug
0 Library is not used.
When not under the ICU Medical MedNet™ Drug Library, in order
for the PreSet Programs function to appear in the Start Up screen,
the pump needs to be configured to the Allow PreProgram setting.
For more information, refer to Configuring General Settings on
page 132.

The following procedures explain how to create, edit and delete preset programs.

Creating and Editing preset programs can be done only by High
0 and Technician authorization levels, and in addition require a unique
password.

A PreSet program will be available for creating, using and editing only when the
program settings are consistent with the current pump settings, and drug availability in
the current CCA (for example, if the flow rate of a certain PreSet program exceeds the
current hard limit, the program will not be available for use).

0 Exception: a PreSet program created with Drug amount and Diluent
volume, will be available for creating, using and editing, regardless
of Calculate concentration setting.

> To create a new preset program:
1. From the Indicators Bar, verify that the pump is in the desired delivery mode.
2. From the Start Up screen, select PreSet Programs.

3. From the toolbar, press Create New.
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4. Using the keypad, enter the appropriate password; then, press OK.
5. Using the keypad, enter a relevant name for the new program.
® To enter the second character that appears on a key, press the key twice. (Press
3 times to enter the third character, etc.)
To enter a space, press the 0 (zero) key once.
To clear the most recently entered character, press the backspace key (left
arrow key at the lower right corner of the keypad).
® To clear all entered characters, press Clr.
After entering the name, press OK.
6. Set the relevant infusion parameters. Refer to the following table for more
information about setting parameters in each mode.

Delivery Mode Refer to:

Continuous Starting a Continuous Infusion on page 79

Multi-step Starting a Multi-step Infusion on page 106

7. Review the parameters displayed on the screen.

Verify that the parameters reflect the correct treatment according to
the prescription.

Then, press OK. The program is saved.
8. To return to the PreSet programs screen, press OK.
> To edit a preset program:
From the Indicators Bar, verify that the pump is in the desired delivery mode.
From the Start Up screen, select PreSet Programs.
From the toolbar of the PreSet Programs screen, press Edit.

Using the keypad, enter the appropriate password; then, press OK.

akrwn -

From the list, select the program that you want to update.
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6. Select the box of the parameter that you want to change. Using the keypad, enter
the new parameter, and then press OK.

If relevant, the pump will prompt you to confirm or update other

0 parameters that may need to be modified, based on the change
made. The name of the program, drug name, drug concentration
and patient weight cannot be modified.

7. Repeat Step 6, until all relevant parameters are updated as required.

Review the parameters displayed on the screen.

Verify that the parameters reflect the correct treatment according to
the prescription.

Then, press OK. The program is saved.
> To delete a preset program:
From the Indicators Bar, verify that the pump is in the desired delivery mode.
From the Start Up screen, select PreSet Programs.
From the toolbar of the PreSet Programs screen, press Edit.
Using the keypad, enter the appropriate password; then, press OK.
From the list, select the program that you want to delete.

From the toolbar, press Delete.

No s wDd -

From the toolbar of the Attention screen, press OK.

The program is deleted.
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Using the Set Delay Feature

The Set Delay feature allows users to program an infusion in advance, or put an active
infusion on Standby.

Before starting an infusion — When the option is enabled, the Set Delay option appears
on the Start screen. The users can then choose to set the infusion to Standby for a time
period not greater than 72 hrs, or to set the infusion for a defined Delayed Period, after
which one of the following occurs:

¢ If the KVO was used during the delay period, the pump starts the infusion
automatically.

®  |fthe KVO was not used during the delay period, the alarm for the clinician sounds
to start the infusion.

For the Set Delay option to appear on the Start screen, the pump

o needs to be configured with the Allow delayed start setting
enabled. For more information, refer to Configuring General
Settings on page 132.

o Alternatively, it is possible to initialize a Standby Period during an
infusion. For more information, refer to Infusion Standby on
page 119.

> To program an infusion using the Standby option:

1. Set the relevant infusion parameters. Refer to the following table for more
information about setting parameters in each mode.

Delivery Mode Refer to:

Continuous Starting a Continuous Infusion on page 79

Multi-step Starting a Multi-step Infusion on page 106

2. From the Start screen, select Set Delay.

3. From the Delayed Start screen, select Standby.

151 SapphirePlus Infusion Pump User Manual



4. The Standby screen is displayed.

Throughout the Standby period, the following information appears on the screen:

Drug Name: The name of the selected drug. Displayed on the indicators bar,
when working with a Drug Library.

Concentration: Drug concentration as entered by the user (Final
concentration or Drug Amount / Diluent Volume). Displayed when applicable.
Rate: Programmed infusion rate. For all dose units other than mL/h, the
calculated rate will be displayed in mL/h, both in the View system menu and in
the Running screen.

VTBI: Total volume left to be infused. This parameter remains constant
throughout the Standby period.

VI / Total: Total volume that has been infused in the current infusion / the VTBI
value programmed. These parameters remain constant throughout the
Standby period.

Time left: Time remaining until the end of the current infusion. This parameter
remains constant throughout the Standby period.

During Standby, Pump unattended alarm will not be active.

To view all of the current infusion programmed parameters, from the
Standby screen, press View/Edit > View system — Infusion
Values.

When in Standby, the pump can be turned Off without losing the
infusion parameters. To resume infusion, refer to Resuming Infusions
After Pump Shutdown on page 117.

To abort Standby and the infusion, from the toolbar, press End
Standby; then, from the Confirm screen, press Exit. The Start Up
screen will appear.
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> To start an infusion from the Standby state:
1. Press End Standby.

2. Review the parameters displayed on the Confirm screen.

Verify that the parameters reflect the correct treatment according to
4 the prescription.

Then, press OK.

3. Make sure that the clamps on the administration set are open; then, press Start.
The Running screen is displayed, and the infusion begins.

> To program an infusion using the Delay Period option:

1. Set the relevant infusion parameters. Refer to the following table for more
information about setting parameters in each mode.

Delivery Mode Refer to:

Continuous Starting a Continuous Infusion on page 79

Multi-step Starting a Multi-step Infusion on page 106

From the Start screen, select Set Delay.
From the Delayed Start screen, select Delay Period.

Using the keypad, enter the desired delay period (h:min); then, press OK.

ok wN

Specify whether or not to run the infusion in a KVO, during the delay period:

If KVO rate is pre-configured to 0 mL/h for the delivery mode, from
o the Start screen, select Start with Delay. (Refer to Do not use KVO:
below)
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® Use KVO:
Press Yes — Start with Delay. The infusion begins with a KVO rate. When the
delay period is over, the programmed infusion begins immediately.

Pressing Start during the delay period begins the infusion
0 immediately (overriding the delay period).

® Do not use KVO:
Press No — Start with Delay.
On the Delayed Start screen, the words No KVO appear in the Rate frame, and
a time countdown for the delay period is displayed in the Time frame.

To override the delay period, from the toolbar, press Skip delay.
0 Then, from the Start screen, press Start.

When the delay period is over, an alarm sounds.

6. To begin the infusion, verify that the clamps on the administration set are open,
and press OK; then, press Start.

When a KVO rate is not used during the delay period, the infusion
&3 does not begin automatically when the delay period is over. You
need to begin the infusion manually, by pressing Start.

During an active infusion — When the option is enabled, the Standby option
appears on the View/Edit toolbar.

For more information about using the standby option, refer to Infusion Standby on
page 119.
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Using the New Patient Feature

When the New Patient feature is enabled, and either a New Infusion or a PreSet
program is selected, the pump will prompt you to indicate whether or not the infusion
to be programmed is for a new patient. When selecting Repeat Last Infusion the New
Patient screen will not appear, and the pump will indicate that the infusion to be
repeated will be used for the last patient selected.

When a New Patient is selected, entries associated with the patient can be tracked in
the Event Log (see Viewing the Event Log on page 142). In addition, the pump calculates
the accumulated volume infused (Accumulated VI) for all infusions associated with the
patient. When a new patient is selected, the Accumulated VI is automatically cleared
(for more information, refer to Monitoring the Accumulated Volume Infused (Shift's Total) on
page 156.

> To select a new patient:
1. From the Startup screen select New Infusion or PreSet Programs.

2. Inthe New Patient screen, select Yes.

When under ICU Medical MedNet™ Drug Library, the new patient
0 feature is enabled (refer to Appendix A: SapphirePlus Configuration

Settings on page 214)

When not under the ICU Medical MedNet™ Drug Library, this

feature can be enabled/disabled by technicians only
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> Monitoring the Accumulated Volume Infused (Shift's Total):The
SapphirePlus pump calculates the Accumulated Volume Infused (Accumulated VI) for all
infusions associated with a specific patient.

The accumulated VI includes the volume infused to a specific patient via infusions
(including primary, secondary etc.), Boluses, KVO and Post Infusion rate. This allows the
clinical staff to monitor the total volume infused to a specific patient. The Accumulated
VI can be cleared by a clinician (for more information, refer to Clearing Accumulated VI on
page 157). The date and time in which the Accumulated VI was cleared is also
captured.

The SapphirePlus pump also provides the volume infused in the current running
infusion (VI), including KVO if applied, during a delayed start period. This VI is
presented on the running screen as well as in the message given at the end of the
infusion. Clearing the Accumulated VI automatically clears the VI.

Viewing Accumulated VI

The Accumulated VI value can be viewed before programming an infusion via the
Options menu, or during an infusion via the View/Edit and View System menus.

> To view the current Accumulated VI value from the Options menu:
1. From the Options menu, select View - View system.

2. From the toolbar of the View system screen, press Next until the Accumulated VI
parameter is displayed.

> To view the current Accumulated VI value via the View/Edit menu:

1. From the toolbar of the Running screen, press View/Edit.
The Accumulated VI value is presented in the Clear Accum. VI box.

> To view the current Accumulated VI value via the View System menu:
1. From the toolbar of the Running screen, press View/Edit.

2. From the View/Edit screen, select View system.
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3. From the toolbar of the View system screen, press Next until the Accumulated VI
parameter is displayed.

The View system captures the date and time in which the

0 accumulated VI was last cleared. In addition to the Accumulated VI
value, when using the Continuous delivery mode, the View System
screen also presents the Accumulated Volume Infused via the
primary line (Accum. Prim. VI) and the Accumulated Volume Infused
via the secondary line (Accu. Sec. VI).

Clearing Accumulated VI

The Accumulated VI value is cleared in the following cases:

®  The pump clears the Accumulated VI automatically
® If the New Patient feature is disabled — Each time a New Infusion or a PreSet
Programs is confirmed (Note: Repeating the last infusion won't clear the
Accumulated VI).
® If the New Patient feature is enabled — Each time a new patient is identified
(Note: Repeat Last Infusion is intended for the same patient; this means that a
new patient can't be identified when using the Repeat Last Infusion shortcut).

®  The user clears the Accumulated VI

® During infusion via the View/Edit or View System screen.This will reset the total
volume infused for all infusions associated with a specific patient to 0 mL.

0 The date and time in which the accumulated VI was cleared is
captured and can be viewed in the View System menu.

> To clear the Accumulated VI value during infusion:
1. From the toolbar of the Running screen, press View/Edit.
2. From the View/Edit screen, press Clear Accum. VI.

3. From the Clear Accum. VI screen, press Yes to clear the Accumulated VI.
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To clear the Accumulated VI value before or after infusion:
From the toolbar of the Start up screen, press Options.
From the Options menu, select View.

>
1

2

3. From the View menu, select View system.

4. From the view system, select the Accumulated VI row by pressing the >.
5

From the Clear Accum. VI screen, press Yes to clear the Accumulated VI.

Updating to a New Pump Software Version

When a new software version is available, the user is prompted to specify whether or
not to update the software. Note that updating the pump software removes the Drug
Library if it has become incompatible.

Updating software should be conducted according to local facility
0 procedures.
Updating a new software version may take a few minutes, during
which the pump is inactive.
The user is advised to connect the pump to a power supply during
the update process. If the pump is turned Off, a message appears at
the top of the screen, indicating the software download status.

> To update to a new software version:
1. From the New Software screen, press Upload.

2. Enter the installation code, and press OK. The pump will start updating the
software. At the end of the process the pump will shut down.

> To view the current software version:
1. From the Options menu, select View = View System.

2. On the toolbar, press Next, until the SW Version parameter is displayed.
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Chapter 9: Drug Library

The following sections explain about the Drug Library unique features, and describe
how to operate the pump in the different delivery modes using the Drug Library:

OVEBIVIBW ettt et ettt ettt et e e et e et e et e et e et s eena e eanaeeaneeanereneneneens 160

Clinical Care Area (CCA) ..ottt et e e et e e e et e e e e et e e e et e e eaaans 161

Programming a New Infusion with the Drug Library ........ccccoovviiiiiiiiiieiiiiiiieeeeieeeees 165

SOFE LIMIT 1eieiiiiie et e et e e et e e e e et e e e s et e e e eateeesatneaeeraannns 166

Update a New Drug Library VEISION .........oeiiiiiiiiiiiiiieeeeeice e e e 168
Overview

The Drug Library contains information about customized groups of drugs and Clinical
Care Areas (CCA) that were approved and saved by qualified and authorized local
hospital personnel, using the ICU Medical MedNet™ Meds™ 6.21 Software and above
(per ICU Medical MedNet™ Meds™ user manuals).

The Drug Library is identified by a Drug Library name and publish date, both displayed
on the View system menu. The Drug Library name is also displayed on the SapphirePlus
when the pump turns On.

The Drug Library functions as an error-reduction tool, thus enabling safer practice.
The Drug Library displays for each drug its available concentrations and allowed range
(hard limits) of various infusion parameters, such as continuous rate and bolus amount.
In addition, it contains the recommended range (soft limits) of these infusion
parameters.

The information about customized groups of drugs may be specific to a CCA, or may
apply to an entire institution.

The limits set in the Drug Library create a guiding range, thus reducing infusion errors.
The pump alerts users when the programmed values exceed the recommended range
(soft limits), and prohibits programming of values that exceed the allowed range (hard
limits).

For more information refer to ICU Medical MedNet™ Meds™ 6.21 Software and above
(per ICU Medical MedNet™ Meds™ user manuals).
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Clinical Care Area (CCA)

The Drug Library accommodates of up to 40 CCAs, each with a unique configuration
setting and up to 3400 drug profiles. A complete Drug Library may contain up to
11,150 drug profiles. The CCA unique configuration is set by the Drug Library. Local
configuration made when a Drug Library is loaded remains valid until the user selects a
CCA or turns the pump Off. For more information about configuration settings, refer to

Appendix A: SapphirePlus Configuration Settings on page 214.

When Resuming an infusion after pump shutdown, local
0 configurations will remain until the end of the current infusion.

Changing a CCA

CCA selection is available in the following cases:

®  When the pump is turned On

®  When the pump is idle, from the General Settings menu

®  During a running infusion (the selected CCA will apply after the infusion has

completed)

The name of the selected CCA is displayed on the Indicators Bar above the screen title.

Selecting a CCA when pump is turned On

When a Drug Library is loaded, a message is displayed, asking to accept or change the
current CCA.

> To accept or change a CCA:
1. Turn the pump On.

2. From the Clinical Care Area screen select whether to Accept or Change the
current clinical care area:

® To accept the current CCA, press Accept.
The Start Up screen appears.
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® To change the current CCA, press Change.
® From the Choose CCA screen, select the relevant CCA.

0 To display additional CCAs press Next.

a. From the Attention screen, press OK.

0 In case the current delivery mode is unavailable in the selected
CCA, the pump will prompt the user to change the delivery mode.

The Start Up screen appears.

o CCA selection should be selected according to local facility
procedures.
o If a message regarding resuming previous infusion appears upon
turning the pump On, refer to Resuming Infusions After Pump

Shutdown on page 117.

Selecting a CCA from the General Settings

> To change the current CCA:

1. From the toolbar of the Start Up screen, press Options; then, select Pump -
configuration - General Settings.

2. Select the Current CCA row.

3. From the Choose CCA screen, press the row of the relevant CCA.

0 To display additional CCAs press Next.

4. To confirm the selected CCA, press OK.
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The Start Up screen appears.

Selecting a CCA should be conducted according to local facility
0 procedures.
0 The Repeat Last Infusion option will be unavailable (grayed out)
after the CCA is changed.

Changing a CCA during a running infusion

When changing the CCA during a running infusion, the CCA will
&R change only after the infusion has completed.

The selected CCA name will appear in the indicators bar, two arrows

on either side.

To change a CCA during a running infusion:
From the Running screen press View/Edit.
From the View/Edit screen, select View system.

>
1
2
3. Select the Current CCA row.
4

From the Choose CCA screen, select the row of the relevant CCA.

0 To display additional CCAs press Next.

5. From the Attention screen, confirm the selected CCA, and press OK.
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The View/Edit screen is displayed.

0 To view or change the Next CCA:
® From the View/Edit screen, press View System.
® Press Next CCA.
® Select CCA from list.
Note: To display additional CCAs press Next.
® From the Attention screen, press OK.

The Repeat Last Infusion option will be unavailable (grayed out)
0 after the CCA is changed.

6. To return to the running infusion, press OK.
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Programming a New Infusion with the Drug Library

When the SapphirePlus pump is loaded with a Drug Library, the programming flow
includes additional related steps: Drug name entry, Drug list and Drug profile.
Following the drug profile selection, the user is required to enter the infusion
parameters according to the delivery mode.

Drug Name

After starting a New Infusion, the pump displays the Drug name screen.
From the Drug name screen, using the keypad, the user enters the drug name then
presses Find".

0 Drug name search is not sensitive to uppercase or lowercase letters.

When the required drug is not found in the Drug Library, the user can program an
infusion without a defined drug by using the Choose General key on the toolbar.

'Choose General' will bypass the specific drug profile limits, and the
A infusion will be programmed under the CCA limitations only.

Drugs List

The filtered drugs are displayed in the Drugs List screen.

The Drugs List screen displays only drugs that are available in the current CCA and
delivery mode. When there are several available drugs, use the Next key to display
additional drugs.

* The Find key can be used to display all available drugs when no characters have
been entered (letters, numbers or symbols), or to filter drug names according to the
characters entered. The number of matching drugs found is displayed at the top
right corner of the main display.
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Drug Profiles

The pump displays the available profiles for the selected drug. The drug profile
includes concentration and defines hard limits and soft limits. Each available drug is
defined by the CCA and the delivery mode to which it was assigned; a drug profile may
be available in more than one delivery mode.

Each drug profile is defined by one of the following types:

1. No concentration: The drug concentration or diluent volume are not needed.
Available drug units are: mL/h, mL/min, mL/kg/h and mL/kg/min.

2. Diluent only: Solutions where medication amount is not required (e.g., 100 mL).
Available drug units are: mL/h, mL/min, mL/kg/h and mL/kg/min.
3. Partial concentration:
®  Without Drug Amount Only Diluent Volume is defined. The user will be asked
to enter Drug Amount (e.g., __ mg/100 mL).
®  Without Diluent Volume Only the Drug Amount is defined. The user will be
asked to enter Diluent Volume (e.g., 10 mg/__ mL).
®  Without Drug amount and without Diluent Volume (e.g., _mg/_mL): No

Drug Amount and no Diluent Volume were defined. The user will be asked to
enter Drug Amount and Diluent Volume.

4. Full concentration: Both Drug Amount and Diluent Volume are defined.

For more information about programming a new infusion with Drug Library, according
to the chosen delivery mode, refer to:

To begin a new Continuous infusion with a Drug Library on page 83

To begin a new Multi-step infusion with a Drug Library on page 110

Soft Limit

The limits set in the Drug Library create a guiding range, thus reducing infusion errors.
When programming values that exceed the recommended range (soft limits), an
Attention screen is displayed, showing the applicable soft limit icon, with the details of
the exceeded parameter. The user can either:

®  Acknowledge the message and continue with the entered value.

®  Go back and enter a new value instead of the entered value.
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Figure 9.1. Soft Limit Icon

VS [ VN
B \ 4 \ 4

Current infusion is Current infusion is Current infusion is exceeding
above upper soft below lower soft  both upper and lower soft limits
limit limit of various parameter

> To acknowledge the message and continue with the entered value:
From the Attention screen, press OK and continue programming.

When a soft limit has been exceeded, an applicable Soft Limits icon
o will be shown on the Sapphire pump indicators bar during infusion.

> To enter a new value instead of the entered value:
From the Attention screen, press Back.
Then, using the keypad, enter a new value and press OK.

Soft limits Attention screen and icon are applicable only when soft
o limits are defined in the Drug Library.
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Update a New Drug Library Version

When a drug library update is available for installation, an icon is displayed on the top

header, The option to install the update is provided when turning off an idle pump.

Updating Drug Library should be conducted according to local
0 facility procedures.
Updating a new Drug Library version may take a few minutes,
during which the pump is inactive.

> To update a new Drug Library version:
From the New Drug Library screen, press Upload. The pump will start updating the
Drug Library. At the end of the process the pump will power Off automatically.

If the user chooses not to update the Drug Library upon pump
0 turn-off, the Update screen will be prompted the next time the
pump is turned Off.

Drug Library
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Chapter 10: Alarms and Troubleshooting

The following sections describe the different types of alarms and messages that can be
generated by the pump, and explain how to troubleshoot common programming
issues:

ALQIMS OVEIVIEW .ieieeieiiiiiieeeeeeeeeeeetietee e e e e e e e eeeeaeeaaaaeeseeeeeeneaennnaaaeeeeasennnennnnnnnns 170
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Alarms Overview

The SapphirePlus pump generates four different types of alarms. The alarm types are
categorized according to their effect on the infusion. In all alarm types, instructions
about how to proceed (and, if relevant, to solve the problem) are displayed on the
touch screen.

Alarm Type Effect on Infusion

Level 1 Pump shuts down.

Level 2 Infusion stops and cannot be reactivated.
Level 3 Infusion stops, but may be reactivated.
Message Infusion is not interrupted.

When Level 1, 2, and 3 alarms occur, the red Alarm LED stays On continuously, and an
auditory alarm sounds continuously. These alarms require immediate attention.
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The following sections provide details about each alarm type. In the lists of alarms,
messages and alarms related to battery issues are shaded. Alarms related to battery
problems can be prevented by adhering to the recommended guidelines for battery
care (Battery Care Information on page 187).

Level 1 Alarms

This type of alarm is the highest severity alarm category. If the pump is running when
the alarm occurs, the infusion stops immediately, and the pump automatically shuts
down within 3 minutes. The infusion cannot be restarted or continued.

The following soft keys are available during a Level 1 alarm:

®  Mute: Silences the auditory alarm.

®  Shutdown: Turns Off the pump immediately.

When a Battery Depleted alarm occurs, connect the pump to an AC power supply. A
pump with an Internal Error alarm needs to be evaluated by an authorized service
technician.

Alarm Title Screen Header Displayed Text

Battery Depleted Battery Pump will automatically shut down in 3
minutes. Please connect pump to power.

Internal Error Error Pump will automatically shut down in 3
minutes. Please send the pump for service.
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Level 2 Alarms

This alarm type is a high severity category. If the pump is running when a Level 2 alarm
occurs, the infusion automatically stops.

The pump can be reactivated by a technician (using a technician authorization code) to
retrieve infusion data and/or manage a battery problem. Pumps with Level 2 alarms
need to be sent for servicing. Screen instructions are directed to technicians only.

To silence the audio signal of an alarm, press the Mute soft key. This silences the alarm
sound for 2 minutes. If the issue has not been cleared after 2 minutes, the alarm sound
will be resumed.

The following soft keys are available during a Level 2 alarm:
®  Mute: Silences the auditory alarm for 2 minutes.
®  Unmute: Returns the auditory alarm.

®  OK: Displays the Paused screen. This soft key is enabled after Mute is pressed.

Alarm Title Displayed Text

Mechanism A pump fault has occurred. Please enter technician code to proceed.

Error

Pump Fault A pump fault has occurred. Please enter technician code to proceed.
Battery End of battery life. Please contact authorized technician to replace battery.
Reminder
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Level 3 Alarms

This alarm type is a medium severity category that requires immediate attention.

If the alarm occurs during an infusion, the infusion automatically stops. However, you
may continue the infusion after the problem has been resolved. Instructions for
resolution of the problem are displayed on the touch screen.

To silence the audio signal of an alarm, press the Mute soft key. This silences the alarm
sound for 2 minutes. If the issue has not been cleared after 2 minutes, the alarm sound
will be resumed.

0 Resolving these alarms will lead to the Paused Infusion screen. If the
alarm occurs while programming a mid-infusion action, the
programming process needs to be re-initiate.

Figure 10.1. Sample Level 3 Alarm Screen
Alarm [ Continuous]ssis]
Air in Line

Please prime administration
set.
If problem reoccurs, remove
and reinsert the cassette

Prime: Mute

The following soft keys are available during a Level 3 alarm:

®  Mute: Silences the auditory alarm for 2 minutes.
®  Unmute: Returns the auditory alarm.

®  OK: Displays the Paused screen. The infusion may then be resumed after the
problem is resolved. This soft key is enabled after Mute is pressed.

®  Prime: Enables automatic priming. This key appears only during an Air in Line
alarm.
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Alarm Title Displayed Text

Air in Line Accumulated air in line is over the limit. Please prime administration set. If
problem reoccurs, remove and reinsert the cassette.

Please prime administration set. If problem reoccurs, remove and reinsert
the cassette.

Possible excessive environmental light.
Please reduce exposure and check if priming is required.

Potential Air Press OK to resolve.

in Line

Cassette The administration cassette is not loaded or misplaced. Please reload the
Misplaced cassette.

Reinsert cassette. Verify both flanges inside safety door. If problem persists
contact technician.

Remove the administration cassette and make sure to correctly reinsert it. If
alarm reoccurs please contact authorized technician.

Check for Please verify clamps are open and set is not occluded.

Occlusion

Downstream To clear occlusions verify: 1. Clamps are open; 2. Administration cassette is

Occlusion properly positioned; 3. Line is not kinked; 4. No occlusion at the output
connection. If all occlusions were cleared press OK to continue.

Pump Please quit and restart the infusion.

Stopped

Occlusion To clear occlusions verify: 1. Clamps are open; 2. Administration cassette is

properly positioned; 3. Line is not kinked; 4. No occlusion at the output
connection. If all occlusions were cleared press OK to continue.

Upstream To clear occlusions verify: 1. Clamps are open; 2. Administration cassette is
Occlusion properly positioned; 3. Line is not kinked; 4. No occlusion at the output
connection. If all occlusions were cleared press OK to continue.

Flow Error Verify that the administration cassette is correctly positioned and battery is
sufficiently charged. If alarm reoccurs contact authorized technician.
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Alarm Title Displayed Text

Insufficient Low battery voltage for current rate. Please connect pump to power supply.
Battery

Messages

A Message indicates a condition of medium severity that you should attend to as soon
as possible. When a Message occurs, an auditory alarm sounds, and the condition that
triggered the message (and recommended actions, if relevant) is displayed on the
touch screen.

To silence the audio sound of a message, press the Mute soft key. This silences the
message sound for 2 minutes. If the issue has not been cleared after 2 minutes, the
alarm sound will be resumed.

Figure 10.2.  Sample Message Screen

Oncology

Message [Continuous]sisii)

Message

The pump has been inactive
for 10 minutes

If a message is displayed during infusion, the infusion continues, and the system
continues to operate. The following soft keys are available:

®  Mute: Silences the auditory alarm for 2 minutes.

®  Unmute: Returns the auditory alarm.
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®  OK: Confirms the message, and returns the display to the previous screen. If the
infusion is complete, the pump returns to the Start Up screen. This soft key is
enabled after Mute is pressed.

If the alarm volume is configured to minimum in the Alarms menu, the OK soft key
will always be enabled.

Screen

Header Displayed Text

Low Battery 30 minutes left to battery depletion. Connect pump to power supply.
Message Battery life will expire in 2 days. Please contact authorized technician.

The battery could not be fully charged - please check power supply.
Annual certification due in 2 days. Please contact authorized technician.

Annual certification date is overdue. Please contact authorized technician.
Note: The pump continues to function after the certification date; however,
failure to perform annual certification impacts the pump warranty.

Door open. Check administration cassette position and close the safety
door.

Infusion complete.
Infusion near end.
The pump has been inactive for <xx> minutes.

System temperature is out of range. If the alarm reoccurs please contact
authorized technician.

Please Wait. Possible Downstream Occlusion. The pump is attempting to
restart; press exit to cancel.

WiFi disconnected. To reconnect WiFi, connect pump to power supply.

WiFi disconnected. Please contact authorized technician. Press OK to
continue without WiFi .

Note: The pump continues to function when Wi-Fi has a connectivity
problem. Following this alarm, the Wi-Fi icon turns gray.
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Troubleshooting

The following table lists some common programming issues, and explains how to solve
them.

Probable Cause

The parameter entered is
outside of the safety range
calculated by the pump.

Problem Solution

Programming cannot be
completed. The OK
function key is disabled,
and the parameter
range is in red font.

Verify the prescription, and obtain
a new one if necessary. Enter
infusion parameters within the
permitted ranges.

The Set Delay option
does not appear on the
Start screen.

The option is not enabled. Enable the Allow delayed start
setting (Configuring General
Settings on page 132). High

Authorization level is required.

The PreSet Programs
option does not appear
on the Start Up screen in
any mode.

The option is not enabled.  Enable the Allow PreProgram
setting (Configuring General
Settings on page 132). High

Authorization level is required.

The Auto Patient Lockout
feature is enabled.

Pump becomes locked
whenever an infusion
starts.

Disable the Auto P. Lockout option
(Configuring General Settings,

page 134). High Authorization level
is required.

Pump is not charging.

177

® The power supply has
become disconnected
from the mini cradle.

® The power supply was

connected to the pump

during pump turn-off.

® The power supply is not

working.

® Verify the power supply is
connected to the mini cradle
splitter.

® Disconnect and reconnect the
power supply to the pump.

® |f the power supply is not
functioning properly, replace it.
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Problem Probable Cause

Recurring Air in Line Treatment is near end, or
alarms. the air detection settings
are too sensitive.

Recurring Occlusion The occlusion issue has not
alarms. been properly resolved.
Occlusion alarm is The backpressure caused
triggered immediately by the catheter used for the
after the infusion starts. treatment, at the
programmed rate, is too
high.
Screen saver does not ® Screen saver option was
appear. not enabled.

® Pump is not in an appli-

Alarms and Troubleshooting

cable state.

Solution

Close clamps, remove
administration cassette from pump
and prime (flush) the set manually.
If the issue is not resolved, replace
the administration set.

If the issue is still not resolved,
have a technician review and adjust
the air detection settings.

® Close clamps, remove adminis-
tration cassette from pump, dis-
connect patient and prime (flush)
the set manually.

® Replace the administration set.

® Change the infusion site.

Reduce the backpressure by either
replacing the catheter or by
decreasing the infusion rate.

® Enable the Screen Saver option
(refer to Configuring General
Settings on page 132)

® The screen saver will not appear
if the pump is in one of the fol-
lowing states: Paused, Delayed
Infusion, Post Infusion Rate, dur-
ing alarm, when screen is
touched, when key is pressed, or
during a Bolus delivery
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Problem Probable Cause Solution

The pump pauses when The pump is not connected  Connect the pump to an AC outlet,
programming a to an AC outlet, and and select to continue the primary
secondary. currently the battery power  or start the secondary.

is insufficient to support

both the primary line rate

and the secondary line

programming.
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Chapter 11: Maintenance and Storage

The following sections describe the proper cleaning, preventive maintenance, and
storage procedures for the pump and the battery:
Cleaning and Disinfecting the PUMP ......coiiiiiiiiiiiii e, 180
Preventive Mainte@nanCe .......couu it
Battery Care Information ..
TranSPOrt ANd STOTAZE .ovvuuiiiiiii e it e et e et e et e e e et e e e e tbeeeseat e e seataeesaraaeaees

Cleaning and Disinfecting the Pump

Between use on different patients, the SapphirePlus pump and all of its components
need to be first cleaned, and then disinfected, per hospital/medical provider protocol
for multiple patient use.

Cleaning and disinfecting the pump involves wiping it with Dispatch® (Caltech)
ready-to-use towels.

o For cleaning, one minute waiting time.
For disinfecting, ten minute waiting time.

Additional Cleaning and Disinfection Agents:
°  Virex® 1256
e Klor De™ (Chlorine tablets)

®  70% Isopropyl alcohol
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/.. Cleaning and Disinfection: Safety Precautions

Before and during cleaning, adhere to the following safety guidelines and

recommendations:

®  Only people who are trained in the maintenance of this type of medical device
should clean the infusion pump

®  Before cleaning/disinfecting the pump, verify that:
® The pump is disconnected from the patient.
® The pump is disconnected from all connections, sets, and accessories.
® The pump is turned Off.

®  While cleaning/disinfecting the pump, do not allow fluid to enter the pump
housing, speaker holes or battery chamber.

® Do not steam autoclave, ethylene oxide sterilize or immerse any part of the pump
in fluid.

® Do not use spray or aerosol cleaners.

® Dispose of all cleaning/disinfectant materials per laws and regulations for
infectious waste disposal.

® Do not clean the pump with Bleach (8.25% concentration, mixed at 1 part bleach
in 10 parts water), as deterioration may occur.

Before using materials other than the products listed above for

e cleaning and disinfecting the SapphirePlus Infusion pump, make
sure that they are listed in Q Core's official approved list of materials
(published at www.qcore.com) .

The pump must be completely dried out before connecting it to a
A power supply.
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Cleaning and Disinfection Procedure

Cleaning/Disinfecting Solution Manufacturer

Dispatch® (Caltech) ready-to-use towels Caltech

Virex® Il 256 Diversey

Klor DeTM (Chlorine tablets) Concept

70% lsopropyl alcohol Veltek Associates, Inc.
Virox® AHP 5 RTU Diversey

Cleaning Procedure

The following procedure explains how to clean the pump using the approved agents
(listed above):

> To clean the pump:

1. Turn the pump Off and unplug the power cord from the SapphirePlus pump power
socket.

2. Use the appropriate dilution ratio per the manufacturer's instructions.

3. When the solution is ready, apply the solution on a cloth or sponge, then squeeze
so it won't drip.

4. Wipe the exterior planes areas in back and forth motions, vertically and
horizontally (mainly on the pump housing).

5. The wiping should be applied with normal force, few times on the same locations
(at least twice) verifying complete coverage of the areas to be cleaned.

6. Guidelines for cleaning specific pump components are listed in the table below.

7.  After the cleaning process is completed, the pump should be dried out for
10 minutes.
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8. Wipe the pump with a clean dry cloth.

The pump must be completely dried out before connecting it to a
A power supply.

Disinfecting Procedure

The following procedure explains how to disinfect the pump using the approved
agents (listed in Cleaning and Disinfection Procedure on page 182):

> To disinfect the pump:
1. Perform steps 1-6 specified in the cleaning process above.

2. Replace the cloth or sponge with a new one and repeat steps 3-5 (specified in the
cleaning process above) two more times (a total of 3 cycles).

3. After the disinfection process is completed, the pump should be dried out for 15
minutes.

4. Wipe the pump with a clean dry cloth.

The pump must be completely dried out before connecting it to a
A power supply.

Guidelines for cleaning/disinfecting specific pump components

Guidelines for cleaning/disinfecting specific pump components are listed in the
following table:

Component Cleaning Recommendations

LCD Screen Wipe thoroughly with a squeezed sponge. Avoid scratching the
LCD panel. Ensure that no fluid enters the speaker holes at the
top of the panel.
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Component Cleaning Recommendations

Sensor Fingers Clean the finger tip of the sensor using only a damp cloth or
sponge.
® |nternal White Panel This part should be kept free from foreign materials and dirt. If

necessary, use foam swab moistened with the detergent solution
to clean the connector, particularly around the 4 fingers roots by
applying normal finger force, assuring that the swab reaches all
areas, at least twice.

® Bubble Detector (on
the internal white
panel)

® Anchor (on the inter-

nal white panel) Note: Swabbing should be applied in vertical or horizontal
® Locking tooth (on the movement, where possible, while less accessible areas should
internal white panel) be swabbed in a circular motion (at least 3 bi-directional

® P to C connector, rotations clockwise-counterclockwise).

Power communication
connector

Reprocessing the pump when used by a single patient multiple times

When the SapphirePlus pump is used by a single patient for multiple times, the pump
and all of its components need to be cleaned first, and then disinfected using 70%
Isopropy! alcohol.

The user is required to clean and disinfect the pump in the following conditions (the
earlier of the three):

®  Every time there is visibly soiled.
®  Once a week.

®  After storage at the patient's home; even if not used.

Cleaning and disinfection instructions are identical to Cleaning and Disinfection
Procedure on page 182.
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Preventive Maintenance

The following sections describe:
Routine Inspection and Maintenance Tasks ........ceeuveeieiiiiiiiiiiiiin e 185
AlQIM TESTING weveniiiiiiiieeiiiie e et e e e e et e e ettt e e eebteeeeattaeesasaneeeessnnaeasssnnasessnnnnns 186
Certification ...

Routine Inspection and Maintenance Tasks

The following sections provide guidelines about inspecting and caring for the pump
before and after use.

Take care not to drop the pump. If the pump is dropped or appears
A to be damaged, cracked or dented, return it to your local
representative for inspection.

/

4 Preliminary Inspection

Before using the SapphirePlus pump and its accessories, check the pump for signs of
any mechanical damage.

Do not use the pump if you identify anything which may indicate

A impaired functioning of the system. In such a case, contact the
facility biomedical engineer or a Q Core approved service
technician.

Post-use Procedures

The following equipment checks should be performed following each use of the pump,
and as required:

Pump Component Action

Pump housing Check for cracks and dents.

Power cord Verify that the power cord is undamaged. Check the entire
length of the cord, and the plug.
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Alarm Testing

It is recommended to perform manual testing of the following alarms at least once a
year. Alarm testing can be conducted as part of the yearly certification.

Before testing the alarms, make sure to disconnect the set from the
A patient.
Name of Test Procedure
Airin Line Alarm Connect a new Q Core administration set to the pump without

connecting it to the infusion container. Start an infusion at a rate
of 100 mL/h. An Air in Line alarm should occur.

Occlusion Alarm Start an infusion at a rate of 600 mL/h over 5 minutes. While the
pump is running, close the upstream clamp. An Upstream
Occlusion alarm should occur.
Test the Downstream Occlusion alarm by repeating the above
test, but closing the clamp or pinching the tubing downstream
while the pump is running.

If an alarm is not generated, contact your local representative or authorized technician.

The operator should stand 1 meter from the pump, and verify that
o he/she can hear and see the alarm.

o For more information about the Air in Line and Occlusion alarms,
refer to Level 3 Alarms on page 173.

Certification

To ensure proper fluid delivery, the pump should be checked by an authorized service
provider at least once a year, to perform yearly certification. For more information on
yearly maintenance procedures to be performed by technicians or certified service
providers, refer to the SapphirePlus Infusion Pump Service Manual.
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Battery Care Information

The SapphirePlus pump can operate on battery power, enabling operation of the pump
during an electrical power failure, during patient transport or during ambulatory care.
When working on battery power (disconnected from the main power supply), the
battery charge level icon, at the upper right corner of the Indicators Bar, indicates
remaining battery capacity. Check the status of the battery charge level icon regularly:

Number of Bars in Icon Approximate Remaining Battery Capacity

5 100%
4 75%
3 50%
2 25%

1 Low

o You can also check the status of the battery using the Options
menu. For more information, refer to Viewing System Parameters on
page 139.

Battery operation time is dependent upon the condition of the battery, which varies
according to temperature conditions, battery age, frequency of charging, and
conditions of storage and use.

An alarm is triggered when there are 30 minutes left until battery depletion. This time
may depend on the delivery rate, the frequency of pressing keys, and whether the
backlight is On. When the Battery Depletion alarm sounds or following long periods of
storage, connect the pump to the power supply.

Notification messages begin appearing on the Main Display of the pump 2 weeks
before battery life expiration. When the battery life expires, the pump allows you to
finish the current infusion and then turns Off. Make sure to test the batteries at least
once a year, and replace the batteries every 2 years or every 500 charging cycles.

Battery Classification
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The UL 1642 Standard for Lithium batteries classifies the Lithium-lon battery used in the
SapphirePlus pump as follows:

®  Secondary battery (rechargeable)

®  Technician replaceable

Battery Safety Information

When working with the battery, adhere to the safety precautions and recommendations
listed below.

Battery Safety Guidelines

®  Ensure that only Q Core Medical's rechargeable Lithium lon (Li-lon) battery is
used.

® In case of rust, bad odor, overheating, and/or other irregularities when using the
battery pack for the first time, return it to your local representative.

®  Avoid any contact with water. Do not immerse the battery pack in water.
® Do not open the battery casing.
®  Store batteries in a closed carton.

®  Short term storage temperature should be below 35°C (95°F).
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Long Term Battery Storage

When you store batteries for extended periods of time, ensure the following
conditions:

®  Well-ventilated facility, free of a corrosive gas atmosphere
®  Low humidity environment

®  Storage temperature should be between -20°C (-4°F) to +35°C (+95°F). The
recommended temperature is 23° £3°C (73° £5°F).

Storage at low temperatures may affect initial battery performance.
Storage at high temperatures may degrade battery performance.
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Charging the Battery

Before initial use of the SapphirePlus pump, the battery must be charged for at least 6
hours. The battery must also be charged if it has been disconnected from the pump
unit for more than 6 months. While the pump is in storage, recharge the battery at least

every 12 months.

The pump can operate while it is being charged.

A

When using the pump while connected to the power supply, ensure
that the pump is attached securely to the power supply, the mini
cradle is attached securely to an IV pole, and the power cord is
secure, to prevent entanglements that might cause strangulation.

To preserve battery life, connect the pump to the main power supply using the power
supply whenever possible.

While connected to a power supply and charging, the Charge
(yellow) LED blinks, and stops blinking when the battery is fully
charged.

If the pump is turned Off, the Q Core logo appears on the screen
while the pump is charging.

A

Before charging the battery, ensure that the device is completely
dry. Failure to do so may compromise patient safety.

> To charge the battery:

1.
2.

Plug the Q Core supplied power supply cord into the main power supply.

With the white arrows facing up, plug the power cord into the SapphirePlus pump
power socket or into the splitter connector.

On the front of the pump, verify that the Charge LED status indicator is On
(blinking yellow light).
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Battery Maintenance

To promote maximum battery life, the following procedures should be performed at
regular intervals.

Frequency Action

Following each use of the Check the status of battery charge, and recharge as
pump necessary.
Every 2 years or every 500 Replace batteries.

charging cycles

Transport and Storage

The pump should always be transported in a protective case internally padded with
cushioning material. It is best to use the original packaging. During handling and
transport, protect the pump and the case from water, excessive humidity, and heat
sources.

To safeguard the pump against prolonged exposure to dust and moisture, the pump
must be stored in a clean and dry environment. It is recommended that the pump
remain plugged in during storage, in order to maintain the battery at full charge. If the
pump is disconnected from the power supply, or is in storage without being connected
to power for several months, check the battery level, and recharge the battery before
using the pump (Charging the Battery on page 190).

For any storage period, make sure that the Q Core administration cassette is
disconnected from the pump, and that the safety door over the pump mechanism is
closed. Specific recommendations for long term storage conditions are listed in the
following table.

Condition Parameters

Temperature -40°C (-40°F) to +70°C (+158°F)
Relative humidity 15% RH to 95% RH
Atmospheric pressure 50 kPa to 106 kPa (500 hPa to 1060 hPa)
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Chapter 12: Technical Specifications

The following sections present technical specifications for the pump and its
components:
PUMP ACCUIACY itiiiiiiiiiiieiie et e te et et et e et e et e ee et e e e et e aneeaaeansansensanesensansansaneenneen
PUMP SPECITICATIONS ..oviiiiiiiiiie e e et e e e e e e e et eeeaa e eens
Average Bolus Volume After OCClUSION .......iiiiiiiiiiiiee e
Environmental Specifications .............ccccoeeeeiiiieeennn.

Electromagnetic Compatibility Statement

Pump Accuracy

The following graphs and curves were derived from the pump accuracy testing
procedures described in the IEC60601-2-24 standard. Testing was performed under
normal conditions (specified in IEC60601-2-24 standard) at room temperature (25°C,
72°F).

Normal conditions to ensure optimal accuracy of £2.5%:

®  Fluid level should be 50 cm above the pump

®  No back pressure due to catheter size or difference in height of pump and infusion
site

®  Room temperature (25°C)
®  Barometric pressure of sea level altitude (101kPa)

® |V medication with water like fluid characteristics
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Infusion under high backpressure conditions (for example, when using catheters, or
other restricting administration set components) may cause the accuracy of the pump
flow delivery to deviate from the accuracy stated for normal conditions.

The pump is designed to accommodate the delivery of infusions under backpressure

conditions with an expected deviation in accuracy of +5% to -5% (Note: In high

backpressure conditions, such as with a 26G PICC line infusing at 100mL/h, additional

under delivery may occur).

In the SapphirePlus pump, as in all infusion systems, external factors may cause

fluctuations in rate accuracy. Conditions that can cause flow fluctuations include:

®  Position of the infusion container height (any deviation from 50 cm above the
pump)

®  Fluid characteristics that deviate from water-like characteristics, such as density,
viscosity and homogeneity

®  Positive and negative pressure, including back pressure

®  Environmental temperature above or below 25°C

®  Barometric pressure above or below 101kPa
For example:

® Achange of £25 cm in the fluid level above the pump may result in deviation in
accuracy of =1%

®  Using sets with PAV may result in deviation in accuracy of -6%

When using accessories where the container height deviates from
0 50 cm above the pump, there may be deviations in pump accuracy
(e.g., Homecare Large Backpack).
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Start-up and Trumpet Graphs

The start-up graphs represent startup flow versus operating time for the first two hours
from the start of the infusion. They exhibit the stability of delivery due to mechanical
compliance and provide a visual representation of uniformity. Start-up graphs were
performed according to the IEC 60601-2-24 standard.

In the SapphirePlus pump, as in all infusion systems, the action of the pumping
mechanism and variations or external factors may cause fluctuations in rate accuracy.
Conditions that can cause flow fluctuations include:

®  Position of the infusion container
®  Fluid density

®  Positive and negative pressure

° Environmental temperature

®  Operation of the pump beyond the recommended operating limits

Trumpet curves are named for their characteristic /shape, and are developed in
accordance with IEC 60601-2-24. They display the percent flow rate deviation from the
programmed rate over time. The horizontal axis represents the observation time
intervals.

Over long observation windows, short-term fluctuation has little effect on accuracy, as
represented by the flat part of the curve. As the observation window is reduced,
short-term fluctuations have a greater effect, as represented by the "mouth" of the
trumpet.
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Figure 12.1.  Delivery Startup Graph, First 2 Hours of Test Period,
1T mL/h
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Figure 12.2.  Trumpet Graph, Second Hour of Delivery, 1 mL/h
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Figure 12.3.  Trumpet Graph, 24th (Last) Hour of Delivery, 1 mL/h
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Figure 12.4. Delivery Startup Graph, First 2 Hours of Test Period,
25 mL/h

Intermittent Flow (, Q= 25 ml/h, , D= 53.32 micl)
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Figure 12.5.  Trumpet Graph, Second Hour of Delivery, 25 mL/h
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Figure 12.6.  Trumpet Graph, 24th (Last) Hour of Delivery, 25 mL/h
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Pump Specifications

The following table lists and describes pump specifications.

Parameter Description

Dimensions 143 x 96 x 49 mm (5.63 x3.78 x 1.93 in.) (H x W x D)
Weight (excluding batteries) Sapphire” - 418 g (14.7 oz.)

SapphirePlus - 433 g (15.3 oz.)
Pumping mechanism Single channel volumetric, with integral pressure sensor
Infusion delivery modes Continuous (with and without a Secondary line), PCA,

Intermittent, Multi-step, TPN, Epidural (PCEA, Epidural
Intermittent)**

KVO rate Up to 20 mL/h in increments of 0.1 mL/h

Accuracy +2.5% (Subject to external conditions such as tubing,
pressure, container position relative to the pump,
barometric pressure, humidity and temperature)

Defibrillation proof - recovery Max 1 sec
time
Flow rate 0.1 - 99.9 mL/h in increments of 0.1 mL/h
100 - 999 mL/h in increments of 1 mL/h
Volume (VTBI)
0.1-99.9 mL in increments of 0.1 mL
100 - 9999 mL in increments of 1 mL
Infusion device Volumetric, peristaltic
External power supply 100 - 240V 50-60 Hz, 0.6A
Battery ® Rechargeable Li-lon battery 7.4V, 1960 mA/h
® 24 hrs @ 125 mL/h (with a fully charged battery, and
backlight Off)
® Recharge time: up to 6 hrs (when pump is not in oper-
ation)

® When connected to Wi-Fi, 5 hrs @125 mL/h (with a
fully charged battery, and backlight Off)
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Parameter Description

Adaptor AC Adaptor 10 VDC/2.0A

Fuse rating T1.6A, 250V

Downstream occlusion Up to 17.4 PSI (1.2 bar or 900 mmHg)

Operating temperature +5° (41°F) to 40°C (104°F)

Alarms Refer to full list of alarms in Chapter 10: Alarms and

Troubleshooting on page 170.

Prime Manual or automatic priming (600 mL/h, or from air in
line alarm 900 mL/h)

Sensors ® Air in line sensor: Detects both single and
accumulated bubbles sized 0.02-0.5 mL. The desired
size range of each option can be selected by the
technician.

® Upstream/Downstream occlusion sensor
® Door open sensor

® Temperature sensor

* Relevant for Sapphire Multi-therapy, Sapphire PCA, Sapphire Epidural, Sapphire TPN and
SapphireH100.

** PCA, TPN, Intermittent, PCEA and Epidural intermittent modes are available in Sapphire
Multi-Therapy pumps only.

Wireless Upgrade Module

The following table lists the wireless module specifications:

Parameter Description

Device Name QC-580 802.11 a/b/g/n Wireless (Upgrade) Module
Standards |IEEE 802.11 a/b/g/n
Transmit Power 802.11 b/g - 15 dBm

802.11 a/n - 16 dBm
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Parameter Description

Antenna Two dual band antennas each operating at 2.4GHz and
5GHz bands
Certifications FCC Part 15 (Subpart C, Subpart E)
IC RSS (210, Gen)
This Device contains FCC ID: N6C-SDMAN
IC: 4908B-SDMAN
Model: QC-580
Wireless Security ® \WPA Personal

® Authentication: PSK
® Encryption: TKIP, AUTO

® WPA2 Personal
® Authentication: PSK
® Encryption: AES

® WPA Enterprise

® Authentication: EAP-TLS, EAP-TTLS, PEAP,
EAP-FAST
® Encryption: TKIP, AUTO

® WPAZ2 Enterprise

® Authentication: EAP-TLS, EAP-TTLS, PEAP,
EAP-FAST
® Encryption: AES
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Average Bolus Volume After Occlusion

The following table presents the average time to a downstream occlusion alarm, and
the bolus volume after occlusion, at a rate of 25 mL/h.

Parameter Pressure

0.4 bar 1.2 bar
Average bolus volume 0.135 mL 0.75 mL"
following downstream
occlusion
Average time to downstream 38 sec 3 min

occlusion alarm

* Under single fault condition

The following table presents the average time to a downstream occlusion alarm at a
rate of 0.1 mL/h.

Parameter Pressure

0.4 bar 1.2 bar
Average time to downstream  2:30 hours 12:30 hours
occlusion alarm
o In case of an occlusion (upstream or downstream), clear the
occlusion by disconnecting the set from the patient and priming the

administration set. When priming manually, close clamps and
disconnect the patient from the administration set prior to
detaching the administration cassette from the pump.
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Environmental Specifications

The pump should be operated within the temperature and humidity ranges specified
below. To avoid damage to the pump or battery, do not store the pump or the
administration set outside these temperature and humidity ranges. Do not store the
pump for prolonged periods with the battery installed.

Operating Conditions

Adhere to the following operating conditions:

Condition Details/Range

Operating mode Long term infusion usage
Humidity 15% to 95%

Temperature +5°C to 40°C (41°F to 104°F)
Atmospheric pressure 70 kpa to 106 kpa

Environmental Conditions for Transport and Storage

When transporting or storing the pump, adhere to the following conditions:

Condition Details/Range
Atmospheric pressure 50 kPa to 106 kPa (500 hPa to 1060 hPa)
Relative humidity 15% to 95%
Temperature -40°C to +70°C (-40°F to 158°F)
y Do not disassemble the portion of the SapphirePlus pump that
2 houses the pump mechanism and the electronics. This should be

done by authorized personnel only; Q Core Medical Ltd. will not be
obligated to provide technical service in such a case.
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When storing batteries separately from the pump, maintain the following storage
temperature ranges:

Type of Storage Temperature Range

Short term <40°C (<95°F)

Long term -20°C (-4°F) to +35°C (+95°F)
Recommended: 23° +£3°C (73° +5°F)

) Storage at low temperatures may affect initial battery performance.
£ Storage at high temperatures may degrade battery performance.

The following list provides guidelines about environmental conditions and situations to
be avoided when working with or storing the pump:

®  Avoid locations where there is inadequate ventilation.
®  Avoid locations where sudden impact or vibration may occur.

®  Avoid damp locations, or locations where moisture level may increase
considerably.

®  Avoid locations with large temperature fluctuations.
®  Avoid locations exposed to direct sunlight.
®  Avoid locations near an electrical heating apparatus.

®  Avoid locations exposed to chemicals or explosive gases.
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Electromagnetic Compatibility Statement

The following sections provide information about testing of and recommendations for:

Electromagnetic EMISSION ...ccuueeiiiiiiieiiiiie ettt e e e e e e et e e e eeree e e aaaeeeaees 204
Electromagnetic IMMUNITY ..o.eiiiiiiriiiiie e e e e e e e eere e e era e eeees 205
Recommended Separation Distances from Mobile RF Communication Equipment ..... 208

Electromagnetic Emission

The pump is intended for use in the electromagnetic environment specified below. The
customer or the user of the pump should ensure that it is used in such an environment.

Electromagnetic Environment

Emission Test Compliance Guidance

RF emission CISPR 11 Group 1 The pump uses RF energy for its internal
function only. Therefore, RF emissions are
very low and are not likely to cause any
interference with nearby electronic

equipment.
RF emission CISPR 11 Class B The pump is suitable for use in all
Harmonic emissions Class B establishments, including domestic
IEC 610003-3-2 establishments and those directly

connected to the public low-voltage
Voltage fluctuations / flicker ~ Complies power supply network that supplies
emissions buildings used for domestic purposes.
IEC 61000-3-3
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Electromagnetic Immunity

The pump is intended for use in the electromagnetic environment specified below. The
customer or the user of the pump should ensure that it is used in such an environment.

Immunity Test

Electrostatic
discharge (ESD)
IEC 61000-4-2

Electrical fast
transient/burst
IEC 61000-4-4

Surge
IEC 61000-4-5

Voltage dips, short
interruptions and
voltage variations on
power supply input
lines

IEC 61000-4-11

205

IEC 60601 Test
Level

+6 kV contact
+8 kV air

*2 kV for power
supply lines
*1 kV for input/
output lines

+1 kV differential
mode

<5% UT (>95%
dipin UT) for 0.5
cycles

40% UT (60% dip
in UT) for 5
cycles

70% UT (30% dip
in UT) for 25
cycles

<5% UT (>95%
dipin UT) for5's

Compliance
Level

+8 kV contact
+15kV air”

*2 kV for power
supply lines
£1kV for input/
output lines

+1kV at
110 & 230 VAC

<5% UT (>95%
dip in UT) for 0.5
cycles

40% UT (60% dip
in UT) for 5
cycles

70% UT (30% dip
in UT) for 25
cycles

<5% UT (>95%
dipinUT)for5s

Electromagnetic
Environment Guidance

Floors should be wood,
concrete or ceramic tile. If
floors are covered with
synthetic material, the
relative humidity should be
at least 30%.

Mains power quality should
be that of a typical
commercial or hospital
environment.

Mains power quality should
be that of a typical
commercial or hospital
environment.

Mains power quality should
be that of a typical
commercial or hospital
environment. If the user of
the pump requires
continued operation during
power mains interruptions, it
is recommended that the
pump be powered from an
uninterruptible power
supply or a battery.
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IEC 60601 Test Compliance Electromagnetic

Immunity Test Level Level Environment Guidance
Power frequency 3 A/m 3 A/m Power frequency magnetic
(50/60 Hz) magnetic fields should be at levels
field characteristic of a typical
IEC 61000-4-8 location in a typical

commercial or hospital
environment.

*  The pump was tested to the EMC requirements of IEC 60601-1-2 (third edition) and
IEC 60601-2-24 (second editiorﬁ,

Electromagnetic Immunity for Life-supporting Equipment and Systems

The pump is intended for use in the electromagnetic environment specified below. The
customer or the user of the pump should ensure that it is used in such an environment.
Portable and mobile RF communications equipment should be used no closer to any
part of the pump, including cables, than the recommended separation distance
calculated from the equation applicable to the frequency of the transmitter.

Field strengths from fixed RF transmitters, as determined by an electromagnetic site
survey, should be less than the compliance level in each frequency range.

()

Interference may occur in the vicinity of equipment marked with the symbol.

Electromagnetic

IEC 60601 Test Compliance Environmfnt
Immunity Test Level Level Guidance
Conducted RF 3 Vrms 150 kHz 3 Vrms Recommended
IEC 61000-4-6 to 80 MHz separation distance (RSD)
10 Vrms 150 kHz _
to 80 MHz d = 1'2"/;
3 Vrms ™ RSDd = 4./p
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Electromagnetic

IEC 60601 Test Compliance Environmgnt
Immunity Test Level Level Guidance

where p is the maximum output power rating of
the transmitter in watts (W) according to the
transmitter manufacturer, and d is the
recommended separation distance in meters

(m).
Radiated RF 3V/m 10 V/m Recommended
IEC 61000-4-3 80 MHz to 80 MHz - 2.5 GHz separation distances:
2,5GHz 80% AM, 2 Hz ® 80 MHz to 800 MHz:
80 MHz - 2.5 GHz
80% AM, 1 KHz d = 4Jp
® 800 MHz to 2.5 GHz:
d=17Jp

At 80 MHz and 800 MHz, the higher frequency
range applies.

* These guidelines may not apply in all situations. Electromagnetic propagation is affected

by absorption and reflection from structures, objects and people.
** The pump was tested to the EMC requirements of IEC 60601-1-2 (third edition) and
IEC 60601-2-24 (second editior%.

Notes

1.

207

The ISM (industrial, scientific and medical) bands between 150 kHz and 80 MHz
are 6,765 MHz to 6,795 MHz; 13,553 MHz to 13,567 MHz; 26,957 MHz to
27,283 MHz; and 40,66 MHz to 40,70 MHz.

The compliance levels in the ISM frequency bands between 150 kHz and 80 MHz
and in the frequency range 80 MHz to 2.5 GHz are intended to decrease the
likelihood that mobile/portable communications equipment could cause
interference if it is inadvertently brought into patient areas.

For this reason, an additional factor of 10/3 is used in calculating the
recommended separation distance for transmitters in these frequency ranges.
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3. Field strengths from fixed transmitters, such as base stations for radio (cellular/
cordless) telephones and land mobile radios, amateur radio, AM and FM radio
broadcast and TV broadcast cannot be predicted theoretically with accuracy. To
assess the electromagnetic environment due to fixed RF transmitters, an
electromagnetic site survey should be considered. If the measured field strength
in the location in which the SapphirePlus pump is used exceeds the applicable RF
compliance level above, the pump should be observed to verify normal operation.
If abnormal performance is observed, additional measures may be necessary, such
as re-orienting or relocating the pump.

4. Over the frequency range 150 kHz to 80 MHz, field strengths should be less than
3V/m.

Recommended Separation Distances from Mobile RF Communication
Equipment

The pump is intended for use in an electromagnetic environment in which radiated RF
disturbances are controlled. The customer/pump user can help prevent
electromagnetic interference by maintaining a minimum distance between portable
and mobile RF communications equipment (transmitters) and the pump, according to
the maximum output power of the communications equipment.

The following table provides recommended separation distances between portable
and mobile RF communication equipment and the pump (for life-supporting
equipment and systems).

For transmitters rated at a maximum output power not listed in the table, the
recommended separation distance d in meters (m) can be determined using the
equation applicable to the frequency of the transmitter, where p is the maximum
output power rating of the transmitter in watts (W) according to the transmitter
manufacturer.
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Rated Maximum

Output Power of Separation Distance According to Frequency of

Transmitter (W) Transmitter (m)

150 kHz to 150 kHz to 80 MHzto 800 MHz

80 MHz 80 MHz in 800 MHz to 2.5
outside ISM ISM bands GHz
bands
d=12Jp d=4Jp d=12Jp d=23Jp
0.01 0.12 0.40 0.12 0.23
0.1 0.38 1.3 0.38 0.72
1 1.2 4.00 1.2 2.3
10 3.8 13 3.8 7.27
100 12 4.00 12 23
Notes
1. These guidelines may not apply in all situations. Electromagnetic propagation is

2.

209

affected by absorption and reflection from structures, objects and people.

At 80 MHz and 800 MHz, the separation distance for the higher frequency range
applies.
The ISM (industrial, scientific and medical) bands between 150 kHz and 80 MHz

are 6,765 MHz to 6,795 MHz; 13,553 MHz to 13,567 MHz; 26,957 MHz to 27,283
MHz; and 40,66 MHz to 40,70 MHz.

An additional factor of 10/3 is used in calculating the recommended separation
distance for transmitters in the ISM frequency bands between 150 kHz and 80
MHz and in the frequency range 80 MHz to 2.5 GHz.

This decreases the likelihood that mobile/portable communications equipment
could cause interference if it is inadvertently brought into patient areas.
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Chapter 13: Limited Warranty

Q Core Medical Ltd. (the "Manufacturer") warrants to the buyer who purchased the
SapphirePlus directly from the manufacturer (Initial Buyer) that the SapphirePlus
Infusion Pump ("SapphirePlus"), not including accessories, shall be free from defects in
materials and workmanship under normal use, if used in accordance with this User
Manual, for a period of one year from the actual date of sale to the Initial Buyer. THERE
ARE NO OTHER WARRANTIES. Extended warranty can be separately purchased
following the end of the one year period.

This warranty does not cover normal wear and tear and maintenance items, (such as the
Yearly Certification Kit), and specifically excludes batteries, administration sets,
extension sets or any other accessory items or equipment used with the SapphirePlus.
Subject to the conditions of and upon compliance with this Limited Warranty, the
Manufacturer will repair or replace at its option without charge (except for a nominal
charge for postage and handling) any defective SapphirePlus provided a claim is made
during such one year period.

The following conditions, procedures, and limitations apply to the Manufacturer's
obligation under this warranty:

A. Parties Covered by this Warranty: This Warranty extends only to the Initial Buyer of
the SapphirePlus.

Warranty Performance Procedure: Notice of the claimed defect must be made by Initial
Buyer in writing to the Manufacturer as follows:

Q Core Medical Ltd., 29 Yad Haruzim St., P.O. Box 8639, Netanya, 4250529, Israel.
Initial Buyer should send mail to support@qcore.com or contact the account manager.
Notice to the Manufacturer must include date of purchase, serial number, and a
description of the claimed defect in sufficient detail to allow the Manufacturer to
determine and facilitate any repairs which may be necessary. AUTHORIZATION MUST
BE OBTAINED PRIOR TO RETURNING THE SAPPHIREPLUS. If authorized, the
Sapphire must be properly and carefully cleaned, packaged and returned to the
Manufacturer. Any loss or damage during shipment is at the risk of the sender.

The SapphirePlus service life is 7 years from the date of manufacture.
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B. Conditions of Warranty: The warranty is void if the SapphirePlus has been

1) repaired by someone other than the Manufacturer or its authorized agent

2) altered so its stability or reliability is affected 3) misused or 4) damaged by
negligence or accident. Misuse includes, but is not limited to, use not in compliance
with the User Manual or use with non-approved accessories. Removal or damage to the
SapphirePlus's serial number will invalidate this warranty.

C. Limitations and Exclusions: Repair or replacement of the SapphirePlus or any
component part therefore is the EXCLUSIVE remedy offered by Manufacturer. The
following exclusions and limitations shall apply:

1. No agent, representative, or employee of the Manufacturer has authority to bind the
Manufacturer to any representation or warranty, expressed or implied.

2. THERE IS NO WARRANTY OF MERCHANTABILITY OR FITNESS OR USE OF THE
SAPPHIREPLUS FOR ANY PARTICULAR PURPOSE.

3. The SapphirePlus can only be used under the instruction of medical personnel whose
skill and judgment determine the suitability of the SapphirePlus for any particular
medical treatment.

4. All recommendations, information, and descriptive literature supplied by the
Manufacturer or its agents are believed to be accurate and reliable, but do not
constitute warranties.

The Manufacturer disclaims responsibility for the suitability of the SapphirePlus for any
particular medical treatment or for any medical complications resulting from the use of
the SapphirePlus. The Manufacturer shall not be responsible for any incidental damage
or consequential damages to property, loss of profits, or loss of use caused by any
defect or malfunction of the SapphirePlus.
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Service Information

While under Q Core warranty, the SapphirePlus pump must not be opened by
unauthorized personnel.

Use only an authorized Q Core service provider for service and repair. In the event that
your pump needs to be returned for service, obtain a Return Authorization by sending
mail to support@gqcore.com, or contact your account manager. The pump must be
packed in a suitable container that will provide adequate protection during shipment.
To ensure prompt return, a

Q Core authorized service representative must be notified before shipping any pump
for repair. When calling for service, please be prepared to provide the serial number of
the pump and software version details. A brief written description of the problem
should be attached to the pump when it is returned for service.

Q Core Medlical Ltd. will not be responsible for unauthorized returns or for pumps
damaged in shipment due to improper packing.
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Appendix A: SapphirePlus Configuration

Settings

The following sections present the SapphirePlus pump configuration settings:

User Options — Alarm and Audio SETHINGS ........eeiiiiiiiiiiiiieee e 214
User Options — General PUMP SEHINGS .....eiiiiiieiiiiiieeeeiiieee e et e e e evi e e 215
User Options — Hard Limits and KVO Settings .......c.eeeiiiiiiiiiiiiiieeeeiiiee e eeevi e 218
User Options — Air SETEINGS ..uvviuiiiiiiiieie ettt et e e e e e e e e e e s eaasenans 219

User Options — Alarm and Audio Settings

Parameter Pump Options Default  Controlled ICU Medical Authorization
Factory byDrug MedNet™ Level
Setting Library Meds™
(without Configuration
drug Options Notes
library)
Occlusion PSI BAR Yes High
Units BAR
mmHg
Occlusion PSI: 5.8-17.4 in 0.4 BAR Yes High
Pressure increments of 0.1
BAR: 0.4-1.2 in

increments of 0.1
mmHg: 300 - 900
in increments of 1

Pump 2,5,10 min 10 min Yes High
Unattended

Infusion Near Off, 1, 3,5, 10 10 min Yes High
End min
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Parameter

Alarm
Volume

Keys Volume

Pump Options

Maximum,
Minimum

Low, High, Off

Default
Factory
Setting
(without
drug
library)

Maximum

High

Controlled ICU Medical

by Drug  MedNet™

Library Meds™
Configuration
Options Notes

Yes

Yes

User Options — General Pump Settings

Parameters

Set Delay

Post Infusion
Rate

Pre-Program
Repeat Last

Set Prime
Volume

Backlight
Options

Prime
reminder

215

Pump Options

On, Off
KVO, Rate

On, Off
On, Off

2-25mLin
increments of
1T mL

On, Partial, Off

On, Off

Default
Factory
Setting

(without
drug
library)

Off
KvO

Off

On

20 mL

On

Off

Controlled ICU Medical

by Drug  MedNet™

Library Meds™
Configuration
Options Notes

Yes

Yes Rule Set -
configurable
General Drug —
controlled by CCA
setting

Yes

Yes

Yes

Yes

Yes

Authorization
Level

High

High

Authorization
level

High

High
High
High
High

High
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Parameters Pump Options Default Controlled ICU Medical Authorization

Factory byDrug MedNet™ level
Setting  Library Meds™
(without Configuration
drug Options Notes
library)
Advanced On, Off Off Yes Rule set — Not High
Bolus configurable;

option set to On
General drug -
controlled by CCA

settings

Auto Patient  On, Off Off Yes High
Lockout
Screen saver On, Off Off Yes High
US Format™  On, Off Off Yes High
New Patient On, Off Off Yes Technician
Set On, Off Off Yes Technician
Secondary
Allow bolus  On, Off Off Yes Technician
Bolus Rate 0.1-99.9mL/hin 125 mlL/h  Yes Rule set — Technician
Continuous  increments of configurable via

0.1 mL/h ICU Medical

100 - 999 mL/h in MedNet™,

increments of Applied for

1 ml/h primary and

secondary bolus.
General drug -
controlled by CCA
settings.
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Default
Factory
Setting
(without
drug
library)

0.1-99.9 ml/hin 125 mL/h
increments of

0.1 mL/h

100 - 500 mL/h in
increments of

Parameters Pump Options

Secondary
Bolus Rate

(Continuous*)

1 ml/h
Occlusion On, Off On
Auto-Restart
Calculate On, Off Off
concentration
mL/h only On, Off Off
Wi-Fi™ On, Off Off

*

Controlled ICU Medical
by Drug
Library

Yes

Yes
Yes

No -
appears
Only in the
absence of
drug library
on the
pump.

No

. Available when Set secondary is enabled.

MedNet™
Meds™
Configuration
Options Notes

Rule set —
configurable via
ICU Medical
MedNet™.
Applied for
primary and
secondary bolus.
General drug -
controlled by
Primary bolus rate
in CCA settings.

Not configurable;
option set to Off

Authorization
level

Technician

Technician

Technician

Technician

Technician

**_Wi-Fi configuration is configured locally on the pump, but does not revert to default in any

event.
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User Options — Hard Limits and KVO Settings

Parameters Pump Options Default Controlled ICU Medical Authorization
Factory byDrug  MedNet™ level
Setting  Library Meds™
(without Configuration
drug Options Notes
library)
Hard Limits 1-9999 mLin 9999 mL  Yes Technician
Continuous increments of
VTBI 1T mL
Hard Limits ~ 0.1-99.9mlL/hin 999 mL/h Yes Technician
Continuous increments of
Rate 0.1 mL/h

100-999 mL/hin
increments of

1 ml/h
Hard Limits 1-9999 mLin 9999 mL  Yes Technician
Continuous increments of
Secondary 1mL
VTBI"
Hard Limits 0.1-99.9mL/hin 500 mL/h  Yes Technician
Continuous increments of
Secondary 0.1 ml/h
Rate” 100-500 mL/hiin
increments of
1 ml/h
Hard Limits 1-9999 mLin 9999 mL  Yes Technician
Multistep increments of
VTBI 1 mL
Hard Limits ~ 0.1-99.9ml/hin 999 mL/h Yes Technician
Multistep increments of
Rate 0.1 ml/h

100-999 mL/hin
increments of
1 ml/h
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Parameters

Hard Limits
Multistep
Time

KVO
Continuous

KvO
Multistep

Pump Options

00:01 - 24:00
hh:mm

0-20mLin
increments of
0.1 mL

0-20mLin
increments of
0.1 mL

Default
Factory
Setting
(without
drug
library)

24:00
hh:mm

3 ml/h

3ml/h

Controlled ICU Medical

by Drug
Library

Yes

Yes

Yes

*. Available when Set secondary is enabled

User Options - Air Settings

Parameters

Single Air
Detector

Accumulated
Air Detector

Accumulated
Threshold

219

Pump Options

Off, 20, 40, 50,
100, 200, 500 mcl

20, 40, 50, 100,
200, 500 mcl

Off, 500, 1000

mcl

Default
Factory
Setting

(without

drug
library)

Off

500 mcl

1000 mcl

Controlled
by Drug
Library

Yes

Yes

Yes

MedNet™
Meds™
Configuration
Options Notes

Not configurable;
option set to the
configured
Continuous KVO

ICU Medical
MedNet™
Meds™
Configuration
Options Notes

Authorization
level

Technician

Technician

Technician

Authorization
level

Technician

Technician

Technician
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Legend:

Controlled by Drug Library = Yes:

Users are able to change the settings temporarily on the pump (these are considered as
local changes). The temporary settings revert to CCA defaults, when turning the pump
Off or when selecting a CCA.

When choosing Reset to Factory defaults, changed settings will revert to pump
factory defaults. This change is considered as a local change and will revert to CCA
defaults, when turning the pump Off or when selecting a CCA.

Wi-Fi configuration is configured locally on the pump, but does not revert to default in
any event.
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Technical Support Contacts
US Phone: 1-800-241-4002
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